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We were disappointed when Apple persisted with a 16GB base model for the iPhone SE, so if you 
find yourself running out of space on your device, try i.dime. It’s one part iPhone case, one part 

clip-on storage boost. Put on the case and i.dime magnetically sticks to the back, wirelessly 
boosting your storage by up to 256GB – that also makes it great for quickly sharing files with 

anyone else who has an i.dime case. It also comes with a small USB dongle that holds the i.dime, 
allowing you to easily transfer files between your iPhone and Mac. 

 From $48 (about £36)  includes i.dime, USB/Lightning dongle (some bundles include case)  
website idime.us  works with iPhone 5, SE, 6, 6 Plus, 6s, 6s Plus

i.dime

 iOpener
Game-changing tech from the world of Apple and beyond

A coin-sized instant storage boost for your iPhone

The i.dime case isn’t 
essential, but it makes 

file transfers easier.

The tiny i.dime is 
about the size 
of a coin.

 macformat.com  @macformat SEPtEmBEr 2016 | MACFORMAT | 3





 The public betas of macOS Sierra 
and iOS 10 have brought a new joy 
to the MacFormat team, both being 
packed with exciting new features to 
make more of your Mac, iPhone and 
iPad. Turn to page 50 to find out how 
to get the public betas and install 
them safely so that none of your data 
is in jeopardy.

While you’re waiting for the full 
release of both OSes in September, 
you can still enhance your devices 

further with great apps that improve on what Apple has 
provided. In this issue we take a look at the very best Mac 
apps, and for the first time show you in detail what the pros 
and cons are of using apps like Fantastical over Calendar 
and Airmail over Mail really are. We love Apple’s apps, but 
we’re amazed by what some of the great developers for the 
Mac platform have been able to do with their apps.

Hopefully, macOS Sierra will turn out to be even more 
reliable than previous versions, but no computer is ever 
free from the potential for disaster. Take a look at our 
up-to-date Mac rescue guide on page 82 for the very best 
advice. And there’s always Howard Oakley’s Genius Tips 
if your Mac and iOS problems lie elsewhere.
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and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

EditEd by christian hall 

aPPlE rUMOUr

 VR is the next chapter in next major shift 
in gaming. It’s been in the wild for years, but 
prohibitive costs and a lack of premium titles 
has meant that it’s taken a long while to 
become big business. But, with Sony on the 
cusp of launching its affordable headset for 
PlayStation 4, the real VR revolution is here. 

So, why would Apple be interested? After 
all, the company often waits in the wings to 
see which technologies gain traction. Well, 
rumours have been around for a decade that 
Apple has been seriously exploring VR and 
augmented reality, both of which have been 
waiting for that must-have reason for buyers to be 
interested. So-called AAA console titles and mobile 
crazes such as Pokemon Go are opening up an exciting 
new revenue stream. That’s great for developers, but for 
Apple it’s more likely to bed into Maps or introduce a whole 
new way to browse in Safari. Whether it ends up as a headset 
or something else, Tim Cook agrees that VR is “really cool”.
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i know i’m excited by the idea

Paul says…

Can Apple really avoid the 
‘next big thing’ in tech?

Apple VR

1

vrOs?
 Whatever an Apple VR unit 
runs on, it’s sure to be very 

much like iOS, which has had 
camera tech built into it 

from the beginning of the 
iPhone’s life. In fact, an 

iPhone and VR app may be 
required to run the headset.

1



3

2

1

Rumour aPPlE cOrE
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iPhOnE 7 cOlOUrs 
 A supposedly ‘leaked’ photo 

of the iPhone 7 colour options 
shows the same colours as 
the iPhone 6s – no ‘Deep Blue’ 
or ‘Space Black’ as some have 
claimed will be released.

liGhtninG EarPOds
 It has long been said that 

Apple will ditch the iPhone 7’s 
3.5mm jack for Lightning 
EarPods; ‘leaked’ photos claim 
to confirm this. Are they real?

rUMOUr
Mill

thE POll

 Hot on the heels of the 
tech giant’s latest moves…

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

WE askEd… What feature 
would you most like to see 
in the iPhone 7?

aPPlE FOrMUla 1
 F1 blogger Joe Saward 

claimed that Apple is bidding 
for a major stake in Formula 1. 
An Apple Car team seems 
better suited to Formula E.

2

hEad trackinG
 From years of dealing 

with the parts that make 
up the iPhone’s gyroscope 

and accelerometer, 
Apple has the core tech 

know-how to make a head-
tracking system work well 

to provide a 360° view.

3

hEadBand
 Apple’s now an expert 

in many different types 
of material thanks 

to the Apple Watch’s 
straps. We’d expect the 

fluoroelastomer material 
from its Sport Band to be 
the perfect thing for VR.

4

siZinG cliP
 Apple would need to 

make any VR headset 
adjustable. It could use a 
similar pin system like the 
Sport Band’s (tighten by 
moving up a notch), or a 
thread system common 

on other headgear.

2

4

3

True Tone 
display

Smart 
Connector

Lightning-only 
audio jack

2% 6.5%

2.5%89%

Wireless 
charging
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L
ike its processor, little has been 
said about the iPhone 7’s battery 
until now. Reports have emerged 

that it will feature a 1,960mAh battery – about 
14% up from the 1,715mAh one in the iPhone 
6s. Any increase will be welcome news to 
many iPhone fans, seeing as the battery in 
the 6s was actually lower capacity than the 
1810mAh one included in the iPhone 6.

What difference this’ll make in real-world 
terms is difficult to gauge. If Apple packs the 
iPhone 7 with components far more powerful 
than their 6s counterparts, battery life could 
dip as a result of higher power draw. On the 
other hand, if Apple is indeed working on a 

 Think your Mac is low 
on memory? Just be 

glad it’s got more than 
the Apple I, which came 

with a mere 4KB of 
memory. You could 

expand that to a mighty 
65KB, which must have 

seemed like overkill 
back in 1976.

The AmounT 
of memory in 

The Apple i

STorAge in The 
powerBook 100 

from 1991

ToTAl pixelS 
in Apple ii’S 

280x192 diSplAy 

S  olid info about the upcoming 
iPhone 7 can be hard to come by. 
It may or may not have a 3.5mm 

headphone jack. It may or may not have two 
rear cameras. We could go on for a while.

Processor performance hasn’t figured 
much in all this, but now Geekbench scores 
for the A10 chip thought to be inside the 
iPhone 7 have allegedly turned up. They put 
the A10’s single-core score at 3,000, compared 
to 2,519 for the A9 chip inside the iPhone 6s. 
That’s an increase of around 19%, less than 
the 43% score increase the A9 chip had over 
the A8 in the iPhone 6. The source of the ‘leak’ 
also claims the A10 will be a dual-core chip, 

not six-core, 
as some people 
have predicted.

It’s worth noting 
that early benchmarks 
for the A9 chip put it only 
marginally ahead of the A8, 
a gap that significantly widened 
once the iPhone 6s was released 
and full benchmarks could be run.

We covered the A10 in MF302, 
when we expected it to be made using 
a 10nm process. Aside from a faster 
processor, this would also boost efficiency, 
particularly in terms of battery performance. 

 We covered upgrading 
a modern MacBook’s 

storage in MF301, 
but things were more 

extreme in 1991, when a 
tiny amount cost a cool 
$2,300 – over $4,000 

in today’s money.

 These days Apple is 
churning out 4K and 
even 5K displays with 

millions of pixels apiece. 
Their venerable 

ancestor, the Apple II, 
was a bit more humble 
with just under 54,000 

pixels and a measly 
280x192 resolution.

20MB

53,760

4KB
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iPhone 7 A10 
benchmarks?
Chip score slightly 
ahead of A9

Battery boost 
for iPhone 7: 
14% more juice

‘leaked’ geekbench scores out – 
just take them with a pinch of salt

More capacity than the 
iPhone 6s – but not by much

more efficient 10nm process for the A10 chip 
in the iPhone 7 (discussed above), battery life 
in future iPhones could actually increase.

What remains absent, however, is any talk 
of battery life in the Plus-size iPhone 7. If that 
version delivers the same 14% increase the 
regular iPhone 7 is slated to receive, that could 
take its battery capacity above 3,000mAh.

The Samsung Galaxy S7, a major rival of 
the iPhone, features a 3,000mAh battery, so a 
battery capacity increase in the iPhone 7 Plus 
would make sense, enabling it to better 
compete in this department.

The iPhone 7 may see a slight increase in battery capacity, 
but how much actual battery life will change isn’t clear yet.



Apps & Games APPLE CORE

PRISMA
FREE

 You might think 
you don’t need yet 
another filters app, 

but Prisma is more like artistic 
styles, turning mundane shots 
into beautiful paintings and 
drawings, reflecting famous 
artists and their works (Piet 
Mondrian, Roy Lichtenstein, 
The Scream and more). 
why you need it: It’s free – 
and we really do mean free!
what’s it best for: Adding an 
artistic dimension to images.

SUPER STICKMAN 
GOLF 3 FREE/£2.29

 Stickman’s third 
outing in the world 
of extreme golf has 

gone for a freemium model, 
but it’s not a cash barrier that 
will hobble your enjoyment. 
Rather, the £2.29 upgrade 
unlocks what you need, but 
there’s IAP for those who 
want to get everything. 
why you need it: A must-have 
if you like the previous games.
what’s it best for: Getting 
your pitch and putt fix on iOS.

 Gregory Porter’s 
voice captures jazz, 
soul and gospel like 

few other modern voices. 
Porter picked up a Grammy in 
2014, and this 12-track fourth 
album cements his reputation 
as one of America’s kings of 
cool. His smooth baritone is 
the very definition of chill. 
why you need it: Carrys on 
from 2013 classic Liquid Spirit.
what’s it best for: Lazy days 
or laid-back evenings.

 Sierra will introduce a new 
universal copy & paste function, 
enabling you to paste from one 
Apple device to another. It’s very 

clever and we’ve been enjoying using it in the 
public beta, but Apple went no further than 
that. The Paste app gives you much greater 
control of what you can actually copy onto the 
Clipboard and, frankly, it’s a lot more useful 
day to day than Apple’s upcoming effort.

[ M O V I E ]

ZOOTROPOLIS 
£13.99
 A rabbit cop and a fox 

con artist are unusual 
partners attempting 
to unravel a city-wide 
mystery in this hilarious 
animated comedy.

[ P O d c a s t ]

DETECTIvE  
FREE
 Two retired homicide 

detectives discuss their 
methods, best cases 
and worst moments.  
A gripping series with 
gritty subject matter.

[ G a M E ]

BATMAN 
UNLIMITED FREE
 Part storybook, part 

video game, Batman 
Unlimited: Gotham 
City’s Most Wanted is 
a puzzle adventure for 
die-hard bat fans!

Paste (pasteapp.me), uses a clipboard 
history organiser called Pinboards, which 
holds multiple snippets that have been copied. 
In fact, it’s limitless, so effectively it will hold 
everything you copy from now on.

You can store copied text, images, links 
and files, and easily identify them from their 
preview thumbnails. As your clippings grow 
in number, you can use the search tool to find 
things you copied weeks ago – great stuff!

TAKE ME TO ThE ALLEy
(GREGORy PORTER)
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Paste £7.99

APPLE 
Tv
 Our top picks 

of what’s worth 
watching and 
playing this month

[ M a c  a P P ]

[ i O s  a P P ] [ a P P l E  M u s I c ][ i O s  G a M E ]

You’ll never go back to the boring old ç+c method

APP OF ThE MONTh



Don’t judge a device by its size: there's plenty of stats 
to talk about in the tiny frame of Apple’s wearable, 
from fractions of a millimetre to thousands of degrees

APPLE CORE Facts & Figures

 macformat.com  @macformat

5,280
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 WATCH
IN NUMBERS

NExT ISSUE  Find out just how successful the Apple Music 
subscription service has been in its first year.

2,640°C
Zirconia, a ceramic used 
in the Apple Watch and 

Apple Watch Edition, 
is heated to more than  
1,000° hotter than lava  
during manufacturing.

1

2x
Apple uses a gold-ceramic 

composite in its Apple Watch 
Edition, which makes it twice 

as strong as regular gold.

it w
ould take over 5,000 

Apple watches laid end-to-

end to surround the one-mile 

circumference of Apple Campus 2.

It takes Apple this 
long just to cut the 

links for the Watch’s 
Link Bracelet.

By creating Watches from 
machined gold ingots, 

Apple can control  
their dimensions to  

within 0.01mm.

0.01mm

3

5
6

80%The stainless steel 
Apple uses is 80% more 

durable than regular 

steel thanks to a cold 

forging process.

4

2



Learn more
*SRP is Exclusive of VAT.

Mac OS X LinuxWindows

Incredible Creative Tools
Whether you need to pull a key, track objects, retouch images, animate 
titles, or create amazing 3D particle effects, Fusion has the creative 
tools you need! You get a true 3D workspace, the ability to import 3D 
models and scenes from software like Maya and 3ds Max, along with 
hundreds of tools for compositing, paint, animation and more!

Scaleable Studio Power
Fusion’s GPU acceleration gives instant feedback while you work, 
so you spend more time being creative and less time waiting! Fusion 
8 Studio also includes optical flow and stereoscopic 3D tools, along 
with unlimited free network rendering and tools to manage multi 
user workflows, track assets, assign tasks, review and approve 
shots, and more!

For over 25 years Fusion has been used to create visual effects on 
thousands of blockbuster films, TV shows and commercials. Fusion 
features an easy to use and powerful node based interface, a massive 
tool set, true 3D workspace and GPU accelerated performance all in 
a single application! Now with support for Linux, Fusion 8.2 is easier 
than ever to integrate into your existing VFX pipeline!

Hollywood’s Secret Weapon
Fusion has been used to create groundbreaking visual effects and 
motion graphics for Hollywood films such as The Martian, Thor and 
The Hunger Games, as well as on hit television shows like Orphan 
Black, Breaking Bad, Grimm and Battlestar Galactica! If you’ve ever 
gone to the movies or watched television, then you’ve seen Fusion 
in action!  

Work Faster with Nodes
Fusion uses nodes to represent effects and filters that can be 
connected together to easily build up larger and more sophisticated 
visual effects! Nodes are organized like a flow chart so you can easily 
visualize complex scenes. Clicking on a node lets you quickly make 
adjustments, without having to hunt through layers on a timeline!

For Mac OS X, Windows and Linux 

For Mac OS X, Windows and Linux

FUSION �  Free Download

FUSION � STUDIO £735*

FUSION 8
The world’s most advanced visual effects and motion graphics 

software is now available on Linux as well as Mac and Windows!

www.blackmagicdesign.com/uk
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Apple talks the talk, but does it walk the walk when it 
comes to diversity?

Diversity at Apple

investigates

hen people buy Apple products, 
they often feel that they’re not 
just buying a product – they’re 
buying from a company that 

cares. Cares about the environment, about 
privacy, about its workers and about diversity. 
But how true is that last assertion? Is Apple 
giving opportunities to women and minorities 
in the technology industry, and how does it 
fare against its Silicon Valley rivals?

As with many issues it claims to take to 
heart, Apple has a dedicated section on its 
website espousing the positive steps it is 
taking towards equality in the workplace. It’s 
prefaced by a letter from CEO Tim Cook in 
which he states the company 
is making progress on its 
diversity goals, having 
increased the number of 
minority and female workers 
at Apple in recent years.

In 2014, 11% of Apple’s 
American employees were 
Hispanic. According to  
The Verge, it has the highest 
percentage of any of Apple’s 
main rivals, including 
Google, Facebook, Twitter, 
Microsoft, Amazon and 
Intel. The average of these 
other firms sat at 5%.

So Apple performs well 
there. But it doesn’t do so 
well when it comes to other 

races. Its diversity page reveals one of the 
lowest percentages of Asian workers of any 
of the sampled companies, coming in at about 
15% of the firm’s workforce (for comparison, 
around a quarter of both Facebook and 
Twitter’s workers are Asian). Only Amazon 
has fewer (13%); the average of Apple’s rivals 
was 16%. Apple comes in second for black 
employees (8% of the workforce, above the 4% 
average), but Amazon is ahead with 15%.

Has Apple improved things since then? 
According to its latest Equal Employment 
Opportunity 2015 report (EEO-1), the figures 
for Hispanic, Asian and black employees now 
stand at around 12%, 17% and 9%, respectively. 

So there is an improvement, 
albeit a slow one. To be fair to 
Apple, it admits it still has more 
work to do in this area.

Gender balance
It’s a mixed bag when it comes 
to race and employment at 
Apple. How, then, does it fare 
with gender balance?

That depends where you 
look in the company. Its 2015 
EEO-1 report shows 70% of its 
total US workforce is male. 
That compares to 49.2% of the 
general US population that is 
male, as per the 2010 census. 
The gender split at Apple is 
almost the same in its global 

W

For our latest 
subscription offer 

see page 46!

Apple has made it a goal to hire more employees from minority groups.

writteN by ALEX BLAKE 

Apple admits it 
still has more 
work to do in 

this area
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workforce, which is split 69% to 31% in favour 
of men. Like nearly every tech company in 
Silicon Valley, more men are employed than 
are reflected in the general population.

That’s the picture at the overall company 
level. What about when you break it down 
further? Jobs at Apple classified as tech-
related see a 79% male share (high above the 
US population make-up), while non-tech jobs 
at the firm are a little better at 63% male to 
37% female. If you work in an Apple Store – 
at any level, leadership or otherwise – you’re 
more likely to be male than female, with 
roughly 70% of Apple retail employees being 
male. That’s the same for Apple’s leadership 
positions, where just 28% are female. To 
illustrate, of the eight members of the Board of 
Directors, two are women – Andrea Jung and 
Susan L. Wagner. Still, that’s not the worst 
score in Silicon Valley. In a March 2016 study 
of major tech companies, Business Insider 
found that Microsoft lagged behind the rest 
with just 17% of its leadership roles being 
filled by women. LinkedIn came out on top 
with 30%, just ahead of Apple. Meanwhile, 
eBay had the highest percentage of all female 
employees, with 43%. This is an issue for the 
whole tech industry, not just Apple.

A high-scoring workplace
However, there is some good news for Apple’s 
female workers. While Apple’s employee 
make-up may not be, on the whole, much 
more diverse than that of its rivals, there is 

one area where it pulls ahead of the pack. 
Forbes reports that Apple comes out on top in 
a Fairygodboss (job review website) survey of 
tech firms where female employees were 
asked if they were treated equally to their 
male colleagues. 75% of female Apple workers 
said they were, while 78% of them said they’d 
recommend working at Apple to other women 
– again, top of the list. Fairygodboss collected 
info from 20,000 women working at various 
large tech firms.

There’s more good news when it comes to 
LGBT workers. LGBT activist group Human 
Rights Campaign (HRC) awarded Apple a 
perfect score of 100 in its most recent annual 
Corporate Equality Index, although it should 
be noted that this does not mean Apple stands 
alone at the top of the pile – HRC gave around 
400 companies the same score. Still, it is 
certainly an indicator that Apple’s policies 
have been well received by diversity 
campaigners. Apple says the index holds 
companies to “an incredibly high standard”, 
and that the score is an indication of its 
commitment to workplace equality.

Apple still has a long way to go to meet its 
diversity targets, but it certainly has plenty to 
be pleased with, particularly when it comes 
to female employee satisfaction and LGBT 
equality. It is taking steps to meeting its other 
targets – by hiring 66% more Hispanic 
workers last year than in the year before, for 
example – but, as Tim Cook says, “we know 
there is a lot more work to be done”.

Apple’s employee base is fairly diverse, though not 
industry-leading. But, a recent survey showed many 

female workers would recommend it to other women.

LGBT group 
Human Rights 
Campaign gave 
Apple a perfect 

score of 100

image creditS: apple



ADAM BANKS…

The biggest announcement Apple didn’t make at June’s 
WWDC keynote was that it was entering beta testing on a 
brand new file system. APFS (Apple File System) will appear 
in macOS, iOS, tvOS, watchOS and presumably any other OS: 
vrOS, say, if Apple moves into virtual reality, or brOS, if Craig 
Federighi and Eddy Cue form an ’80s boy band tribute act. 
I’m not sure which you’d get better odds on. 

It’s easy to forget how central the file system is to our 
conception of personal computers. The PC’s original software, 
after all, was MS-DOS (Microsoft Disk Operating System).

That distinguished it from ‘micros’ like my Commodore 64, 
which barely had an OS at all, just enough code to start itself up 
and load BASIC. This came on ROM chips; removable storage, 
in the form of a cassette tape player, was optional. Later, there 
was the shoebox-sized Commodore 1541 5.25-inch floppy disk 
drive, which ran its own Commodore DOS. (It was really more 
like what we’d now call network-attached storage.) For the 
BASIC programmer, this was a whole new world of complicated 
commands, but let you read and write data much more flexibly.

Apple’s Hierarchical File 
System (HFS) is almost as old, 
dating back to 1985. It became 
HFS+ in 1998. Now, Apple is 
writing its new file system 
from scratch. It’s the work of 
Dominic Giampaolo, famous 
for his work on BeOS, which 
Apple nearly bought instead 

of Steve Jobs’ NeXTSTEP. If it had, Apple might be based today 
in a smaller garage than the one where it started. But BeOS was 
respected for its technical achievements.

Currently, if you want to try APFS in the macOS Sierra 
developer beta without getting stopped by warning messages, 

  With summer here, Apple 
wants to squash your beach ball. 
But it’s not being a spoilsport, 
just introducing more efficient 
file handling to your devices

APPLE CORE Opinion
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ABOUT ADAM BANKS
 Adam is Apple to the core, having 

reported on the world of Macs since the 
1990s. As a writer, designer, art director 
and print production contractor, he 
divides his time between the Northern 
Powerhouse and the Creative Cloud.

HFS+ was made for 
magnetic disks, but 
APFS is optimised 
for use with flash

gOing deeper than  
a fOrce click with  
muSingS On the  
wOrld Of apple

you have to accompany your Terminal 
commands with the parameter ‘-IHaveBeen 
WarnedThatAPFSIsPreReleaseAndThatI 
MayLoseData’. If you can type that accurately, 
they know you’re not drunk-developing.

Among APFS’ new technologies, ‘copy on 
write’ (COW) means duplicated files share 
the same data on disk until one is changed. 
This could save space. More could be saved by 
compression, not yet a feature but hinted at. 
We know APFS has more flexible encryption, 
in line with Tim Cook’s commitment to 
protect personal data. Maybe the developer 
team credits should include Ed Snowden.

APFS can also retain a ‘snapshot’ of the 
file system. This could bring more reliable 
Time Machine backup, but so far the two 
don’t fit together. Something else HFS+ has in 
common with the old DOSes is that it was 
made for magnetic disks; APFS will work 
more efficiently with flash, while keeping the 
hardware at arm’s length. In another 18 years, 
who knows what we’ll be storing files on?

The most appealing feature is the promise 
to prioritise foreground operations, keeping 
the beach ball at bay. That’s all very well, but 
when are we going to check Twitter or make 
a cup of tea? Maybe macOS’s next innovation 
should be a pause button.
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 the macFormat team debates the hot Apple  
issues of the day, using their iphones of course!

“WhAT dO yOu Think OF 
ThE nEW MusiC APP?”

nExT issuE  Which Apple app could you not bear to lose?

sPLiT ViEW

Alex says…

Alan says…

“Do you follow the three laws  
of robotics”

Something about obeying 
people and not hurting them. 
I would never hurt anyone.

Siri...ously? tap to edit

hiLLARy CLinTOn
hillaryclinton.com

“Hillary rejects 
the false choice 

between privacy 
interests  

and keeping 
Americans safe.”

Presidential hopeful 
agrees with Apple in her 
published tech agenda

ChRis sMiTh
trustedreviews.com

“If anything, it’s 
amazing it took 
Apple so long to 
get to this point.”
Columnist reckons Apple 
should have released the 
Home app a long time ago

JOhn GRubER
daringfireball.net

“[Apple] will 
initiate a painful 

transition for 
long-term gain.”

Pundit says removing the 
headphone jack from the 
iPhone 7 will be worth it

sTuART dREdGE
theguardian.com

“By growing 
to 15 million 

subscribers in 
a year… Apple 

Music has  
shown there’s  

an alternative.”
Apple Music can succeed 

without the need for 
a free tier like Spotify’s

It was good to see Apple Music getting an 
overhaul at WWDC – it needed some work.

I actually disagree. Removing visual cues and 
having to guess that options are hidden behind 
a firm press doesn’t seem very intuitive.

On the plus side, Play Next and Play Later        are 
a lot clearer than the old Up Next options. Having 
an icon next to each option is also a good move.

True, but the title font is way too large! It feels like 
wasted space, even on my iPhone 6 Plus.

Yes, discoverability’s a concern, but it has been  
for years on purely Multi-Touch        devices. I think 
we’ll get used to it as more apps adopt 3D Touch.

I’m pleased to see fewer icons at once – not least 
that there aren’t ellipses next to everything!

Those icons make using the app a lot better!

Yes, it’s a bit LARGE.          I like the structure it brings 
to For You, but I hope it’s refined during the betas.

turn to page 46
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Win a copy of Parallels Desktop
Your chance to win a two-year subscription to the leading Windows virtualisation software

 Whether you’ve moved to the Mac 
from Windows or you just need to be 
able to use software that’s Windows-
only, virtualisation is a fantastic tool 
that Parallels has perfected for the Mac.

Trusted by more than five million 
users, Parallels has become one of the 
very best ways to use Windows on a 
Mac, and the company is celebrating 
10 years as the top choice for home 
users and businesses around the world.

Parallels enables Mac owners to run 
Windows and Mac applications side by 
side. In fact, you can make Windows 
invisible while still using its applications 

on your OS X desktop. It also works with 
existing Boot Camp installations so that 
creating a virtual machine from Boot 
Camp is a quick and easy process.

Parallels Desktop 11 Pro also 
includes Parallels Access, the iOS app 
that enables you to gain virtual access 
to your Mac from anywhere in the 
world. Parallels Desktop supports 
Windows 10 and OS X El Capitan, so you 
don’t have to wait until macOS Sierra is 
released to use a voice-controlled 
assistant. With Parallels Desktop and a 
copy of Windows 10, you can use 
Microsoft’s Cortana just like on a PC!

 ThE QuEsTION
For a chance to win one of 10 two-year 
copies of Parallels Desktop 11 Pro, just 
answer the following question:

Parallels Desktop 11 Pro also features 
Parallels Access, which is for what?
A) Time Machine
B) iOS devices
C) AirPort Extreme

For more detailed information about 
Parallels Desktop 11 for Mac, just visit 
parallels.com/desktop and try out the 
full product for free for two weeks.

 To enter, you can visit our website at futurecomps.co.uk/mfparallels. 
  For full terms and conditions, go to futurecomps.co.uk/mfparallels. By sending your entry, 
you agree to these competition rules and confirm you are happy to receive details of future 
offers and promotions from Future Publishing Limited and carefully selected third parties. 
 This competition closes on 29 August 2016. Over 18, GB residents only.

hOW TO
ENTER...

In association with

PRIzEs 
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he kitchen is one of the busiest 
rooms in your home – from  
that first cuppa in the morning, 
through to the delicious dinner 

that brings the whole family together at the 
end of each day.

 Oddly, though, it’s taken a while for the 
Internet of Things (IoT) to find its way into  
the kitchen. The iKettle was dismissed as an 
April Fool’s joke when it first appeared, but 
it’s now on version 2.0 – and in this issue 
we’ve also got the new Smarter Coffee 
Machine for coffee connoisseurs.

Samsung has been leading the way  
with its smart washing machines and its 
Family Hub fridge, but rivals such as LG  
and Whirlpool will be launching their own 
smart kitchen appliances in the next few 
months. And, for the bake-off brigade, 
we’ve picked out handy gadgets that can 
help with cooking or even a BBQ out in the 
garden – if we get a summer this year!

We all spend a lot of time in the 
kitchen, so we’ve rounded up the 
latest kit that’ll help  
with all your cooking  
and cleaning chores

T

The smart home is 
here – live the Apple 

dream today!

LiVe 
Smarter
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Now you can brew coffee remotely so it’s 
ready when you get to your kitchen, as 
long as you’ve filled the machine’s tank.
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he iPhone and iPad quickly 
found a place in the kitchen 
when they became available, 
with dozens of apps providing 

recipes and nutrition information to help 
you become a better cook. There have also 
been some weird and (not so) wonderful 
kitchen gadgets released over the years.

Recently, we’ve seen the Hapifork  
(about £74, hapi.com), which monitors how 
quickly you eat to help avoid overeating and 
stomach issues, while Kickstarter brought 
the world the SmartPlate (about £112, 
getsmartplate.com), which has a camera 
and sensors that enable it to analyse 
everything you eat. Even Jamie Oliver’s 
been at it, using the pukka Google Glass 
techno-specs to record videos while he 
prepares dishes so you can watch the 
process from the chef’s point of view.

Out of the frying pan
Some of these gadgets might seem a bit 
pointless, but there are many others that 
are genuinely useful. If you’re watching 
your weight, there are several smart scales 
that use an app to count the calories in your 
latest bake-off extravaganza. The best that 

we’ve seen for amateur chefs is the Drop 
Kitchen Scale (£80, getdrop.com), which 
can talk to recipes in its app to ensure your 
ingredients are just right. It can even tweak 
them, changing weights or suggesting 
alternatives if you run out of something.

The idea of a smart frying pan might 
sound daft, but it can be useful to have one 
like the Pantelligent (£170, pantelligent.
com) that can precisely monitor food’s 
temperature and send you a notification if 
your dinner starts to get crispy around the 
edges. A less costly alternative is a smart 
food thermometer, such as the Weber iGrill 
range, which starts at £30 for the iGrill Mini. 
The battery-powered iGrill can go outdoors, 
which is handy for BBQs as you can relax 
with a beer as it cooks stuff and have it buzz 
your iPhone when your burgers are ready. 

No discussion of kitchen gadgets would 
be complete without mention of the iKettle 
(£100, smarter.am). A remote-control kettle 
might sound silly, but it has proved 
surprisingly popular, and its maker recently 
introduced the iKettle 2.0 along with the 
Smarter Coffee Machine (£180), which can 
modify the strength of your coffee and keep 
it warm for as long as you want. Neither 
device can fill itself, though the Smarter app 
can remind you when a top-up is needed, 
and enables you to brew your first cuppa 
of the day from the comfort of your bed.

If you can’t stand the heat…
Having your cooker connected to the 
internet doesn’t seem to have any obvious 
benefits, as you’ll always need to be there 

T
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Where’s Siri?
 Apple’s plan is for 

Siri and HomeKit to 
control a wide range 
of home automation 
devices, but there’s 

no sign of Siri working 
with any the kitchen 
gadgets that we’ve 
looked at recently. 

Mind you, Amazon’s 
Alexa and Microsoft’s 

Cortana haven’t made 
it into the kitchen yet 
either. However, LG’s 
HomeChat app (only 
available in the US), 

lets you ask your 
LG fridge whether 

you’ve got milk, or if 
your washing machine 

has finished its cycle.

Connected kitchen
 Getting Wi-Fi to reach 

your kitchen can be 
tricky, especially due 
to interference from 

microwaves and other 
gadgets. PowerLine 

networking kit can 
prove useful here, 

providing affordable 
adaptors that plug in 

to an electrical socket 
to extend and boost 

Wi-Fi reception.

appLe hOme Smart Kitchens

Many smart kitchen 
gadgets are truly useful 
in helping you to raise 
your culinary skills

We all have to eat, and there are plenty of smart 
gadgets that can help you cook up a storm at home

Smart 
kitchens

Get started with
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Explained
acryLamiDe
 Gadgets that prevent 

food from burning also 
prevent the build-up 
of this carcinogenic 
chemical compound, 
which is found in burnt 
toast and even in very 
brown chips and 
potatoes, according 
to a study conducted 
by the UK’s Food 
Standards Agency.

Smart Kitchens appLe hOme

If you aren’t ready to replace costly 
appliances, there are accessories 
that make dumb ones a bit smarter.



appLe hOme Smart Kitchens

Water, water, 
everywhere?

 Many leaks occur in 
the kitchen, from your 
sink, washing machine 

or other appliances. 
You can get early 

warning of leaks from 
devices like the miGuard 
Wireless Flood Detector 

(£25, bit.ly/2a9zcYF). 
This lets you place two 

small water sensors 
near pipes, and can 

trigger a warning siren 
or send a notification 
to your iPhone in the 

event of a leak.

 The devices we’ve 
looked at here are  

part of the Internet of 
Things (IoT), and talk  
to your iPhone using  

Wi-Fi or Bluetooth. 
However, there are 

other high-tech devices 
for your kitchen that  
we like, even though 

they don’t connect to 
iOS or the internet.  

LG makes a fridge that 
lights up and enables 

you to see through 
its door when you tap 
on it, and even opens 

the door automatically 
if it senses your arms 

are full of shopping.

to put food in it and take it out when it’s 
ready. There have been a couple of 
IoT-connected cookers sold in the US, such 
as LG’s already-discontinued Smart ThinQ, 
and the Dacor Discovery IQ, which lets you 
preheat the oven and check temperature 
from an app, but cookers don’t seem to be 
in a hurry to join the Internet of Things

In contrast, connecting your washing 
machine to the internet can be useful. 
Many people prefer to use their washing 
machine at specific times of day, and 
Whirlpool, LG and Samsung all have 
app-connected washing machines that 
you can load before you leave home and 
then control them during the day using 
your iPhone. You can select program 
options such as an extra wash for really 
dirty or muddy clothes, and the iOS apps 
also provide useful diagnostic options to 
make sure the washing machine is kept in 
good condition. Again, LG’s ThinQ range 
is only available in the US, and you’ll have 
to hunt around to find Whirlpool’s new 
Supreme Care FSCR12241 in the UK 
(£900, whirlpool.co.uk), but Samsung’s 
smart washing machines have been 
available here for a couple of years now, 
with prices starting at around £550 for 
the WW6500 AddWash.

Super-smart fridges
Samsung is also leading the field with 
smart refrigerators, and grabbed plenty 
of headlines in January with its Family 
Hub Refrigerator. This super-fridge is 
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A temperature sensor in the Pantelligent’s handle 
communicates with the pan’s app to help you cook 
things to perfection by giving you guidance.

equipped with Wi-Fi, a 21.5-inch HD screen 
and built-in speakers, enabling you to look 
up recipes, check the weather, and even play 
some music while you’re cooking up a storm. 
The Family Hub also has three cameras inside 
it that enable you to view the contents of the 
fridge on your iPhone, so you can check 
supplies you need to pick up on your way 
home. Prices start at around $6,000 (about 
£4,565) in the US. However, Samsung hasn’t 
set a launch date for the UK yet. Whirlpool’s 
new 6th Sense fridge is due here later this 
summer, though this model doesn’t seem 
to have the extravagant colour screen and 
cameras of its Samsung rival.

If you don’t want to pay for a brand new 
fridge, Smarter has come up with a couple 
of neat accessories that allow you to add 
some internet smarts to your existing model. 
Its Fridge Cam enables you to remotely view 
the contents of your fridge, and you place its 
Smarter Mat in your fridge, tell its app what 
you’re putting on it, and the Mat will check 
the weight of those items and warn you 
when they’re running low. Smarter hasn’t 
announced pricing for these yet, but they’re 
due later this summer – likely at a lower cost 
than Samsung’s expensive super-fridge!

iFacts…
3 meals
 The NHS’s recommended 

number per day – that’s a lot 
of time spent in the kitchen!

 
£897 million
 The UK’s spend on kitchen 

gadgets in 2015, says Mintel.

62%
 The UK government’s figure 

for home fires that started in 
kitchens during 2013–2014. 

 
7 million tonnes
 Food wasted every year, 

says a House of Lords report.

The Mat helps at times when 
you know you have an item in 

your fridge, just not how much.

How smart is ‘smart’?
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fiVe Of the beSt

Drop Kitchen 
Scale £80
getdrop.com
> As well as working as 

a straightforward set 

of kitchen scales, this 

Bluetooth-enabled device 

can link up with recipes in 

its iOS app to ensure you 

get all your ingredients 

just right. It can even 

suggest alternatives, 

in case you run out of 

any of those parts.

Pantelligent  
£170
pantelligent.com
> Sensors in this smart 

pan allow you to precisely 

monitor the temperature 

of your food using its app 

on your iPhone. The app 

has dozens of recipes, 

and can prompt you to 

turn things over or add 

ingredients at the right 

time, as well as warn you 

if something’s burning.

WW6500 
AddWash £550
samsung.com/uk
> Sometimes referred to 

as the WW80K6414QW, 

this is one of Samsung’s 

older, more affordable 

smart washing machines. 

You can turn it on or off 

and select programmes 

from its iOS app. We like 

the AddWash feature that 

lets you slip in extra items 

after a wash has started.

Weber iGrill Mini  
£30
weber.com
> This affordable little 

gadget is really handy 

for cooking meat on a 

BBQ. You can put your 

feet up and have a beer 

while your burgers and 

steaks are cooking, and 

Bluetooth connectivity 

enables it to send a 

message to your iPhone 

when everything is ready.

the drop Kitchen 
Scale’s app smartly 
adjusts ingredients in 
its recipes to suit you

Smarter Coffee 
Maker £180
smarter.am
> We thought the iKettle 

was a bit pricey, but £180 

isn’t over the top for a 

high-quality coffeemaker. 

Wi-Fi connectivity and a 

versatile app allow you 

grind and brew remotely. 

You can specify the grind 

strength, and set an 

alarm to wake you with 

a cuppa in the morning.



 HoW To brew coffee using your iPhone 

appLe hOme Smart Kitchens
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1As you like it
The first thing you’ll want to do with the 

Smarter Coffee Machine is tell it how you like 
your coffee. You can choose a strength to use 
by default, or change it manually if you need 
an extra-strong shot before an early meeting.

2The daily grind
You can set other brewing preferences, 

including the number of cups you need, and 
how long you want to keep the coffee warm 
in the carafe. If you need extra cups for visitors, 
you can change settings just by tapping icons.

Genius Tip!
 The Smarter app  

(bit.ly/29Pygd8) can 
use the GPS feature 

on your iPhone to 
monitor your location 

and start a brew when 
it sees you’re coming 

home from work.

you can look up 
recipes, check on 
the weather, and 
even play music 
while you’re cooking

Explained
air qUaLity
 Your home’s indoor 

air quality (IAQ) can 
be affected by volatile 
organic compounds 
(VOCs), which can include 
fumes from bleach and 
other kitchen cleaning 
products, as well as 
dry-cleaning chemicals 
and many types of paint.

1

friDGe Of  
the fUtUre

 Samsung’s Family Hub is 
a high-tech extravaganza 
with Wi-Fi connectivity, 
an HD touchscreen and 

speakers, so you can look 
up recipes or watch the 

news while you’re cooking.

2

miLky Way
 Inside the Family Hub are 
three cameras that allow 
you to view the contents 

of the fridge on your 
iPhone, so you can see 

what you need to pick up 
on your way home.

1

2
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 What eLSe ShOULD i cOnSiDer?

Smart Kitchens appLe hOme

3Rise and shine
You can activate the device using your 

iPhone, and you can also set an alarm to wake 
you up in the morning and start the coffee 
brewing at the same time. The machine will 
give you another nudge when it’s ready.

4 Fill it up
Sadly, we’re not at the stage where the 

Smarter Coffee Machine can fill itself. In case 
you forget to top it up, safety features include 
the ability to detect a low water level, and when 
the carafe has been removed altogether. 

Jargon Buster
 Cheaper coffeemakers 

use blades to chop up 
the coffee beans, while 
more expensive models, 
including the Smarter 
Coffee Machine, use 
‘burr grinders’ that 
crush the beans and 
produce a more uniform 
size of coffee particle.

our kitchen can smell 
wonderful sometimes:  
fresh coffee, sizzling 
bacon, or a nice roast 

dinner are the sorts of smells that 
can really make you feel at home. 

Y
There are other kitchen smells that 
aren’t so great. Food that’s going bad 
can smell nasty, and some odours 
can be dangerous, such as gas leaks 
or a cooker that’s burning something. 

There are several air quality 
sensors that can monitor levels of 
CO

2
 pollution in the air, and more 

specialised sensors that specifically 
monitor indoor air quality.

Elgato’s Eve Room (£70, elgato.
com) can monitor levels of several 
organic chemicals and pollutants in 
the air, and Withings’ Home security 
camera (£170, withings.com/uk) has 
a similar sensor built in to help you 
monitor IAQ. Also consider the Nest 
Protect smoke alarm (£89, nest.com/
uk) for its early-warning system that 
can nudge you to check on burning 
toast in your kitchen before it sets 
off a full-scale fire alert.

Bring your kitchen’s safety bang up to date 
with sensors that can tip you off to danger

OUt Of the fryinG pan – 
bUt nOt intO the fire
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appLe hOme Gadgets

hOme GaDGetS 

Geo Cosy 3 Smart 
thermostat £180
geotogether.com

originally launched through 
Kickstarter a couple of years 
ago, the Cosy is a home-grown 
addition to the range of smart 

thermostats that are now available for your 
home’s heating system.

Developed by Cambridge-based Geo, 
the Cosy takes a slightly different and more 
flexible approach than most of its rivals. 
The thermostat consists of three separate 
components, including an adaptor that plugs 
into your broadband router, and a switch 
that connects to your boiler and turns it on 
or off as required. The third element is the 
temperature control, the Cosy Display, which 
is designed to be portable, rather than fixed 
to the wall in one specific room.

Most of the time, the little pod-shaped 
Cosy Display will sit in its charging dock in 
one location, such as your front room or 

hallway. However, it’s battery-powered, 
which enables you to pick it up and carry it 
into another room whenever you want – 
perhaps taking it into an upstairs bedroom on 
a cold winter evening. Alternatively, you can 
buy a kit with two Cosy Displays and leave the 

1

 What yOU neeD next…

indoors or outdoors, here’s the tech you  
need to create your new smart home

second one upstairs all the time. 
And, of course, you can also control 
the entire system from an iPhone 
app, or with a web browser on your 
Mac or PC. The iOS app includes 
predefined settings for different times of 
day, and it allows family members to create 
up to seven customised heating schedules 
to suit their different routines. The app 
even keeps an activity log so you can 
see when the heating was turned up  
or down by other people. 

Cosy up to your wallet
The basic Cosy kit costs £180 with 
a single Cosy Display, or £250 with 
two of them. Additional displays cost 
£70 each, or £150 for a fancy version 
with a real wood finish.

There’s also an optional controller 
available for homes with a separate hot 
water tank (£30), and if you don’t feel 
confident about installing the thermostat 
all by yourself, you can get a professional 
engineer to install it on your behalf, which 
costs a further £70. 

Geo’s system consists 
of an adaptor for your 
router, a switch for your 
boiler, and a controller

For even  
more smart 
home advice 

subscribe 
today!
See page 46

Though it’s more than double the price of the regular Cosy Display, the wooden one looks stylish.

The Cosy Display is 
battery-powered and 
small enough to carry 
between rooms.
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Gadgets appLe hOme

Misfit  
Ray £73

KitSound Ovation Soundbar From £150

misfit.com

kitsound.co.uk

Smart  
ideas
hOme in 
iOS 10

There are plenty of soundbars available that can beef up your 
TV’s audio output, but Kitsound’s Ovation is one of the first 
we’ve seen that can also be used as part of a multiroom 
speaker system. You can buy the Ovation on its 

own for £150, with HDMI, digital optical, and Bluetooth 
connectivity, but step up to £220 and you also 
get a Wi-Fi adaptor that enables you to 
stream music to other KitSound 
speakers connected to your 
home network. The KitSound 
app works with services 
such as Spotify, Napster 
and Rhapsody – but 
there’s no support for 
Apple Music right now.

Netatmo  
Welcome tags £90
netamo.com

Netatmo has updated its 
Welcome security camera to 
work with the company’s new 
security tags. A pack of three 

tags costs £90, and these little sensors can be 
attached to doors and windows, sending you 
an alert via the Welcome camera if they open, 
or if they detect vibrations such as breaking 

glass. The Welcome app has 
also been updated to allow 
you to upload your security 
videos to Dropbox, so you 
don’t have to pay for an 
online storage subscription.

We’ve seen plenty of 
identikit fitbands recently, 
but the new Misfit Ray is 
one of the most stylish 

offerings we’ve seen to date. It’s designed 
to look like a friendship bracelet, and is 
so slim and light that you can easily wear 
it on your wrist alongside a watch or a 
bracelet. Its accelerometer can measure 
steps, distance, and calories burned, and 
it’s waterproof to a depth of 50 metres 
too. Prices start at £73 with a rubber 
sport band, or £87 if you prefer the 
luxury of a smart leather strap.

3

Get your home ready for the next 
generation of wireless networkingnext iSSUe  

2

4

 In recent months 
we’ve seen Amazon’s 
Echo and Microsoft’s 
Cortana starting to 
give Apple’s HomeKit 
and Siri some real 
competition, but at 
June’s WWDC event 
Apple started to get 
its act together on 
home automation.

The HomeKit 
framework has been 
updated so that it can 
control a wider range 
of devices, including 
security cameras and 
door locks, and there’ll 
be a new app, Home, 
included in iOS 10 to 
enable you to more 
easily control all your 
smart home devices in 
one place. According to 
Apple, there are even 
property developers in 
the US and China that 
now put HomeKit into 
their new builds, so 
buyers can control their 
entire abode from the 
moment they move in. 

It’s early days, but 
we’ve already heard 
from companies such 
as Withings, which has 
announced it’ll be using 
the improved HomeKit 
in its security cameras 
once iOS 10 launches in 
autumn. So maybe the 
Apple Home of your 
dreams is finally about 
to become a reality.

The Ovation Soundbar 
has the connections 

you need to make 
it the heart of your 

home entertainment.
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ver wondered if there’s 
something better than 
Apple’s Mail, more 
capable than Calendar, 
or superior to Safari? 

This feature looks at the most-used 
Mac apps and shows you how to 
power up your workflow with better 
third-party alternatives. Some are 
free, but we don’t shy away from 
those with a price; our choices are 
genuine enhancements for your Mac.

UPGRADE  YOUR 

MAC     pp
Craig Grannell showcases the best 
alternatives to Apple’s default apps 

Preinstalled software has existed 
as long as there have been home 
computers, but the truth is many 
people today rarely venture further. 
That’s not surprising when you think 
about it – after all, the modern Mac 
comes supplied with all the basics 
you need to perform all manner of  
tasks, from organising your day to 
navigating files.

However, as much as Apple has 
improved its apps over the years 

E
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through various updates to OS X, 
enterprising developers have sought 
to plug gaps, fill niches, and try new 
things. Often, the result is software to 
thrill a dedicated few, but sometimes 
the end result is accessible and 
powerful enough to warrant serious 
consideration by the masses. Yes, you 
might end up shelling out £10 to £40, 
but, as we’ll show you, apps such as 
Fantastical are really worth it.

In this feature, we explore apps to 
replace Calendar, Mail, Safari, Notes, 
Finder, TextEdit and more. With them, 
you’ll be able to work more efficiently, 
save time, and have a more fulfilling 
Mac experience every day.

UPGRADE  YOUR  

    ppS
22



 macformat.com  @macformat32 | MACFORMAT | SEPTEMBER 2016

1

Fantastical
nless you have the 
memory of several 
elephants and are the 
most organised person 
around, it’s probable that 

you make use of a digital calendar. 
Apple’s own Calendar is a decent app in 
this field. It’s easy to use, has a design 
that marries clarity and elegance, and 
is mostly reliable, bar perhaps the odd 
wobble when attempting to sync data to 
iCloud. On that basis, you might wonder 

why you would need to ‘upgrade’ to 
something else, but any such doubts 
should disappear on using Fantastical.

The app started out differently from 
most of its rivals, which tend to be very 
traditional in nature. Instead, Fantastical 
lived in the menu bar and doubled down 
on natural language input. Rather than 
having you laboriously input details into 
various fields, Fantastical encourages 
you to type as if talking to an assistant, 
interpreting your words and extracting 
the details on your behalf. Perhaps most 
staggeringly, Fantastical mostly got this 
right, and this level of convenience made 
it a must-buy for a large number of Mac 
users, many of whom had enjoyed its 
charms on iOS.

A new lease of life
With version 2, Fantastical grew up. 
Rather than being akin to an accessory 
to Apple’s Calendar, the app’s developer 

Calendar Fantastical
 Comes free with your Mac
  Clean, easy-to-use interface
  Easy to toggle each 
calendar’s visibility

  No list view of events
  Reliant on Notification Centre 
for quick glances

  Excellent natural language 
input for events

  List view for quick browsing
  Speedy access in menu bar
  Quite pricey, and iOS version’s 
a separate purchase

  No mini-calendars

Get a smarter calendar to help  
manage your busy schedule

The month 
calendar

Fantastical’s level of 
convenience made it 
a must-buy for a large 
number of Mac users, 
many enjoyed it on iOS

VS

U

Originally more like a Calendar 
add-on than a fully fledged app, 
yet Fantastical 2 is true rival with 
plenty of innovations, such as all 
your events in a sidebar, a menu 
bar icon to quickly find things, 
and calendar sets that can show 
or hide based on your location.

Calendar is preinstalled on 
every Mac. It’s a smart, swish, 
modern-looking app, and it’s 
usable too, providing several 
views of your schedule, and 
strong integration with Apple’s 
iCloud service to sync data 
between all your devices.

 At the top of the sidebar is 
a small calendar. Unlike in 
Calendar, there’s no way to 
see several of these at once, 
but you can use the arrows 
or swipe two fingers left or 
right when the pointer‘s 
over the mini-calendar to 
preview a different month. 
Coloured dots under a date 
indicate events on it from 
specific calendars. Only 
three dots can be shown 
under a date, regardless of 
how many events you have 
scheduled on that day.

1

2
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A list of 
your events

An overview 
of the year

The Mini  
Window

Fantastical’s 
preferences

2 3 4 5

 Fantastical’s List view is 
an endlessly scrolling 
ticker that makes it far 
easier to see your day’s 
events and those that are 
upcoming. It’s linked to the 
main view on the right, so 
move the Week view 
a couple of weeks into the 
future will update the list 
too. Similarly, scroll the list 
and the main view adjusts. 
You can set it to show only 
events from today or today 
and tomorrow in the app’s 
Appearance preferences.

 Rather like Calendar, 
Fantastical’s Year view 
provides a heat map, 
intended to show at a 
glance how busy you’re 
going to be on any given 
day. Light yellow days have 
few events. Those that are 
red should probably be 
investigated, in case you 
can reschedule something. 
Unlike Calendar, you don’t 
have to click a date to see 
what’s scheduled. Put the 
pointer over one to get a 
quick preview of events.

 The Mini Window starts 
life in the menu bar. Click 
Fantastical’s icon there to 
gain insight into some 
upcoming events, a month 
calendar (which defaults to 
the current one), and the 
means to add a new event 
by double-clicking a date or 
search for an existing one 
by clicking and typing at 
the top. Click the cog icon 
(bottom right) and choose 
Detach Mini Window to 
make it stick around and  
float above other windows.

 Fantastical’s preferences 
contain many ways to 
tailor the app. In General, 
you can pick a default 
calendar and reminders 
list for new items. Under 
Calendars, you can create 
calendar sets to pick which 
are visible in one click, or 
when you arrive at or leave 
a location. In Alerts, pick 
which go to Notification 
Centre, and set default 
timings. Click Advanced to 
adjust behaviours relating 
to maps and time zones.

3

5

4



Create a new event
Set Fantastical to its Day view. 

Click the + above the sidebar to start a 
new event and type “Lunch on Sunday”. 
The main calendar dims and the event is 
highlighted there, updating as you type.

Add a time & duration
Next, add “at 1pm for two hours”. 

These details are automatically added to 
the ‘starts’ and ‘ends’ fields in the card 
below the input area, and the Lunch 
event on the main calendar adjusts too.

Refine it further
Optionally, add a location and an 

alert, such as “alarm one hour before”. 
Assign the event to a calendar by typing 
a slash and the calendar’s name – one 
letter often works, such as ‘/h’ for ‘home’.

HOW TO Add an event using plain language >

deemed it was instead time to replace it. 
Now, we have an app that betters Apple’s 
in almost every way. Fortunately, 
Fantastical hasn’t lost touch with its 
roots. Although it’s now a full calendar 
app, Fantastical’s menu bar component 
remains, providing you with fast access 
to the month’s calendar and upcoming 
events, along with the ability to input 
details for a new event or search for an 
existing one.

Fantastical’s menu bar icon proves 
useful, too; it shows today’s date by 
default, but you can optionally add the 
weekday or month, or set it to detail 
today’s remaining events or incomplete 
tasks. The menu can be invoked with a 
click, or by pressing ≈+å+[spacebar]. 
(You can edit this shortcut in the app’s 
General preferences.)

The big picture
In Fantastical’s main window, you get 
something more akin to Apple’s app – 
day, week, month and year views – 

though with a large sidebar on the left. 
The sidebar houses a small calendar 
that initially shows the current month, 
beneath which is a list that summarises 
all your events.

That list is the other big benefit over 
Calendar, since it gives you a very quick 
and easy way to scroll through upcoming 
events; this offers focus compared to 
scanning events across many days on 
a traditional calendar. However, the 
sidebar and main view are linked to each 
other, so selecting something on one 
updates the other, ensuring both are 

zeroed in on the same event. Each view 
therefore actually reinforces the other, 
providing useful context.

Make a date with destiny
It’s possible to add new events from 
either part of Fantastical’s window – 
the process for doing so in the sidebar 
is outlined in the three-step ‘how to’ 
below. In short, though, you can often 
type a description of an event like you 
would say it out loud and Fantastical will 
understand what you mean. Calendar 
makes a stab at doing this, too, but isn’t 

When you type event 
details like you’d say 
them, Fantastical 
copes better with 
nuance and detail

Fantastical works with your existing iCloud calendar and reminders data, as well as other popular services.
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Skype 
 FaceTime’s great when it 
works, but we find it can 

choke on poor connections. 
Also, it’s only on Apple kit, 
but Skype’s on every major 
platform, and can be used 

to call phones at cheap rates, 
making it a great substitute.

bit.ly/mfkndl

Spotify
 To say iTunes has become 
bloated is something of an 
understatement. Spotify is 

more svelte, doubling down 
on streaming in a manner 

that’s more usable than 
Apple Music. Its weekly 

playlist is particularly great.
spotify.com

Dropbox 
 Apple’s iCloud Drive gives 

you a place to store files 
online, providing you with 
access to them on various 
devices. However, Dropbox 
has a ton of app integration, 
superior sharing options, and 
works on more platforms.

bit.ly/mfdri

In Fantastical’s Year view, place the pointer over any 
date to get a preview of the events scheduled for it.

as smart regarding 
nuance and details. For 
example, “Meet Christian at 
11am at MacFormat HQ for two 
hours on Friday, and set an alarm 
30 minutes before” works perfectly 
in Fantastical. In Calendar, the meeting’s 
duration is reduced to an hour and lacks 
the alarm, which you then have to set 
manually. This isn’t to say Fantastical 
gets everything right every time, 
because it doesn’t. But, experiment 
a bit and, where necessary, learn its 
vocabulary and you’ll find it’s a great 
timesaver and far superior to Calendar 
for adding events using plain language.

Set yourself up for success
Another area in which Fantastical beats 
Apple’s app is calendar management. 
To be fair, the latter is simpler, listing all 
your calendars in its sidebar, where you 
can show or hide them individually based 
on what you need to see at any time.

With Fantastical, the process is more 
involved, but it can be automated in an 
interesting manner. In the Calendars 
section of the app’s preferences, you can 
turn on and off individual calendars, and 
you can also create calendar sets, which 
enable you to show or hide several at 
once. You can switch between sets 
manually in View > Calendar Sets, using 
the pop-up at the bottom of the sidebar 
(or using the keyboard shortcuts listed 

there), or automatically, based on your 
location. So, you can arrive at work and 
have your office calendars ready and 
waiting, go home and see your personal 
ones and, presumably, go on holiday and 
occasionally stare at a calendar that 
states “Holiday! Hurrah!” as an all-day 
event every day for two blissful weeks.

Fantastical has basic integration with Apple’s Reminders 
app, and shows timed reminders on the main calendar.

The calendars you see 
can be activated based 
on your current location.

Other apps

Upgrade your Mac apps FeATURe
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lthough it has plenty of 
options, Apple’s Mail 
feels quite rigid in use. 
The main reason to switch 
to Airmail (airmailapp.com) 

is that it’s so flexible and accounts for 
people with vastly different ways of 
working with email. Also, its wealth of 
options make it extremely efficient for 
blazing through bulging inboxes, hurling 
yourself with merry abandon towards 
the promised land of ‘Inbox Zero’.

It all starts with browsing your 
messages. This works in much the same 
way as in Mail, enabling you to sort your 
inbox by various criteria, such as sender, 
subject, or date; unlike Mail, keyboard 
shortcuts are already assigned, speeding 
things up a little. Airmail goes further, 
with a set of filters that make life a bit 
easier. For example, you can quickly 
hone down the list to messages with 
attachments (although, sadly, you can’t 
just peruse the attachments on a grid 
view — a hint, there, for version 4, if the 

developer’s reading). It’s also possible to 
show or select all of the emails in your 
inbox that are from the same sender.

When it comes to actually dealing 
with your messages, Airmail provides a 
wealth of tools. Actions can be assigned 
to gestures and inputs. There are the 

Airmail

usual left and right swipes, but also 
four buttons that sit at the top of the 
Message Detail pane; a few keyboard 
shortcuts can have actions assigned to 
them as well. With a little setting up and 
development of muscle memory, you 
can quickly rifle through your inbox 

Use this Mail replacement to sort, compose, 
and manage email with ease

A

Airmail
Airmail feels like a more modern app than Apple’s, partly 
due to its iOS-inspired design. Still, this is a proper Mac app, 
fully utilising keyboard shortcuts, and with plenty of power 
and features if you want to do more than Mail allows.

Mail
Apple’s Mail is a usable and somewhat customisable email 
client. You can add plug-ins to extend its functionality, and 
fiddle around with the interface to make it more suitable for 
you. It is, though, somewhat rigid in how you work with email.

Airmail provides a number of different ways for you to quickly filter the contents of your inbox.
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unsubscribing from mailing lists, 
bouncing spam messages, archiving 
email, and uploading documents. 
(Airmail can be linked to cloud services, 
so you can send attachments to the likes 
of Dropbox or FTP, or even save entire 
messages to Evernote.)

Plugged in for productivity
Airmail also has a task-based approach 
to email, although these features are 
optional. You can mark a message as a 
to-do (needs action), a memo (a thing to 
memorise or stash), or done. If you don’t 
have time to deal with something right 
now, but don’t want it in your face, the 
relevant message can be snoozed 
instead. Also, if you’re a fan of fully 
fledged task managers, you can fling 
messages their way instead.

Airmail has plenty to offer above and 
beyond Apple’s app where composition 
is concerned, too. Although Mail gives 
you the capability to format messages 
(something Airmail broadly matches in 
terms of text styles and font access), 
Airmail interestingly lets you type in 
Markdown, with a split-screen live 
preview of how your message will appear 
as you do so. This is a niche feature, of 
course, but it’s something that will be 
welcome if you’re one of those people 
who lives and breathes Markdown, and 
so find yourself adding a hash symbol 
before a heading in Mail before sadly 
realising the app is not Markdown-aware.

A quick tour of Airmail

1  The accounts (shown) 
and folders columns can 
be hidden entirely. When 
expanded, the latter shows 
your folders, or mailboxes. 
You can pick the icon that’s 
used for an account.
2  The selected inbox’s 
appearance is defined by 

the Theme option in the 
apps’s Appearance prefs. 
You can toggle whether 
emails are threaded by 
conversation, and apply 
filters to the list.
3  Up to four action 
buttons can be set up. 
Additional options are 

accessible by clicking the 
ellipsis to the right.
4   The message detail 
pane is optional. Message 
threads are collapsed by 
default, but you can alter 
this by turning on ‘Expand 
Conversations’ in the app’s 
Appearance prefs.

Airmail enables you to style the text in your messages 
using Markdown syntax and see a live preview of it.

Airmail offers a task-
based approach , so 
you can mark a 
message as a to-do,  
a memo, or done.

Kindle
 This suggestion veers very 

much towards the practical. 
Objectively, Kindle isn’t 

especially great, but it does 
give you access to Amazon’s 

colossal bookstore, which 
works with far more devices 
than Apple’s iBooks format.

bit.ly/mfkndl

Google Maps
 Okay, this one isn’t actually 

a Mac app – you access it in a 
browser – but Google’s maps 

are far better than Apple’s 
for finding points of interest, 
planning journeys by public 
transport, and checking out 
locations using Street View.

maps.google.co.uk

Alfred 
 If you feel Spotlight could 
and should do more, try 

Alfred. Its interface is akin 
to Spotlight’s, but offers far 
more control over whatever 
file you select. The app’s also 

extensible, so you can add 
functionality using plug-ins.

alfredapp.com

Other apps
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hich web browser is best 
for you to some extent 
comes down to the type 
of person you are. Safari’s 
a solid choice on the Mac – 

broadly dependable and well-integrated 
into the operating system. Also, if you’re 
wedded to the Apple ecosystem, there’s 
sense in sticking with it to share tabs and 
data across your Macs and iOS devices.

However, not everyone has such a 
straightforward setup. Perhaps you also 
use an Android device, a Chromebook or 
a Windows PC, in which case Chrome 
(google.co.uk/chrome) is a smart choice 
for your Mac because it affords you a 
continuity of experience and data that 
you’d otherwise miss.

If you don’t care at all about Google 
services, there are still two good reasons 
to consider Chrome. Historically it has 
been far superior than Safari when it 
comes to implementing cutting-edge 
web standards, meaning it’s more likely 
to work with emerging technologies, 
such as advanced web games. In our 
experience, Safari works reasonably well 
with many such titles, but if something 
doesn’t work, chances are it’ll be just 
fine in Chrome – at which point you’ll 
wonder if you should just use it full-time.

The other motivation to use Chrome 
is extensibility. Safari provides support 
for extensions, but 
the sheer range of 
them for Google’s 
browser dwarfs 
what’s available for 
Apple’s. In part, this 
is due to Google’s 
attempts to make 
Chrome a viable 

platform in and of itself. Regardless, 
a quick visit to the Chrome Web Store 
(bit.ly/mfchromews) reveals all kinds of 
extensions for working with popular web 
services, blogging, communicating with 
friends, downloading content, and 
tailoring the browser. Managing Chrome 
extensions is simple, and in many cases 
you can choose whether they work in the 
Incognito private browsing mode.

Extra spit and polish
There are smaller touches in Chrome 
that make it pleasant to use. It has long 
enabled you to mute a noisy tab — 
something Safari only recently caught 
up with. It also has options to duplicate 
a tab and reload it in the background — 
handy, respectively, when shopping or 
wanting to keep several pages current.

There is one downside to Chrome 
that’s worth noting, though, which is its 
tendency to be resource-hungry. Quite 
often on MacBooks, you’ll find Chrome 
lurking in the ‘Apps Using Significant 
Energy’ sin bin. However, quite how 
much Chrome will batter your battery 
will be down to your particular usage. 
So, if you fancy a browser that’s more 
extensible than Safari, and that’s 
well-integrated into Google’s services, 
at least give Chrome a go — just keep 
an eye on your Mac’s resource usage!

Google Chrome
A better way to browse if you’re not monogamous with Apple

One of the main reasons 
to switch to Chrome 
is the huge range of 
extensions available to 
help you personalise it.

Other apps

W

Opera
 This web browser has 

doubled down on speed 
and privacy, with an ad 
blocker and VPN 

(virtual private network) in recent 
releases. It also aims to be kind on 
your MacBook’s battery. 
opera.com

Firefox
 Mozilla’s browser isn’t 

especially Mac-like, but 
it is fast and customisable. You can 
quickly tailor its toolbar, or install 
any number of add-ons and themes.
bit.ly/fox

Tor  
 If you want the utmost 

privacy, Tor essentially 
bounces your communications 
around the world, preventing 
anyone learning your location and 
visited sites. torproject.org

1> On first running Chrome, you can 
start from scratch or use Chrome > 
Import Bookmarks and Settings to 
grab your existing stuff from Safari. 
2> By signing in to Chrome using a 
Google account, you can share your 
bookmarks, history and saved 
passwords across all your devices.
3> Choose Windows > Downloads for 
a list of recent downloads, which  
details file names and types, and 
provides links to them in Finder.
4> To browse without leaving a trace 
of it in your history, pick File > New 
Incognito Window. That window’s 
tab bar will be blue as a reminder.

Chrome tips
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Evernote
ith OS X el Capitan, Notes 
underwent some major 
changes. Rather than only 
offering textual notes, the 
app acquired a modicum of 

enhanced formatting options, such as the 
ability to style text as headings or 
checklists, place images (including 
hand-drawn sketches on iOS), and add 
map and web links. Of course, it works 
nicely across Macs and iOS devices.

Evernote (evernote.com) goes a lot 
further, though. Like many alternatives 
we’re talking about, it works on more  
platforms, and it can capture and store 
pretty much anything – even entire web 
pages using its Web Clipper extension.
 
Much ado about noting
Notes also pales by comparison when 
managing large collections. It lets you 
bung notes in folders, but that’s about it. 
In Evernote, individual items can be 
tagged to group related files across 
multiple notebooks. It lets you share  
notes for collaboration, as well as merge 
or assign reminders to them.

Evernote is clever with images too. 
You can annotate them, and the service 

attempts to read text in scanned docs. 
It’s quite something to send a scan to 
Evernote and find it’s fully searchable 
almost immediately.

Evernote has other tricks too, but 
you’ll need to pay to use some of them.
Unlike Apple’s app, you don’t get the 
entire thing without paying, otherwise 
your monthly uploads are restricted 
to 60MB, and you must be online to 
access notes on iOS (though not on the 

Mac). Evernote Plus (£29.99 per year) 
gives you 1GB of uploads per month 
and the ability to add emails to notes. 
Premium (£44.99 per year) can search 
within PDFs, scan business cards, and 
show previous versions of notes.

We think Evernote’s worth the cost, 
not least due to its feature-richness. 
Even the relatively limited free version is 
worth a look, though a recent change 
limits you to using it on two devices.

Evernote goes beyond OS X’s Notes, enabling you to grab and annotate web pages.

W

Take your notes further with improved access, search and OCR smarts

1 Upload an image
Evernote’s examines each image 

you add to it, and enables you to search 
any text within them. Scan or photo a 
receipt, crop and save the image, then 
drag it on to Evernote’s Dock icon.

2 Add some info
Evernote should automatically 

recognise the image is a receipt. Even so, 
change the note’s title to something 
suitable. Click in the Tags area and add 
terms you’ll later use to find the receipt.

3 Search in Evernote
Use Evernote’s search field to 

search for your tags. Next, search for a 
word within the receipt’s text – Evernote 
will often find it, showcasing its power to 
store snippets besides your typed words.
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ath Finder’s website 
(cocoatech.com) neatly 
sums up the main reason 
to use it: “Path Finder’s 
philosophy is to let you 

work how you want”. This isn’t the case 
with Apple’s file browser. While Finder 
has admittedly improved in recent years 
with things like tabs, it isn’t nearly as 
flexible as this third-party rival.

At a glance, Path Finder doesn’t look 
all that different from Finder, but you’ll 
immediately notice there are a lot more 
panes in its window. Whereas Finder has 
a sidebar and optional status and path 
bars, Path Finder has a bottom shelf with 
four configurable panels. If that’s not 
enough, you can add four more to the 
right-hand side of every window, and 
a Cover Flow pane that sits above the 
Icon, List or Column view you’ve chosen 
for the main one.

Keep a reign on complexity
Because of this flexibility, Path Finder 
has the potential to become confusing 
and cluttered; but with focus and care 
it can vastly speed up common tasks 
you would normally perform in Finder. 
Search filtering is extremely snappy, the 
dual-pane mode is excellent for manually 
copying items between two folders, and 
its contextual menu can be customised 
to include only those options you need 
when you ≈-click or tap two fingers.

Path Finder
Increase your comfort when working with files and folders

1  The Path Navigator 
and Bookmarks Bar 
provide fast access to 
folders but also enable 
you to navigate your 
Mac’s file system. Just 
click the former or 
right-click the latter and 
venture into Contents.
2  In Path Finder’s 
application menu, you 

can opt to use the app’s 
own desktop (so clicking 
there doesn’t activate 
Finder), and, in a nod to 
old hands, a desktop-
based Trash icon!
3  The Drop Stack at the 
top of the sidebar is a 
place you can use to 
temporarily stash files 
while moving things 

between multiple folders. 
The stack‘s contents can 
be compressed, emailed 
or moved as one.
4  The Filter field works 
much like Finder’s search. 
Use it to filter the current 
folder by name. Click the 
magnifying glass icon to 
switch criteria – to search 
your whole Mac, say.

Path Finder’s dual-pane mode is especially handy 
for managing files in different folders.

1> Dual Pane View
Use this mode to 
more easily move 
files around. If you 
like to use keyboard 
shortcuts, press ! 
to open this mode, 
use @ or † to move 
the focus between 
panes, and use %, 
^, & or * to copy, 
move, compress or 
decompress items, 
respectively, to the 
other pane.

P

3> App launcher
Choose Go > Launch 
Application. As you 
type in the app 
launcher’s window, 
it quickly whittles 
down even huge lists 
of apps to match 
your search term. 
The app launcher is 
fully navigable using 
the keyboard, and 
you can assign it a 
keyboard shortcut in 
Path Finder’s prefs.

2> Batch rename
Select two or more 
items, then choose 
Commands > Batch 
Rename. In the new 
window that opens 
you can set actions 
to perform, such as 
replacing text or 
inserting something 
into every filename. 
A preview shows 
how each filename 
will be affected by 
your settings.
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Ulysses
A versatile and powerful replacement for TextEdit

extedit is an app with 
roots that go right back 
to the Mac’s early days. 
Early versions of Mac OS 
bundled TeachText, which 

later evolved into SimpleText. TextEdit is 
the similarly straightforward successor 
on OS X – yet it’s surprisingly versatile in 
many ways, boasting a text engine that’s 
used throughout a large range of Mac 
apps. Notably, you get access to plenty 
of formatting options, making for an 
experience akin to a stripped-back word 
processor. What you don’t get is a great 
deal of help when it comes to writing and 
finding what you’ve previously written.

Poles apart
Ulysses (ulyssesapp.com) is almost the 
polar opposite of TextEdit, and yet for 
many people who do a lot of writing, 
it’s the perfect replacement. It lacks 
word-processor-style formatting, but 
the structure of your text can still be 

outlined using a markup syntax such as 
Markdown, in which a hash (#) signifies 
a heading and hyphens denote items in 
an unordered list.

More importantly, Ulysses boasts 
a library that houses everything you’ve 
ever written in the app. You can organise 
documents into folders, or create smart 
containers based on conditions relating 
to the content or creation date of files. 
You can also virtually or permanently 
merge a multiple-document selection in 
the library, or to export such selections 
to a range of different formats.

Along with powerful searching plus 
syncing your devices via iCloud, Ulysses 
proves itself to be one of the most 
capable tools around when it comes to 
writing. While it won’t allow you to set a 
heading in 48pt Comic Sans and colour it 
red, or merrily add a ton of inline images 
from Photos, Ulysses provides a superb 
environment for crafting, saving and 
later rediscovering your words.

Default  
Folder X

  
 This replaces the regular 
Open and Save dialogs, 
speeding up tasks with 

access to recent folders, open 
Finder windows, and more.

bit.ly/mfdfx

VLC
 It’s a stretch to say this is a 

QuickTime replacement, as 
Apple’s app works fine with 
many movie and audio files. 
Yet, VLC’s a great option if 

you do get problems. 
videolan.org

BetterTouch 
Tool

 This add-on for your input 
devices enables everything 
from key sequences to extra  
Multi-Touch gestures to get 
more from your accessories.

boastr.net

T

Ulysses is an excellent app for 
writing and also accessing what 
you’ve previously written.

Other apps

SEPTEMBER 2016 | MACFORMAT | 41 macformat.com  @macformat





More great alternatives
Replace Calculator, Activity Monitor, Preview and Time Machine!

The main thing Calculator has going for 
it is its instantly recognisable interface 
and operation. But that brings limitations 
and a lack of context and flexibility for 

complex calculations. By contrast, Soulver (acqualia.
com) is weird at first but blows away Calculator once 
you grasp the basics. You jot down calculations in plain 
language and it extracts the numbers and tots things 
up. Line totals become tokens that can be used in later 
lines, everything updating as figures are changed. 
Calculations can be saved, or exported to other formats.

If you run a lot of apps and background 
utilities, it pays to keep an eye on your 
Mac’s resources. Apple’s Activity Monitor 
isn’t terribly efficient as it takes up lots of 

space, and its floating windows for CPU usage are 
a distraction. iStat Menus (bjango.com) puts resource 
monitoring in the menu bar, where tiny graphs detail 
how your Mac’s doing; click one and a drop-down menu 
provides extra detail. It’s also a great replacement for 
the menu bar clock, with a highly configurable world 
clock, sunrise/sunset times, and a world light map. 

With Time Machine, Apple provides a 
way to safeguard data from disaster. 
If your Mac’s startup disk dies, you can 
use Time Machine’s backup to restore 

your files to a new drive. Rather than just backing up 
data, though, SuperDuper (shirt-pocket.com) clones 
your drive, making a bootable backup that can be used 
to start your Mac and have you up and running again in 
minutes. SuperDuper’s also useful for ‘archiving’ an old 
Mac’s final state. Still, since Time Machine backups are 
more regular, we recommend using it and SuperDuper.

To give Preview its due, it’s great for 
opening PDFs, adding annotations and 
moving a few pages around. Spend some 
time with PDF Expert (readdle.com) though 

and it soon comes across rather like Preview Pro. If you 
regularly organise pages, PDF Expert’s page thumbnail 
preview is a godsend, making it a cinch to drag pages 
about to reorder them. To mash a few PDFs together, 
just use the app’s Merge Files command. With Safari-like 
tabs and an easily accessible range of usable annotation 
tools, PDF Expert is a worthy replacement for Preview. 

Soulver iStat Menus

SuperDuperPDF Expert
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 Coming soon in macOS 
pple revealed macOS 
Sierra on 13 June 13, 
packed with new goodies 
that are coming to the 
Mac later this year. In the 

context of this feature, are Sierra’s 
updated apps so much improved that 
there’s less point in using alternatives?

The biggest new feature is Siri. As on 
Apple’s other platforms, this virtual 
assistant permeates the entire operating 
system, providing a new way of 
communicating with your computer. 
Apple’s on-stage demos showed how Siri 
can be used to perform tasks in the 
background or even grab info such as 
weather forecasts from the web while 
you carry on with something else.

Siri should boost usability and 
efficiency when dealing with Calendar 
and in tasks usually done in Finder. In the 
former, you’ll be able to interact with and 
create events using natural language 
– but Fantastical will still have merit 
unless Calendar gains menu bar access 
and a speedy list of your events.

As for file management, Siri looks to 
be really special. You can ask it to locate 
all files from the past week, and then 
only the ones sent from a specific 
contact. It’s also possible to zero in on 
certain documents, such as PDFs in your 
downloads folder. Brilliantly, you’ll be 
able to drag and drop search results and 
pin them to Notification Centre to quickly 
reuse them. It feels like the kind of power 
we see in Path Finder, but through an 
entirely different interface. Also, Finder 
will sort folders above your files, 
removing another reason to use a 
third-party replacement.

Reasons to be cheerful
Safari will make a claim to be your 
primary web browser. Its most notable 
addition is the integration of Apple Pay, 
assuming you have an iPhone or Apple 
Watch for authentication purposes. 
Sierra’s Picture in Picture feature is also 
a draw, providing the means to float an 
online video, for example, over 
everything else so that Safari’s window 
doesn’t clutter the screen. Amusingly, 
one feature might cement Chrome’s 
place on your Mac, at least in the short 

term. Safari 10 will deactivate plug-ins by 
default, and though there will be 
‘use once’ and ‘use every time’ overrides, 
you may find it’s worth keeping Chrome 
around for websites that still use Flash as 
if it’s 2010.

We haven’t discussed replacements 
for Photos largely as there are few 
consumer-oriented picture managers 
we’re fond of. Photos does the job ably. 

Its upcoming Memories feature ferrets 
through your pics and groups them on 
people, locations and scenery it finds.

With this and Siri, it’s clear the Mac’s 
future has a distinct artificial intelligence 
bent. So, be nice to your computer, or it 
might one day sit there in a huff until you 
profusely apologise.

In Photos, Memories are made as a result of image analysis that picks out people, objects and scenery.

Finder searches performed by speaking to Siri can 
be pinned to Notification Centre to reuse later on.

Given security concerns, expect using Apple Pay 
to buy things online to only ever work with Safari.

A

Brilliantly, you’ll be 
able to pin Siri’s Finder 
search results to 
Notification Centre to 
reuse later on
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How the next Mac operating system will upgrade Apple’s preinstalled apps
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#SMARTERMOVIEMAG

“What film features  
the fictional tech 

company Blue Book?

”

www.gamesradar.com/new-totalfilm-quiz

Take the smart movie quiz...



 Understand iOS gestures

EditEd by AlAn stonebridge 

What’s inside 

50–53 
get reAdy for 

new operating systems 

54–55  
design PAges 
newsletters

 Get to grips with 
precise page layouts

56–58  
creAtively 

blend imAges
 Master blend modes 
using Affinity Photo

60–61 
give your mAc 

A once-over
 Test and diagnose 

hardware issues

62–63  
instAll new 
fonts on ios

 Boost creative options 
on your iPhone or iPad

64–67 
rescue old 

Audio mediA
 Give old recordings 

a new, lease of life

 When you see a shortcut like 
ç+å+C, hold all but the 
last key, then press that one.

 ç is the Command key, 
which is also labelled cmd.

 å means the Option key, 
labelled alt or opt.

 ≈  means the Control key, 
labelled ctrl, and shown as ^ 
in shortcuts in the menu bar.

 ß  is the Shift key, which is 
typically just labelled shift.

 ∫  means the Delete key, 
which deletes to the left of the 

insertion point. Press ƒ+ ∫ 

to delete to the right.

 † is the Tab key, which shifts 
the focus between some 
controls in windows and web 
forms. Turn on Full Keyboard 
Access in System Preferences 
to jump between all controls.

sierrA & ios 10

try out betas of Apple’s
 Prepare your devices to
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 master mac keyboard shortcuts

 A tap is a brief contact of 
(usually) one finger on your 
device’s screen.

 To drag is to move a finger 
across the screen to scroll 
or pan around content.

 Swipe means move one or 
more fingers across an item 
or the screen, then let go. 
 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.

 Pinch means move two 
fingers together or apart, 
usually to zoom in or out.

 Touch and hold means lightly 
rest your finger on an item 
and wait for a reaction.

Your new-look guide to 
getting more from 

your Apple kit

new 
ideAs

get 
creAtive 

with blend 
modes p56
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Clone your 
current drive 
and use that 
as a backup 

when you 
install Sierra
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Try Sierra and iOS 10 today
Sign up for Apple’s public beta and take its new systems for a spin

iT will TAke
  At least 60 minutes

yOu will leARn
  How to put Sierra on 

your Mac while keeping 
your current system. 

How to install or 
roll back from iOS 10.

yOu’ll need
  An Apple ID.

A spare external  
hard drive or SSD.

There are several reasons 
you might want to make an 
external startup disk in order 
to try Sierra. If you’ve signed up 

to Apple’s public beta program, for example, 
creating an external startup disk is the safest 
way to try out macOS Sierra while retaining 
the ability to instantly fall back to your current 
version when you need to do some work.

Prior to the new macOS launching, it may 
also be a good idea to do the reverse – create 
a startup disk for El Capitan before you update 
to Sierra. That way, if anything goes wrong, or 
if you find that Sierra causes problems with 
apps or hardware you depend upon, you can 
easily start up in your previous system. 

The processes for each of those tasks are 
different, however. The Sierra startup disk will 
hold a clean install of the new system, or a 
beta of it, and nothing else. If you were to do 
that over your current OS and something went 
wrong with Sierra after upgrading, you might 
have to start over, reinstalling everything, 
losing files that weren’t backed up. At best, 

you’d endure a lengthy restore from your 
Time Machine backup.

So, it’s much better to clone your current 
system and use that as a backup when you 
install Sierra. You should do that anyway, as 
a matter of course, whenever you update the 
operating system or make any major changes 
to your Mac.

Clone your system
There are a number of ways you can clone 
your startup disk, and Carbon Copy Cloner 
(bombich.com) offers a whole raft of options 
for creating clones, including the ability to 
create specific tasks and schedule them. 
It also provides a simple interface designed 
to enable you to easily clone one drive to 
another. The best news of all is that there’s a 
free, full‑featured 30‑day trial you can take 
for a test drive and use to clone your system 
before installing a new one.

In the rest of this tutorial, we’ll show you 
how to create a startup disk for the Sierra 
public beta. The process is similar if you want 
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Genius Tip!
 Install macOS Sierra 

on the fastest drive you 
can. A USB 2.0 drive, 
for example, will work, 
but because the OS is 
continually reading data 
from it during startup, 
and reading and writing 
as you use your Mac,  
it‘ll be much slower to 
use than an SSD.

1

2

3

4

1

Drives and 
volumes

 The left pane 
shows drives,  

and volumes on 
them. Select a 

drive then click 
Erase to wipe it, 
ready for Sierra.

3

Drive details
 The bottom 

of the window 
displays info 
regarding the 
selected drive, 
including its size 
and partition 
map scheme. 

2

Partitioning
 Alternatively, 
click Partition, 

then +, and drag 
the handle to set 

a new partition 
of at least 16GB 

to hold Sierra.

4

Partition  
map scheme 
 With your drive 

selected, ensure 
this says ‘GUID 
Partition Map’ 
so that Sierra 
will start up.

explained… Disk Utility in El Capitan 
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to create a clean, system‑only startup disk 
for any version of OS X since Lion, assuming 
you’ve had an Apple ID for a while and have 
already downloaded previous versions of the 
OS from the Mac App Store. 

You can access any OS X installer from 
Lion to El Capitan, if you have previously 
downloaded them, by going to the Purchased 
tab in the Mac App Store. Just click that tab 
and then scroll through the list of previous 
downloads until you see ‘OS X’ and then the 
name of the version you want. When you find 
it, click Download. This will put an installer for 
that version in the Applications folder, ready 
for you to install on any disk.

Choose a disk
The first thing to do is to decide where to 
install Sierra. An external SSD is perfect as it’s 
fast and will have plenty of space. You’ll need 
at least 16GB. You could use a USB stick, but if 
you want to test drive apps on the beta you’ll 
quickly run out of room on a small stick, and 
it’ll be relatively slow. So, if you don’t have an 
external SSD, your next best option is a USB 3 
or Thunderbolt hard drive, if your Mac has a 
suitable port. If not, a USB 2.0 one will work, 
but it’ll also be slower.

Connect the drive you plan to use. If you 
haven’t already signed up to the beta program, 

go to beta.apple.com and follow Apple’s 
instructions to enroll. You’ll need an Apple ID. 
If you’ve already signed up, go to the same 
site, sign in and, if you’ve enabled two‑factor 
authentication or two‑step verification on your 
account, nominate a device to verify your 
identity, then enter the code Apple sends to it. 

Once you’ve signed in, you’ll be taken to 
the ‘Guide for Public Betas’ page. Scroll down 
it to ‘Get Started’ and click ‘enroll your Mac’. 
On the next page, scroll down to step 2 and 
click the button labelled ‘Redeem Code’. This 
takes you to the Mac App Store, automatically 
submits your redemption code, and starts 
downloading the Sierra beta. Don’t run it yet; 
once downloaded (about 4.9GB), the installer 
will open automatically, at which point follow 
the step‑by‑step walkthrough on page 52.

Installing the Sierra beta on an external 
drive is only one option. Apple’s advice is to 
install it on a secondary Mac. If you have a 
second Mac you don’t use for critical work, 
that’s a good move. Back it up first, though.

You could also partition your Mac’s main 
internal drive, and run a dual‑boot system, 
choosing which OS to run either from System 
Preferences or by holding down å at startup. 
Doing this may require you to wipe your entire 
hard drive – it depends how much free space 
there is and where it is. If that’s necessary, 
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Jargon Buster
 A beta version of 
software is still in 

development, though 
the worst bugs have 
been eradicated and 

it’s ready to be tested 
outside of the company 

developing it. In the 
case of public betas 

like macOS Sierra and 
iOS 10, this means 

anyone can download 
and install the software. 

Genius Tip!
 If you plan to install 

apps on your new 
startup disk, take 

screenshots of their 
Preferences windows in 

your current setup so 
you can quickly refer 

to those when you set 
up the apps in Sierra.  
This will save you the 

frustration of trying  
to remember things.

1 Prepare a drive
Connect the drive where you’ll put Sierra. 

In /Applications/Utilities, open Disk Utility, 
select the drive and check its partition map 
scheme is GUID; if not, cancel and click the 
Erase button instead. Otherwise, click + to split 
the existing partition in two, then drag the 
handle to resize the partition, set its format to 
‘OS X Extended (Journaled)’, then click Apply.

2Begin installation
Now download the installer from the Mac 

App Store, as described on page 51. It’ll open 
once it has downloaded. When it asks where 
to install Sierra, click Show All Disks, select the 
partition you prepared, then click Install and 
enter your password. Click Add Helper to begin 
installing. This could take a while. When it’s 
done, your Mac will restart to finish installation.

 How to Install the macOS Sierra beta 

Cloning your startup disk with a tool like Carbon Copy 
Cloner means you can quickly get back to your old system.
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after erasing and partitioning the drive you 
can use your Time Machine backup to restore 
your existing system, apps and files to the 
reduced‑size main partition, as long as it all 
fits. However, you’ll need plenty of spare time.

Running Sierra in a virtual machine (within 
your existing system) is more fiddly. At the 
time of writing, the latest blogs about doing 
this are at bit.ly/prlsrra for Parallels Desktop, 
and bit.ly/vmwsrra for VMware Fusion.

Is it safe?
Beta software is at a stage where its not yet 
considered fit for broad public release, as it’s 
likely to still have bugs. Whether these bugs 
are minor irritations or big problems is 
anyone’s guess. At this stage, it’s unlikely 
to be the latter, though not impossible.

Nevertheless, treat the Sierra beta with 
caution. Back up all your data, preferably 
using Time Machine or another incremental 
back‑up system, as well as cloning your drive. 
Don’t use it for mission critical work at this 
stage, and don’t store any data on your Sierra 
disk without also creating a copy elsewhere.

As long as you take those precautions, 
there’s nothing to fear. Thousands of people 
are already using Sierra, and so far there have 
been no reports of serious problems with it. 
At this stage, it’s reasonably close to the final 
version, but is likely to get several updates 
before the final release. So, the other thing 
to do is to allow the Mac App Store to install 
updates as they become available. 

What about when Sierra ships?
Keep the disk that contains the beta version 
for a while. If you update your Mac to Sierra 
and find you have problems with, say, Mail, 
comparing your main installation with the 
beta on your external drive may allow you to 
identify whether the problem also exists in 
the beta or just the installation of the final 
version on your Mac. If it’s the latter, you 
might be able to fix it by reinstalling Sierra 
over itself (which ought to fix permissions), 
rooting out troublesome preference files, or, 
as a last resort, with a full clean installation 
of Sierra. kenny Hemphill & Alan Stonebridge
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3Set up macOS Sierra
You’ll need to go through the process of 

setting up the OS from scratch as it’s a clean 
installation. First up, specify your country 
preference for keyboard settings, and allow 
or disallow location sharing. When it comes 
to signing in to iCloud, if you don’t yet have 
an offline backup of all its data, don’t sign in; 
you can do so later in System Preferences.

4Switch between versions
Finally, provide a name and password for 

the admin user account. It can take a while to 
create this on a slow drive. Next, explore Sierra 
and use Feedback Assistant in the Dock to 
notify Apple of issues. To switch back to your 
usual version of OS X, make a persistent choice 
in the Startup Disk preferences pane, or hold 
å at startup to make a temporary choice.

Genius Tip!
 If you decide to roll 

back a device to the 
latest non‑beta version, 
carefully follow all of 
Apple’s instructions 
at apple.co/rollbackios.

Jargon Buster
 Recovery mode puts 

an iOS device into a 
state that allows iTunes 
on your Mac to erase 
the device and install 
the latest non‑beta 
version of iOS that’s 
compatible with it

explained… Get the iOS 10 beta 

The iOS 10 public beta is 
a chance to try out the 
new Lock screen, Raise 
to Wake and much more!
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To get the public beta of iOS 10, go to beta.apple.
com and sign up or in, as for the macOS Sierra beta. 
Scroll down to the tabs for macOS and iOS, click the 
latter, and follow the instructions to back up your 
device. Next, tap the link that downloads and installs 
a configuration profile that tells iOS’s software 
update mechanism your device is eligible to receive 
the iOS 10 beta. Once that’s installed, go to Settings > 
General > Software Update to download the system.

Bear this in mind: at the time of writing, Apple 
had released two beta versions to developers and 
one version to the public. There were six developer 
betas of iOS 9.0, so assume there’ll be issues with 
some of your apps. As such, if you’re able to install 
the iOS 10 public beta on an old or a spare device, 
that’s the best approach, rather than putting it on 
a device you depend on every day.

It’s possible to roll back a device that’s running 
the beta (see the Genius Tip to the right), but not 
long after the final public release of a new version 
of iOS Apple tends to stop authorising attempts to 
install previous versions. If you think you may want 
to stick with iOS 9.0, perhaps due 
to incompatibility between iOS 10 
and an app or accessory, roll 
back your device ahead of that.



Page layout is 
about careful 
arrangement 

of content, not 
just flowing text 

through page 
after page

 macformat.com  @macformat

APPLE SKILLS Mac Software

54 | MACFORMAT | SePteMber 2016

Lay out newsletters in Pages
Discover the part of Apple’s word processor designed for desktop publishing

IT wILL TAKE
  20 minutes

yOu wILL LEARn
  The basic elements 

of magazine-style page 
layout using Pages.

yOu’LL nEEd
  Pages 5 or higher 

(although Pages 4 
had extra features).

not only is Apple’s Pages 
an excellent word processor, 
its Page Layout mode works 
more like a desktop publishing 

(dTP) app. This is ideal when you want to 
create magazine-like layouts, starting with 
a specific number of pages and arrange text 
and pictures on each, rather than flowing 
text through however many pages it needs. 

Here we’ll look at the basic techniques for 
laying out a page. In word processing, you 
start with a flashing cursor at the top left of 
page 1, and your main text (or ‘body text’) 
flows downwards from there, interrupted by 
any pictures you add. In page layout, there’s 
no such assumption. You start with an empty 
page and add text and images within frames, 
sometimes called ‘boxes’.

The boxes themselves are invisible when 
your document is output; they merely hold a 
page’s elements in place. This enables another 
crucial page layout technique: placeholders. 
You can first work out the visual structure of 
your page using random pictures and dummy 
text – anything to fill the space. When you’re 
happy with your layouts, you make a copy of 
the document and then replace the text and 

pictures with your actual content, writing the 
text to fit the space. To create another edition, 
you go back to the original document, make 
another copy, repeat, and so on. (File > Save 
as Template can be used to formalise this 
process, as explained at bit.ly/pgstmplt.)

Facing facts
One thing Pages can’t handle is double-page 
spreads, also known as ‘facing pages’. It did 
have this ability until 2013, and we’d like to 
have it back, but for now you can only lay out 
documents intended for printing on individal 
sheets of paper, or on multiple pages that 
come in a pile or stapled at a corner. Sadly, 
you can’t design bound books or magazines 
that the reader opens to see a left and a right 
page. That’s why the templates supplied in 
Pages’ Newsletters category have only two 
pages: they’re intended to be output on the 
two sides of one sheet. It’s a decent newsletter 
format for a modest amount of content.

Do be aware that newspaper-style columns 
are set in a smaller point size than the 12pt you 
might use for word processing. Try a text size 
of about 8-9pt, with fairly tight line spacing, 
for neat and legible columns. Adam Banks

1

Hello, Page 
Layout mode
 This mode lets 

you work like 
a mag designer, 

placing page 
elements in 

fixed positions.

2

Automatically 
make room
 Each box has 

an optional text 
wrap; text it 

overlaps moves 
across or down, 
out of the way.

3

We’re all in 
the gutter
 A box’s text can 

flow in columns, 
usually of equal 
widths. ‘Gutter’ 
means the space 
between them.

4

Attack of the 
giant insets
 A text inset is 

good for tinted 
boxes, but for 
column layouts 
set it to 0 so text 
fills to the margins.

1

2

3

4

3
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 How to Lay out a page from scratch 

1Make a box for body text
Make a new document based on Pages’ 

Blank template. Pick File > Convert to Page 
Layout and click OK. Choose View > Show 
Layout to see frames. Click the Text button to 
make a text frame, and size it to fit the space.

2Add some dummy text
Paste in any available text as dummy, 

select it all (ç+A) and use the Fonts palette 
(ç+T) to size it to about 9pt. In the Layout 
section of the Format inspector’s Text tab, set 
the number of columns to 3.

3Add an image
Go to Insert > Choose and select an image 

file. It pushes the text aside: this is a text wrap, 
which is tailored in the Arrange tab. See how 
Object Placement defaults to Stay on Page, 
not Move with Text as in word processing docs.

4Add a box for a masthead
Click the Text button again to add a new 

frame, then drag that frame to the top of the 
page, resize it and enter your masthead’s text. 
Set the text’s size in the Fonts palette again. 
Drag the picture below it, leaving neat gaps.

5Add an inset picture
Text wraps can get more interesting than 

our results so far. Use Insert > Choose to add 
another picture, then, with it selected, choose 
Format > Image > Mask With Shape > Oval. 
Your image is now cropped inside a circle.

6 Complete your layout
Drag the slider and handles to resize and 

position within the circle. Click Done. Drag the 
circle and its handles to position it on the page 
(between columns wraps more legibly). Add a 
headline, and fill in the header and footer.

Genius Tip!
 To recrop a picture, 

≈-click it and choose 
Edit Mask. You can now 
move and resize the 
image within its frame, 
as with shape masks.

Jargon Buster
 Dummy text is known 

as ‘lorem ipsum’, after 
the fake Latin that’s 
traditionally used (as 
seen in Pages’ built-in 
templates). However, 
English often works 
better than it.
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A blend mode 
affects how a 
layer interacts 

with those that 
are below it

Creatively blend graphics
Make image layers interact to produce advanced visual effects

IT wILL TAKE
  30 minutes

yOu wILL LEARn
  How the basic types 
of blend modes work, 

and how to layer 
duplicates to change 
the look of an image.

yOu’LL nEEd
  Affinity Photo

If layers are the key to creative 
image manipulation, blend 
modes are the key to layers. 
In this tutorial we’ll explore them 

in Serif’s excellent Affinity Photo, though they 
work similarly in Photoshop CC and other fully 
featured photo and vector graphics editors.

Layers can be a bit confusing at first, 
because they resemble several different 
real-world phenomena without quite working 
identically to any of them. If you import a 
regular photo into a layer, by default it acts 
like a photo printed on a sheet of paper, 
covering up what’s below. This is with the 
Normal blend mode. If you switch its layer’s 
mode to Multiply, the layer acts more like a 
photographic slide – a piece of film that has 
the developed photo on it, but which remains 
translucent, illuminated from behind by an 
imaginary lightbox. Add more layers, and they 
show through each other.

Wherever you’d see white in a printed 
photo, or in a layer set to Normal mode, you’ll 
see nothing – transparency – in Multiply mode. 

Here’s where the metaphor gets a little bit 
confused, because you can also have areas 
that are truly transparent, not white, meaning 
that whatever’s underneath will show through 
even in Normal mode. You’ll be familiar with 
this if you’ve ever created transparent PNG 
images for a website.

Other blend modes work in basically 
the same way, but the way the selected layer 
affects what’s below it differs in each case. 
Behind the scenes, the software looks at 
each pixel in the image in turn, and applies a 
mathematical formula that takes the colour 
value of that pixel in the layer – essentially, 
what colour of the rainbow it is, how saturated, 
and how bright – and the colour value of 
whatever’s underneath (taking into account 
all the layers below), and generates the colour 
value that’s actually displayed for that pixel.  

Where do layers come from? You might 
start with a blank transparent layer and draw 
shapes onto it, like an animator painting onto a 
cel, leaving the area around them transparent; 
or you might start with a photo in a layer and 
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1Open a layered image file
At Affinity Photo’s Welcome screen 

(available by choosing Help > Welcome), 
click the chevron near its bottom-right 
corner to scroll through the sample files, 
and click ‘Beautiful Storm’ to download 
that image. Click it again to open it.

2Hide layers for clarity
In the Layers panel, click the triangle  

to the left of the main group, then leave 
a check mark next to the group’s row but 
clear the marks to the right of each row 
inside it to hide all the individual layers, 
until you get to the last group in the list.

3 Retain required layers
In this final group, which contains 

the model’s face and hair, leave two 
layers checked, as shown above. Click this 
group’s row to select it. Within the group, 
clear the check marks next to everything 
but the very last Background layer.

 How to Understand the basics of blend modes 

4 The Blend Mode menu
The selected group’s blend mode 

is ‘Passthrough’. This means the blend 
modes of layers within the group are 
respected, but the group itself has no 
blend mode. You can now try giving 
the group one to change the effect.

5 Try Multiply mode
Multiply means the colour values of 

this layer (or group) are added to those 
below. It’s like placing a transparency on 
top of another on a light box. Everything 
gets darker; the darkest parts of the 
image look strongest.

6 Try Lighten mode
Screen is the opposite of Multiply; 

it’s like putting the same transparency 
in two projectors pointing at the same 
screen. Lighten, seen here, is simpler: 
comparing each pixel to what’s below, 
the lightest value is kept.

erase parts of it to make them transparent in 
order to cut out an object. Pasting any image 
into your document normally adds it on a 
layer of its own. Remember that transparent 
areas will always remain transparent, and the 
rest of the layer will combine with what’s 
below according to its blend mode.

Will it blend? 
For now, to give you something to experiment 
with, we’ll start by isolating some layers from 
one of the impressive sample files supplied 
with Affinity Photo. As you try out blend 
modes, you’ll notice they fall into various 
groups, although the app doesn’t make this 
explicit. With Darken, Darker Colour, Multiply 

and Colour Burn, the selected layer always 
darkens what’s below. Lighten, Lighter Colour, 
Screen, Colour Dodge and Add always lighten.

Overlay is basically neutral, as is Soft Light, 
while the Hard Light, Vivid Light, Pin Light, 
Linear Light, Hard Mix, Reflect and Glow blend 
modes make shadows darker and highlights 
lighter. Difference, Exclusion, Subtract, 
Negation and Contrast Negate introduce 
negative colours. With the Hue, Saturation 
and Colour modes, the layer to which they’re 
applied only affects the underlying colours, 
not brightness, while Luminosity conversely 
only affects brightness and not colour. 

You’ll get the hang of all this best by trying 
it, so without further ado… Adam Banks

Genius Tip!
 Need to place several 

objects, each of which is 
on a white background, 
side by side? Rather 
than cut them out, just 
use Multiply and bring 
them close together.
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 How to Do more with blend modes 

1 Combine with Overlay
Overlay is a special mode that applies 

Multiply if the underlying pixel is darker 
than 50%, and Screen if it’s lighter. Try it 
when you want two images to contribute 
equally to the result. The Soft Light mode 
is a subtler version of it.

2 Increase saturation
The Dodge and Burn blend modes 

continue the theme of darkening and 
lightening, but with a more colour-
saturated result. Linear Light works 
similarly, and is quite extreme. Notice 
how the lightest areas are burned out.

3Adjust the blending mix
To adjust the effect of any mode, 

click the cog to the right of the blend 
mode menu to open the Blend Options 
dialog. Click and drag points on its graphs 
to balance light and dark areas of the 
layer and the underlying image.

4 Tweak the graph
In the preceding step, we cut the 

Source Layer at the right to let the clouds 
show through the light background, but 
this had unwanted effects on the face 
and hair. Further tweaks to the graph can 
fix that, as depicted above.

5 Create tonal effects
You can get more extreme effects 

by experimenting with both graphs. 
Where the lines form relatively smooth 
curves, gradations will be subtle; where 
you create spikes or verticals, there’ll be 
sudden tonal shifts, like the greys above.

6 Duplicate a layer
A key technique is to blend a copy 

of a layer with the original. Reset the 
Blend Options graphs and set the blend 
mode back to Passthrough, then press 
ç+J to duplicate the selected group. 
Set the copy’s blend to Overlay.

7Add a blur to one copy
The image now appears intensified. 

Next, choose Layer > New Live Filter 
Layer > Gaussian Blur Filter. This applies 
a non-destructive blur, indicated by a 
double triangle icon in the Layers panel. 
Set the blur’s radius to 4px.

8Vary the blend mode
Notice how the skin tones are 

smoothed out, but the details – around 
the model’s eyes, for example – remain 
sharp. Try other blend modes on the 
duplicated group for different effects: 
Darken gives a cartoon-like appearance.

9 Creative combinations
Here we’ve set the duplicate’s blend 

to Lighten and the original’s to Normal 
(hiding the clouds), and then chosen 
Layer > New Adjustment Layer > Recolour 
Adjustment and set its blend to Linear 
Light for a striking monochrome portrait.



 macformat.com  @macformat SEPTEMBER 2016 | MACFORMAT | 59

SPONSORED EDITORIAL

Looking for the perfect NAS device? QNAP’s 
TVS-x82T series is just the thing for Macs

C
hoosing the right network 
storage isn’t always easy, 
especially if your creative 

demands are high, like 4K video or 3D 
modelling. Perhaps you are a creative 
professional such as a designer, photographer 
or filmmaker that needs high storage capacity. 
Well, QNAP’s new TVS-x82T series NAS is  
a perfect match for Thunderbolt 2-capable 
Macs like the Mac Pro, MacBook Pro or iMac. 

Up to 2 Thunderbolt devices can connect 
to the NAS to process real-time video editing 
simultaneously without sacrificing the 
performance, while 4K videos can be directly 
displayed through the HDMI ports. 

Easily share files with created links, 
just like Dropbox. The TVS-x82T series 
supports storage tiering by using QNAP’s 
Qtier Technology, this helps optimise storage 
efficiency across M.2 SSD, SSD and SATA 
drives. They also support hot-swappable 
drives, which means users don’t have to suffer 
from downtime in the event of drive failure. 

Away from work, these NAS devices are 
great as multimedia players by using HD 
Station to enjoy rich apps including Kodi, HD 
Player, Plex Home Theater, YouTube, Spotify, 
JRiver, Google Chrome, Mozilla Firefox and 
more. Give your media the storage it deserves 
by choosing a QNAP TVS-x82T.

The perfect storage 
for Thunderbolt 2

In association with

TVS-882T
TVS-1282T

“The new 
TVS-x82T 
series NAS 
provides an 
ideal storage 
solution for 
Mac users”

TVS-682T
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After a crash 
or freeze, two 
minutes with 

MacCheck 
screens for 

problems you 
need to fix
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Give your Mac a once-over
Quickly test your hardware and diagnose errors with MacCheck

iT will TAke
  At least 5 minutes

yOu will leARn
  How to run a light 
check of your Mac’s 

hardware and follow up 
any errors detected.

yOu’ll need
  MacCheck.

Disk Utility.  
Other tools mentioned 

throughout to test 
more extensively.

whenever an app quits 
unexpectedly, or your Mac 
restarts after freezing, you 
would probably like to run 

a quick check to reassure yourself that 
there’s nothing more serious wrong with it. 
You could restart and run Apple Diagnostics, 
or start up OS X Recovery to run Disk Utility’s 
First Aid feature, but by then it’ll be lunchtime 
and you’ll have got nothing else done.

These are ideal situations to run a quick 
and lightweight check, so that you can get 
back on with what you were doing with the 
minimum of fuss. To this end, it’s time for 
MacCheck from micromat.com – when you 
first open this app, it’ll ask you to register for 
a free serial number; there’s no price attached.

MacCheck is much like a health screening 
for your computer. It performs a quick run 
through the most important indicators of 
significant problems with a Mac’s hardware. 
It checks the results of the last power-on 
self-test (POST), memory, and several kinds 
of storage error, as well as the battery on 
portable Macs.

If you get a set of green lights at the end of 
the tests, you can be happy that, whatever it 
was that happened, your Mac remains in fine 

fettle. If any test returns a red light, you need 
a strategy and the tools to follow it up.

Most errors found during the power-on 
self-test are likely to be with memory, and 
should have attracted your attention at that 
time as you would have experienced problems 
during your most recent startup. Battery 
problems tend to be straightforward, and are 
typically fixed by replacing the failing battery.

Deal with the prognosis
MacCheck only tests internal drives, so it won’t 
recognise an external RAID drive even if it was 
set up using OS X’s software-based RAID tech. 
Drives with a hardware-based RAID controller 
normally have their own maintenance tools to 
check and report their status. Use Disk Utility 
to check software-based RAID drives.

If you suspect a hardware fault, Apple 
Diagnostics (apple.co/294GZtH) is the ultimate 
check. Power on your Mac and hold d until it 
appears. (If you have trouble with this, use the 
Recovery system to remove any firmware 
password you’ve set, or try a wired keyboard 
and mouse.) You may get a choice of regular 
or extended checks; in the first instance, pick 
the former. Note any error code to quote to 
AppleCare or a Genius Bar. Howard Oakley

How to Test your computer with MacCheck > 

1 Start the tests
MacCheck inspects your computer 

and works out what tests it can perform. 
There are no options to choose from, and 
the app always runs all the tests that it 
can on the hardware you’re asking it to 
check. Simply click the Start button.

2 See the result
As the app works through its tests, 

each one’s icon changes from amber to 
green or red, showing whether your Mac 
passed or failed that item. The Volume 
Structures test invariably takes longest, 
according to the drive’s capacity.

3 Browse MacCheck’s log
If you get any red lights, click on the 

Log button at the top right to inspect 
MacCheck’s testing log. This should give 
you a good idea as to what to do next, 
so you can further diagnose and fix any 
problems the app detected.



Diagnose hardware issues APPLE SKILLS

 macformat.com  @macformat SEPTEMBER 2016 | MACFORMAT | 61

How to Investigate memory faults >

How to Investigate disk errors >

1 Check installed memory
Memory errors can cause MacCheck’s 

power-on self-test or memory test to fail. 
If either comes up red, choose  > About 
This Mac and then click the Memory tab 
to check what memory is installed and 
successfully detected by your Mac.

2 Scan your memory
MacCheck runs one test on a sample 

of memory, typically around 1–2GB out of 
8GB. Paid-for apps like TechTool Pro 
(about £74, micromat.com) can test more 
intensively, and help pinpoint the fault so 
you can replace any faulty modules.

3 Run a specialist checker
Specialised memory testing tools 

like ATOMIC (about £45, micromat.com) 
can be used to test even more memory, 
and can run tests for half an hour or 
more as a stress test. This can help bring 
troublesome intermittent faults to light.

1 Run SMART diagnostics
Some SMART diagnostic indicators 

are better predictors of disk failure than 
others. Use a specialist tool such as 
DriveDx (about £19, binaryfruit.com) to 
investigate a SMART error, and its tips 
will advise appropriate action.

2 Disk Utility’s First Aid
Input/output and disk errors are 

best repaired using Disk Utility, preferably 
from the Recovery system (hold ç+r 
at the startup sound). Select the drive 
rather than volume on it, so it can check 
and repair low-level disk structures too.

3 Try specialist repair
If Disk Utility can’t fix your drive, 

use a specialist tool such as Drive Genius 
(about £74, prosofteng.com). If damage 
is substantial, try to make at least one 
backup, then initialise the disk using Disk 
Utility. If old, consider replacing the drive.

Beyond MacCheck

Two things MacCheck doesn’t test, for speed and simplicity, are external drives 
and graphics cards. Checking and repairing external hard drives is best done 
using Disk Utility. Macs don’t normally monitor the SMART status of USB drives, 
but should over Thunderbolt. Graphics processors are tougher; TechTool Pro 
tests their memory, but Apple Diagnostics can miss serious faults. After storage, 
they are among the components most likely to fail. If you still suspect you have 
a problem, a Genius Bar or Authorised Service Provider is your best bet for help.

Some things take longer to test  



With AnyFont, 
you can use a 
clever system 

to add fonts 
from your Mac 
to iOS devices

1Create a document
We created this presentation slide in 

Keynote for Mac, using two third-party fonts: 
Laffayette Comic Pro (orange) and Tekton Pro 
in bold (white). As you’d expect, there are no 
problems displaying them on the Mac.

2 Open it on your iPad
We saved the document in iCloud. When 

opened on an iPad, Keynote warns that the 
fonts are missing. If we tap Open at this point, 
the slide looks very different – everything’s 
turned to Helvetica, which is a little boring.

Genius Tip!
 If you’re unsure which 

fonts are already on 
your various devices, 
use Font Book on the 
Mac and compare its 

contents with the 
‘Already installed fonts’ 
tab in AnyFont on your 

iOS device. Bear in mind 
that fonts you’ve 

installed yourself will 
also appear in this list.

 macformat.com  @macformat
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Install new fonts on iOS
Use AnyFont to increase your creative options in iPad or iPhone apps

IT wILL TAKE
 10 minutes

yOu wILL LEARn
 How to add fonts 

from your Mac to iOS. 

yOu’LL nEEd
  AnyFont.

iTunes.
Compatible fonts.
 A device running  

iOS 8 or later.

In the early days of computing, 
you were limited to a tiny 
selection of ugly fonts, but 
today’s computers typically 

come with plenty of much nicer typefaces. 
The only problem is that what you get on one 
system may not match what’s on another. 
For example, even if you’ve never added to 
your Mac’s font collection, it’s going to be a 
whole lot bigger than your iPad’s.

This would be fine if people still used a 
single device to do everything; but with the 
magic of the cloud, you’re now just as likely 
to be sending presentations and other kinds 
of document between a Mac and an iPad. 
If you’re very fortunate, the app you’re using 
on your iPad might take fonts included with 
OS X along for the ride, enabling you to keep 
using them in its iOS version.

Sans typeface
Often, though, you’ll find that when an iPad 
app can’t recognise a font, it’ll switch it for 
something different. With AnyFont (£1.49, 
App Store), you can use a clever system to 
install fonts from your Mac (or Windows PC – 
we assume Mac use in the walkthrough, but 
you can also access fonts on Windows systems 

from Control Panel). Alternatively, you can 
also grab new free fonts from the web, to 
install on both your computer and iPad – 
Google Fonts (google.com/fonts) is a good 
place to start. You can add fonts you like to a 
collection, then download them in a Zip file.

Every font you install through AnyFont 
requires a separate profile to be created, so 
you’re probably not going to want to cram 
hundreds of new fonts onto your iPad. For a 
few key additions, though, AnyFont works just 
great. Our walkthrough shows the process 
when using iTunes; check out the Genius Tip 
on the opposite page for an alternative install 
method using Dropbox. Craig Grannell

 How to Add fonts using AnyFont 

Now you can get more creative with docs created on iOS.



CoNtINUED… Add fonts using AnyFont 

3Prepare to copy
On your desktop, create a folder for fonts 

you want on your iPad. The quickest way to 
find specific fonts is Spotlight: type a name, 
select the font, then press ç+® to view it 
in Finder. Hold å and drag it to your folder.

4Connect to iTunes
Connect your iPad to iTunes. Select Apps 

in the sidebar and scroll down the main pane 
until you see the File Sharing area, then select 
AnyFont. Drag the font files you assembled 
into the AnyFont Documents box. Click Sync.

5Preview a font
Back in AnyFont, tap ‘Install own fonts’. 

You should see the list of fonts you just synced 
using iTunes. Tap one and then Preview to  
verify it’s the correct one. Tap Close to shut 
the preview and continue with installing.

6 Install the font
Tap the big font file icon and Safari will 

open. You’ll then be sent to Settings and asked 
to install a profile for your font. Tap install, type 
your passcode, and tap Next and Install (twice) 
to consent and confirm the font installation.

7 Force apps to close
You may need to force iOS apps to close 

for them to recognise the newly installed fonts: 
double-click the Home button and swipe the 
app upwards to do this. Here, our Keynote 
presentation now shows the two fonts.

8Keep things tidy
Your installed fonts should now be 

available to any app. However, if you later find 
you’re not using some, you can remove them 
in Settings > General > Profiles – just tap one 
followed by Delete Profile to get rid of it.

Genius Tip!
 To send a few fonts 

to your iOS device 
rather than lots of them, 
use Dropbox instead 
of iTunes. Open the 
relevant file in Dropbox, 
tap the Share button, 
then tap ‘Open in’, and 
finally choose Copy to 
AnyFont. The font will 
end up in the screen 
mentioned in step 5.

Jargon Buster
 Much as images have 

different file formats, 
such as GIF, JPEG and 
PNG, so too do fonts. 
AnyFont supports the 
following common 
formats: TrueType 
(TTF), OpenType  
(OTF), and TrueType 
Collection (TTC).

Add fonts to iOS APPLE SKILLS
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If you’re a music fan, you’ve 
probably amassed all kinds of 
music on various formats over 
the years – vinyl records, CDs, 

MiniDiscs, and cassette tapes being the 
most popular. While much of your music has 
probably ended up on services like Apple 
Music or Spotify and can easily be bought on 
or streamed to your Apple devices, there are 
bound to be some tracks that have never 
appeared on any download store – maybe 
because your tastes are a little obscure, the 
label or artist hasn’t reissued them digitally, 
or you have some stuff you want to keep 
listening to for sentimental reasons – 
treasured mix tapes, recordings of your kids, 
and so on. Perhaps you’re just enjoying the 
vogue for all things retro and have been busily 
refreshing your old vinyl collection, but your 
purchases didn’t come with download codes 
for digital versions. What are you going to do?

Format flustering
If you’re a vinyl junkie, you have a couple 
of options. One is to buy a USB-equipped 
turntable, such as the Pro-Ject Debut Carbon 

USB, £399, amzn.to/29mmtlZ, which you can 
plug in to a USB port on your Mac and record 
from it using software such as Amadeus Pro or 
GarageBand. Or, you can team up your Mac 
with your existing hi-fi and do it that way.

If you’re thinking of converting old cassette 
tapes or MiniDiscs, your options are a little 
more limited. Older Macs included built-in 
analogue and digital audio inputs as standard, 
but the most recent models don’t. That means 
you’ll need to add some third-party hardware 
to get your old media into your modern Mac.

The most affordable option for most users 
is the Griffin iMic (£35, amzn.to/29llT7u), 
which includes 3.5mm microphone and line-in 
analogue audio inputs so you can record 
whatever you like. You’ll also need suitable 
cables to carry the sound signals from your 
source into the iMic. If you’re planning to 
record straight from your existing hi-fi, you’ll 
need a stereo RCA phono to 3.5mm jack cable 
(available online for around £3 to £10), though 
the more money you spend the better the 
audio quality will be. Your local hi-fi shop will 
be able to advise you on the best options that 
fall within your budget.

Rescue your old audio media
Give your old records and tapes a new lease of life on your Apple devices

It wILL tAKE
 At least 1 hour

you wILL LEArn
 How to digitise your 

old audio media, 
split up its tracks, and 
get them into iTunes.

you’LL nEED
 Amadeus Pro, 

GarageBand or 
a similar app.

Some audio capture 
hardware to suit your 

hi-fi or turntable setup.

Recent Macs 
lack analogue 
audio inputs, 

so you’ll need 
extra hardware
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If you’re recording from a turntable that 
doesn’t have USB, your best bet is to connect 
your Mac to a hi-fi amp with a built-in phono 
preamp (which boosts the audio output from 
your turntable so you can hear it through your 
speakers and your Mac), or use an external 
phono preamp such as the Pro-Ject Phono 
Box MM (£49, amzn.to/29lo9vu). You won’t 
need a preamp if you’re recording from other 
old formats, such as cassette tapes, as your 
existing hi-fi amp will be able to handle them 
without additional amplification.

Get connected
The next step is to connect your hi-fi to your 
Mac. You’ll find instructions on how to do this 
in your hi-fi amplifier’s manual. In essence, 
you’ll need to connect the left and right RCA 
phono ends of the RCA phono to 3.5mm jack 
cable to a suitable RCA analogue audio output 
on your amplifier, and then plug the 3.5mm 
jack in to the line-in audio input of the Griffin 
iMic and make sure that device’s Mic/Line 
switch is set to the Line position.

Before you get gung-ho with an audio 
recording app on your Mac, it pays to make 
sure the sound coming into your computer is 
as ‘clean’ as possible. If you’re recording vinyl, 
make sure your turntable is properly set up 
(its manual will explain how), its needle is free 
from fluff, and the record itself is free from 
dust and fingerprints by using a suitable 

anti-static brush or cloth and cleaning 
solution. For cassette tapes, ensure your 
deck’s playhead and tape pinch rollers are free 
of gunk using a cassette cleaning kit. The end 
result will be worth it.

Make sure the Griffin iMic is connected to 
a spare USB input on your Mac, then go to  > 
System Preferences > Sound > Input and select 
Griffin USB Audio Interface. This ensures your 
Mac is ready and listening to sounds coming 
from your hi-fi source. Now open GarageBand, 
Amadeus Pro or whatever audio recording 
software you’re using.

The next step, if you’re recording from 
analogue sources such as cassette tape or 
vinyl, is to get your recording levels right. Most 
recording software measures these levels on a 
scale from -60dB (decibels) to 0dB. Ideally you 
want most of what you’re recording to be in 

Genius Tip!
 When recording, 

choose the highest 
quality you can. Aim 
for at least CD quality 
(16-bit, 44.1kHz), then 
save the result as a 
high-quality AIFF file.

Jargon Buster
 Decibel (dB) is a unit 

of measurement that 
identifies the intensity 
of sound. In Amadeus 
Pro, audio levels are 
measured on a scale 
of -60db to 0dB.

The Griffin iMic is one of the easiest and most affordable 
solutions for getting old analogue audio into your Mac.

Amadeus Pro enables you to tag individual tracks in a long recording by choosing Sound > Sound Info > Metadata. The Artwork tab enables you to add album art, too.
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the mid range (around -30dB to -20dB), with 
loud passages peaking at -10dB to -3dB and 
only very occasionally hitting 0dB. If the 
recording regularly hits 0dB, you’ll experience 
‘clipping’ – a form of audio distortion that you 
definitely want to avoid if you’re to capture 
your recordings at the best quality.

Perfect peaks 
The best way to avoid clipping is to find out 
which part of the source sounds the loudest, 
play it, and then monitor it using your audio 
recording software. The software you’re using 
should show the majority of sounds you’re 
recording occur around -30dB to -20dB (often 
represented by green indicators), sometimes 
tip over into -10dB to -3dB territory (yellow) 
and very occasionally hit -3dB to 0dB (red). 
If the sounds you’re recording are too quiet or 
too loud, you can usually manually adjust your 
recording software’s gain (or volume input 
controls) to make them louder or quieter. Your 
best bet when recording is to err on the side of 
caution. You can always adjust loudness later, 
once the initial recording phase is complete.

Another thing to consider is the quality 
level you want in the finished recordings of 
your old media. Most audio recording software 
provides a range of options from super-high-
quality to CD quality, down to MP3 or AAC. 
The level to choose depends on what you’ll  
listen to the music on, and how much space on 
your Mac you want it to take up. Amadeus Pro, 
for example, lets you choose anything from 
128kHz/32-bit recording (highest quality) to 
6kHz/8-bit (lowest quality), with many options 
in between. The higher the quality you choose, 
the larger the resulting audio file will be, but 
with storage being so affordable these days 
your best bet would be to pick the highest 
quality available and save that as a ‘master’ 
recording, which you can then convert for 
listening on your iPhone or elsewhere.

Once you’ve picked a quality and adjusted 
levels, press your software’s Record button, 
cue up your turntable or cassette deck, then 
sit back and let your old-school music do its 
thing. You can find out how to edit your music 
and get it ready for importing into iTunes in 
the walkthrough opposite. rob Mead-Green

Genius Tip!
 Amadeus Pro (£44.99, 

hairersoft.com) is a 
well-established audio 

recording app that’s 
ideal for digitising your 
old records and tapes.

Jargon Buster
 Apple Lossless is an 

audio codec that retains 
the audio quality of 

the original recording, 
but creates files that 
are only half the size 

of CD-quality AIFF files.

3

4

1

2
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expLAineD… Editing a recording in Amadeus Pro 
3

Audio channel tracks
 Below the overview are 

separate tracks that show 
waveforms of the audio’s left 
and right stereo channels.

2

Whole sound overview
 The top waveform shows 

the current recording. The 
highlighted area indicates the 
part that’s zoomed in below.

4

Audio quality
 The bottom-left corner 

shows the sampling rate and 
depth of your recording. 
Click here to change it.

1

Playback and recording
 The toolbar in Amadeus Pro 

offers various controls, such 
as buttons for playback and 
recording functions.



Preserve old audio media APPLE SKILLS

 How to Record analogue media 

1Choose your source
In order to start digitising your analogue 

media, connect your Griffin iMic to your Mac, 
then head to System Preferences > Sound > 
Input and choose the iMic as your audio source. 
There is no need to adjust the input level at this 
stage of the process.

3Start recording
Once you’re happy with the input level, 

cue up your source from its start again, click 
Stop in the pane and clear what was recorded 
(ç+A, then ∫), then click Record again and 
start playback; you can monitor progress by 
putting a check mark next to Playthrough.

5Edit and split
To identify each track, scrub through the 

audio file using your mouse or trackpad to find 
the beginning and ending of each one. When 
you’ve identified a track’s boundaries, select it 
by clicking and dragging through the timeline, 
then Choose Edit > Copy To New File.

2Set your levels
In Amadeus Pro, press the Record button 

in the toolbar. Start playing the audio you want 
to record, then adjust the gain (input level) 
using the sliders in the top half of the recording 
pane. Make sure the loudest sounds only very 
occasionally reach 0db to avoid distortion.

4Stop and save
If you’re recording a whole album, note 

that Amadeus Pro will record it as a single 
audio file, which you’ll then need to split into 
individual tracks. For now, choose File > Save 
to preserve the whole album in a single file. 
We recommend AIFF for the highest quality.

6Export to iTunes
In the new file’s window, choose Sound > 

Show Sound Info, click Metadata and then add 
the file’s Title, Album, Artist, and so on. Next, 
choose File > Export to iTunes Library to add 
this track to Apple’s jukebox app. Repeat this 
process for each of the album’s tracks.

Genius Tip!
 Amadeus Pro includes 

a tool to help repair 
digitised recordings 
by banishing clicks, 
pops and other nasties. 
To use this tool, choose 
Window > Repair Centre.

Jargon Buster
 normalisation is a way 

to adjust the volume of 
a recording so its peak 
loudness level reaches 
a set limit. It can be a 
good way to make quiet 
recordings louder.
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Q
I erroneously opened 
an email that appeared 
to be from a friend. In it 

was a link to a site promoting a 
weight loss product. A little later, 
I inadvertently ran an app called 
Bitdefender that had appeared on 
my Mac. Is my Mac now infected?
by E a r l  H i l l

A
Bitdefender is intended 
to clear out iffy software, 
rather than being malware 

itself, but it’s controversial and 
intended to get you to pay money. 
I strongly recommend you remove 
it, and avoid doing anything that 
could bring you to install other 
unwanted apps on your Mac: 
the next one could be malicious.

Mercifully, Bitdefender has its 
own removal tool, which you should 
use as soon as you can. If you are 
looking for tools that are completely free yet invaluable to 
detect and prevent malware, visit objective-see.com, as the 
tools there are written by one of the leading experts in Mac 
security. Check your iMac with those and you can be confident 
that they’ll detect any malware you may have acquired.

It’s absolutely vital that you don’t click on links in messages 
unless you’re certain that they are genuine and trustworthy. 
If you have the slightest doubt, don’t follow them: move on to 
the next message and, when you have a bit more time, return 
and check out the previous message in more detail. Your Mac 
is only one click away from disaster.
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Mac OS X 
Shine a spotlight on sagacious solutions 
to your most maddening Mac maladies

GeNIUS tIPS OS X
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subtly like this can work second time around. 
Ensure that OS X is up to date before starting 
the restore process again, as that should run 
a lower risk of bugs.

If you can’t get this to work properly, try a 
manual restore. This used to be easy, and was 
just a matter of copying the Mail folder across 
from your backup, but it has become more 
complex of late, as Mail now requires more to 
be in place before it will recognise your 
existing mailboxes properly.

Try manually copying across the following 
folders from Library in your Home folder in 
the last backup: Mail, Accounts, Containers/
com.apple.mail, Containers/com.apple.intern 
etaccounts, and Mail Downloads.

If you have another backup besides the 
Time Machine one you’ve been using, such as 
a clone of the disk made using Carbon Copy 
Cloner, that might be worth trying too.

If my Mac freezes, 
is it okay to turn 

the power off?
> Give it a minute or two 

in the hope that it will 
restart automatically. 

If that doesn’t happen, 
hold down the power 
button until the Mac 

shuts down. You should 
only ever shut it down 

by turning off the mains 
power supply in a dire 
emergency, as that’s 

likely to cause problems.

What keyboard 
shortcut moves 

to the end of line?
> Press ç+‘ to move 

the insertion point to 
the end of the current 
row or line, or ç+“ 

to move it to the start. 
You’ll find many more 

shortcuts that help you 
work with text under 
Document Shortcuts 
at apple.co/29swVss, 

and apple.co/29gu5do 
for Apple’s Numbers.

Mac OS X  
quick-fire 

questions 

Q
I upgraded my iMac (late 2011) by 
adding a 250GB SSD and combining 
that with its internal 1TB hard disk 

to make a Fusion Drive, using the instructions 
in MF296. When I set this up, the hard disk 
was wiped clean, and I restored from my 
Time Machine backup. All looked good apart 
from my Mail folder, the contents of which 
appear in a folder named Recovered Folders, 
and stop in about 2012, with nothing more 
recent. Where can I find and restore my 
missing email messages?
by r o y  l u n d

A
It’s most likely that something went 
wrong with your restore from the 
Time Machine backup: either that 

didn’t work properly, or the backup itself has 
become broken. It’s worth trying this again, 
as sometimes a restore operation that’s failed 

External drive 
in trouble

To access Time Machine backups 
of your user account’s Library 
folder, choose Go > Library in 

Finder, then open Time Machine.

The Keyboard pane doesn’t 
list every kind of shortcut.

 macformat.com  @macformat
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Stay current on a broadband budget
Mac App Store apps can be copied from 

one Mac to another, but you may be asked for 
your Apple ID to reauthorise the second one. 
See apple.co/29b5KzD if you have trouble.

OS X Server can cache updates for OS X, 
apps, personal iCloud data, and other store 
downloads when one Mac requests it, and 
distribute it to others as needed, but this 
imposes its own overhead.

weird in Disk Utility
> El Capitan’s Disk Utility 
lacks RAID management 
features, but still shows 
such drives, albeit in the 
disjointed fashion you’re 
seeing. Management is 
done in Terminal: enter 
diskutil appleRAID. 
Thankfully, macOS 
Sierra will reintroduce 
graphical tools for this.

Where’s Keychain 
First Aid in 10.11?
> Up to OS X 10.11.1, this 
was found in Keychain 
Access’s application 
menu. 10.11.2’s security 
notes list two keychain 
changes: some legacy 
functionality is gone, 
and checking of access 
control lists (ACLs) is 
improved so malicious 
apps can’t use keychain 
items. ACLs used to be 
fixed by Disk Utility’s 
Repair Permissions 
feature, which is a 
background task in 10.11. 
So, Keychain First Aid is 
not needed as of 10.11.2.

Q
What’s the most efficient way to 
obtain software updates for my 
iMac and MacBook without 

exceeding my broadband cap?
by C o l i n  H E a t o n

A  
The largest updates you’re likely to 
need are to OS X itself. Rather than 
downloading them from the Mac App 

Store, check Apple’s support pages (support.
apple.com) a day or so after release. Search 
for something like “OS X 10.11.5”, and get the 
smaller, incremental update (which updates 
only from the version immediately before its 
target), not the much larger Combo version. 
These are delivered as disk images, which you 
can copy to and reuse on additional Macs.

OS X Server’s Caching service can make Mac App Store 
updates available locally to save your internet bandwidth.

OS X updates are also 
delivered as disk images, 
which you can copy to 
and reuse on other Macs

Without Server available, you can get system updates as 
disk images from Apple’s website to use on all your Macs.

My RAID drive looks

1Clear out old panes
After an OS X update, System Prefs 

may not display its window of icons. 
Check there are no old or unwanted 
panes in /Library/PreferencePanes, and 
in the same place in your Home folder (in 
Finder, hold å and choose Go > Library).

2A free check-up tool
Another good way to discover old 

software components is EtreCheck (free, 
etrecheck.com). This should alert you to 
the presence of old panes, extensions, 
and other stuff hanging around on your 
Mac that could be causing the problem.

3 Fix improper installation
If there are still no clues, and your 

Mac is suffering other strange problems, 
the update may not have taken properly. 
Fix this by getting the relevant Combo 
updater from support.apple.com and 
applying it on top of your current system.

 HoW To Fix shy System preferences 



Mac Software 
Ease your app-fuelled anxieties and get your 
productivity back on track with this advice

No more book printing from Aperture

Software 
quick-fire 

questions 
Why does Safari 
keep freezing on 

random websites?
> This is most probably 
because of an old and 
broken plug-in. Check 
the Internet Plug-Ins 

folders in /Library and 
~/Library to root out 
old ones. A frequent 

offender is an old 
Google Earth plug-in, 

for example. Bring  
Java and Adobe Flash 
Player up to date too,  

if they’re installed.

Can I verify that an 
HTTPS connection 
is actually secure?

> Yes. To check this, 
connect to the website 
in question. Once it has 
loaded, you should see 

a padlock icon to the left 
of its address. If there 

isn’t one there, the site 
isn’t secure. Click the 
padlock to check the 

site’s security certificate 
for final confirmation.

work from that file format. As the Buy button 
provided the option to generate a PDF of your 
book, complete with dust jacket, that’s no 
longer available, but you can still ‘print’ a PDF 
and provide a separate file for the dust jacket.

One specialist US print firm that’s used to 
working with Aperture books is prestophoto.
com, which ships to the UK. You should find 
alternative European services that also do it.

You could export PDFs of individual pages, 
import those into Photos, then add them to a 
book. PDF is preferable to JPEG, as it’s more 
likely to retain your images’ original quality.

Aperture libraries can 
be imported into photos, 
and should transfer your 
book in the process

GeNIUS tIPS Mac Software

Q
I spent the last two months laying 
out an Aperture photo book of my 
trip to the Antarctic. When I started, 

Apple hadn’t warned it would discontinue 
printing of Aperture photo books. Now my 
book is complete, clicking the Buy button 
doesn’t work, and directs me to Photos. 
I can’t face laying out all 96 pages again. 
How can I still use my Aperture photo book?
by M a r t i n a  W a t s o n

A
Although it’ll take a bit more work, 
you should be able to avoid starting 
from scratch. The first thing to try is 

importing your Aperture library into Photos, 
to see what changes result. Your whole library, 
including book projects, should be migrated. 
If the result looks good, or can be tweaked 
easily, that could save you any further effort.

If you’re going to have to work from the 
Aperture book, the best option is to turn it into 
a PDF and use another print service that can 

Apple no longer offers any printing services from Aperture or iPhoto. You either have to use Photos or a third-party service.

Safari’s summary includes 
lots of info, including whether 
a site’s certificate is valid.
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Q
I normally check my mail first on my 
iPhone, where I haven’t experienced 
problems viewing PDF attachments. 

However, when I read the same messages on 
my MacBook Pro, I often get errors that its 
PDF attachments are missing, or may be 
damaged and unreadable. What’s causing 
this, and how can I fix it?
by n i C k  C o o k

A
This might result from the settings 
in the copy of Mail on your MacBook 
Pro. Open its preferences, select the 

Accounts tab, and then for each of your 
accounts go to the Advanced tab and try the 
following: Ensure there’s a check mark next 
to ‘Automatically download all attachments’. 
Next, go to the Viewing tab, and ensure ‘Load 
remote content in messages’ is also checked. 
These should guarantee all PDF attachments 
are properly downloaded to your Mac.

Mac Software GeNIUS tIPS

If the issue persists despite those settings 
being correct, next try to rebuild any affected 
mailbox(es) affected. Select one on the left 
and choose Mailbox > Rebuild, then repeat for 
additional problematic mailboxes.

If you still can’t reliably access PDFs sent 
to you, the best workaround is to try saving 
them and then opening the saved files. A few 
people seem to suffer from this as a more 
persistent problem, though the majority don’t.

Mail has two preferences that can affect the display of 
PDFs, whether attached or embedded from a web server.

itunes 12.4 playlist  
layouts have changed

broken pdF 
attachments
in Apple Mail

2016 | MacforMat | 73

iTunes remembers view options for each playlist, so you’ll 
need to invest time in setting them all up the way you want.

Where can I find 
the images stored 
in Photos?
> Photos’ .photoslibrary 
‘files’ can be stored 
anywhere on your Mac, 
but you’ll typically find 
them in ~/Pictures. 
Don’t tamper with a 
library or its contents 
outside of the app itself 
or you could lose the 
whole thing.

How can I open 
my drawings from 
AppleWorks 6?
> EazyDraw (bit.ly/
eazydraw) can do this. 
It’s $20 (about £15) for 
a nine-month licence. 
LibreOffice (libreoffice.
org) is a free alternative 
that’ll also do the job. 
 
 
 
 
 
 
 
 
 
 

What alternatives 
to Spotlight also 
search mail?
> There are several 
alternatives that use 
Spotlight data but which 
you may find perform 
better for searching 
your email message, 
such as EasyFind (free, 
devontechnologies.com) 
and Tembo ($15 – about 
£11, houdah.com).

You can use EazyDraw to get 
your old AppleWorks drawings 
into a modern format.

Tembo displays search filters 
in a plain fashion on the right.

 macformat.com  @macformat

Q
I‘ve been trying to follow an article 
on TechRadar about changing the 
playlist view in iTunes, but I’m 

having problems, as what is shown there 
doesn’t correspond to what I see in iTunes 
version 12.4.1. In particular, I want each of my 
playlists to show in the same ‘classic’ format. 
What am I doing wrong?
by J E r E M y  k E a t i n g

A
This is because iTunes 12.4, released 
after that article was published, has 
altered everything again. The first 

change is that you now must switch between 
different layouts by choosing an option in 
View > View As, instead of using the control 
that used to be near the top-right corner of 
the window. This has caught out many people, 
and brought us a torrent of questions.

The snag with the various options for the 
available layouts is that they’re set individually 

for each playlist. To access these 
options, select a playlist in the 
sidebar, then choose View > 
Show View Options.

These options should let you get 
your playlists looking the way you prefer, but 
you’ll have to work through every playlist 
individually. There’s no way to set a default, 
or apply settings to several playlists at once.
Though it’s tedious doing this for many 
playlists, once it’s done you shouldn’t have 
to do it again, and it does give the flexibility 
to have some playlists look different.



iOS Software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS software 
quick-fire 

questions 
Why do our iPhone 

5s and iPhone 6 
differ in mileage?

> Distance walked or run 
in Health’s Dashboard 

is calculated from 
periodic location fixes 
using built-in Assisted 

GPS, while your number 
of steps is measured by 
the accelerometer. Both 
are approximations and 

will vary considerably. 
Later iPhones are often 

more accurate, and 
adding a Watch makes 
measurements better 

than a phone alone.

iMessage is using 
my new, temporary 

phone number
> When you’ve switched 
networks but kept your 

old number, this can 
leave some settings 
wrong. In Settings > 

Phone, edit the number 
at the top. Also check 

it’s correct in your 
card in Contacts.

GeNIUS tIPS iOS Software

Q
Although I’ve been using iPhones 
for years, I’ve never actually used 
iMessage. How can I add my number 

to activate it, and to use FaceTime?
by M a r g a r E t  C H a n

A
Chances are your iPhone is already 
set up and ready for both of these 
features. First check the date and 

time on your phone are correct, then go to 
Settings > General > Software Update to check 
your phone has the latest version of iOS – if it 
doesn’t, back up your device, then download 
and install the latest update.

You’ll probably find it easiest to set up 
Messages and FaceTime when you’re using 
a good, fast Wi-Fi network. Go to Settings > 
Messages and ensure iMessage is turned on 
at the top of the page. Tap Send & Receive, 
and check you’re signed in with your Apple ID. 

You should be reachable by iMessage at your 
phone’s number, and you can make yourself 
reachable on any email address associated 
with your Apple ID. Below, you can choose 
which one of those details is used to identify 
you when you start a new conversation.

If your phone number doesn’t appear, sign 
out on all your iOS devices, then tap ‘Use your 
Apple ID for Messages’ on this iPhone alone, 

Getting started 
with iMessages 
and Facetime

and sign in. Once done, you can sign in again 
on your other devices. Now try sending a 
message to a friend who uses iMessage: in the 
app, create a new conversation, add a contact 
detail your friend uses with iMessage, type 
your message, then tap Send. Apple explains 
how to resolve problems at apple.co/29cc9wg.

FaceTime is set up similarly, in Settings > 
FaceTime. In the app, type a name or contact 
detail in the box, or tap + to browse contacts.

you can make yourself 
reachable on any email 
address that’s associated 
with your Apple id

Configuring iMessage or FaceTime is straightforwardly 
done in their respective pages at the top level of Settings.

Check your iPhone has your 
correct number in Settings.
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y niece Darcy is almost five. Like most 
children under 10 she likes Minecraft, 
but she doesn’t get a lot of time on 

the family Xbox because her two brothers put 
in six or seven hours each day to keep their 
Darks Souls 3 skills sharp. She’s too young to 
have her own console, and isn’t allowed on the 
family PC without supervision, because… you 
know, the internet and stuff. But an entire 
Saturday frittered away on video games is 
every child’s birthright, and playing Minecraft 
will certainly set her up for a lucrative future 
career of 3D modelling or tree punching.

As a mildly disreputable uncle, I figure 
it’s well within my remit to take round an old 
MacBook that just happens to have Minecraft 
installed and forget to take it home. Provided 
it’s set up so she can’t get on the web or telnet 
into the CIA’s servers, it should be perfectly 
safe. But first, I need to find a suitable model.

m

A mac for minecraft

The black MacBook was Apple’s 
premium consumer laptop in the 
days before aluminium unibodies.

 LUIS’S APPLE CLASSIC!
The Mac TV was a computer you could use as a television. 

A desktop Mac with a 68030 processor, integrated monitor 
and a TV tuner, it was basically a crippled LC 520. The TV 
picture used 16-bit video but the OS could only display 8-bit 
computer graphics, so you could only watch TV full screen. 
It was the first desktop Mac to come in black, but there really 
wasn’t much else to recommend it. Even in 1993 it was an 
unattractive compromise, and Apple only made 10,000 units.

Inspiring ideas for 
revamping your old  

Apple devices

ReUSe 
OLd KIT
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Hardware 
quick-fire

questions 

How do I create a 
new user account?
> In System Preferences 

> Accounts, click the 
padlock at the bottom 

(if it’s locked) and enter 
an admin password, 

then click the + under 
the list of accounts. 

Choose Administrator 
from the pop-up menu 

at the top if you want 
the account to have full 

access to the Mac, or 
Standard to restrict 
its ability to change 

settings. Fill in the name 
and password details 
in the relevant fields, 

then click Create User.

How much memory 
can be fitted in a 
2006 MacBook?

> Provided all memory 
slots are working (unlike 

mine), you can put 1GB 
modules in each, for a 
total of 2GB. You can 

look up the specs of old 
Macs at support.apple.
com, or in MacTracker 
(free, bit.ly/29H02pa)

Can I play DVDs on 
a 2006 MacBook?

> Yes. Its SuperDrive  
can read DVD-Videos  

(but not Blu-rays)  
using OS X’s built-in 

DVD Player app. 
The aged CPU copes 
quite well even with 

playing HD video files.

minimum 
minecraft 
Can you really play games  
on a 10-year-old macbook?

nitially, I’d hoped to find a second-
hand mid-2010 MacBook, with a 
2.4gHz Core 2 duo processor and 

4gB of memory. That’s still really capable 
and would run Minecraft very comfortably. 
Unfortunately, it also holds its price pretty 
well, and I couldn’t find one for less than £190 
on eBay. So I started making optimistic bids 
on slightly older models. I was soon watching 
a dozen auctions and trying to remember 
when they all ended. Things got away from 
me slightly on Sunday evening, and so it was 
that I ended up with a 2006 MacBook for £58 
including delivery.

This model is a big step down, though, 
being the first of the Intel MacBooks. It has a 
Core Duo processor, not a Core 2 Duo, which is 
32-bit and so unable to run OS X Lion. Worse, 
this one came with a faulty memory slot, so 
it’s stuck at just 1GB. On the plus side, it has 
already been updated to Snow Leopard, and 

the case has just enough scrapes and cracks 
that I can turn it over to a five-year old with a 
clear conscience.

Making it safe
The first step was to partially sanitise the 
desktop. I pulled everything off the Dock, 
except for Finder and Trash (which can’t be 
removed), and changed Finder’s preferences 
so the hard drive’s icon doesn’t show up on 
the desktop. I set new Finder windows to open 
the Desktop folder by default, and then hid the 
sidebar and toolbar for good measure. This 
doesn’t stop me from quickly getting to other 
folders if I need to, but it limits the amount of 
chaos that a child can do by randomly clicking 
and dragging on the desktop.

Next I needed to find an up-to-date web 
browser. The last version of Safari that will run 
on the Core Duo is 5.1.10, which dates back to 
September 2013. That’s three years of 

i

Minecraft looks a little 
worse at low detail and 

resolution, but the 
boost in its frame rate 

makes it more playable.
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vulnerabilities and web technology advances 
that this browser doesn’t know about. If you 
try going to YouTube in Safari 5.1.10, for 
example, you’ll just get an error page. I don’t 
really want Darcy accessing the web on this 
computer, but it’s still important to have an 
up-to-date browser installed, in case I need to 
troubleshoot a problem on it when I’m visiting. 

Chrome won’t run past version 38 (from 
2014), so I ended up installing Firefox 47, 
which is the latest version and still has a 32-bit 
executable. I made a local Applications folder 
for the admin user account and moved Safari 
and Firefox from the main Applications folder 
to it. Darcy’s own account isn’t an admin, so 
she won’t be able to access this folder.

Blocky graphics
Minecraft’s current version is also a 64-bit 
app, so I had to locate the 32-bit version, which 
is tucked away at launcher.mojang.com/
download/Minecraft_legacy.dmg. I installed 
it and put a shortcut to it in the Dock. I could 
have set the Dock to auto-hide itself and put 
a shortcut on the desktop, or even added the 
game to Darcy’s login items to start it 
automatically, but part of my reason for 
finding a cheap MacBook, rather than a cheap 

Minecraft with all the 
detail options turned up, 
ran at an unplayable 4fps.

games console, was to subtly encourage 
computer literacy. Knowing how the Dock 
works and how to start an app is an important 
skill, like learning to tie your shoelaces.

When I fired up Minecraft for the first time, 
the results were underwhelming. In full-screen 
mode at 1280x800 resolution, I was getting 
five frames per second. Not good enough. 
So I opened the game’s video settings and 

changed ‘Graphics’ to ‘fast’ instead of 
‘fancy’. Just doing this roughly doubled 
the frame rate. Encouraged, I went 
through the other options and turned 
off anything that might require the 
CPU to do any thinking at all. Smooth 
lighting and clouds were disabled, 
I set particles to minimal, and 

Knowing how the dock 
works and how to start 
an app is like learning 
to tie your shoelaces

Polycarbonate Macs can 
look in poor condition, but 

scuffs may mean a bargain.
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3Configure its settings
Press œ in the game and choose 

Options > Video Settings > Other from the 
menu. Click ‘Show FPS: ON’, then return 
to the game to measure your Mac’s 
performance; the frame rate is shown at 
the top right. Experiment with the detail 
settings to find a balance between video 
quality and frame rate you’re happy with.

 How to install and work with OptiFine 

Next Issue!
 Luis blows the dust off 

a Mac that dates back 
to the birth of the web!

of the box. I didn’t notice a difference on 
this Mac, but it’s possible the benefits are 
more pronounced on faster models, 
or need more memory to be effective.

Of more interest to me were the extra 
tweakable options that OptiFine adds to 
Minecraft’s settings menu. I was able to 
turn off shadows, fog, clouds, stars and 
the sky texture, and use 2D drawing 

shortcuts for translucent blocks, 
weather and dropped items. Even 
better, I could change the game 

resolution, which is normally fixed at the 
native resolution of the computer. By dropping 
to 800x600 pixels, I bumped the frame rate 
to 22–25fps, which is quite usable. Minecraft’s 
graphics are deliberately blocky anyway, so a 
lower resolution is much less noticeable than 
in other games. In fact, it’s good enough that 
I just wasted over an hour writing this last 
paragraph, while I wandered around my 
island ‘checking the frame rate’!

In the end, I’ve set up a working Minecraft 
computer for under £60 (plus £18 if you don’t 
own Minecraft already) – cheap enough to give 
to my niece without stressing her parents that 
it might get damaged. The standard avuncular 
present for a Minecraft fan is Lego Minecraft. 
But the Lego Minecraft Nether Fortress set is 
about the same price as this laptop, and my 
present will probably better prepare Darcy for 
the world she’ll grow up in.

dropped the rendering distance to ‘lower’. 
This brought the frames per second up to 
12–14 – still not great, but just about playable.

Speed run
Then, after searching for “increase minecraft 
framerate”, I came across optifine.net. I had to 
disable cookie blocking in Safari’s preferences 
just to get this dreadful webpage to load, then 
cancel the pop-up for MacKeeper and close 
the tab that opened without my asking. Then 
I had to spot the inconspicuous text link to 
‘OptiFine_1.10_HD_U_B7.jar’ surrounded by 
ads for other games. But apart from that, 
downloading this optimisation mod was 
straightforward. OptiFine supposedly uses 
more efficient rendering and 3D calculations 
to improve Minecraft’s performance, right out 

1Download OptiFine
At optifine.net, click Downloads in the 

menu at the top of the page. The website 
runs JavaScript that requires you to turn 
off pop-up blocking before it’ll load. So, in 
Firefox’s preferences, click Content and 
clear ‘Block pop-up windows’. Next, click 
Privacy then ‘Remember history’, and 
choose ‘Use custom settings for history’.

Prices of second-hand early 
MacBooks range from double 
digits well into triple figures.

2 Install the mod
OptiFine needs to be installed to the 

same folder as Minecraft, because it 
directly modifies the Minecraft launcher. 
Typically this will be in the Applications 
folder. You can tell it’s installed correctly 
by a new user profile called OptiFine on 
Minecraft’s main launcher menu. You 
need to select this to enable the tweaks.

If you plug an external  
mouse in to older MacBook 
models, it may be mistaken 
for a keyboard, but you can 

happily ignore this.
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 A work computer, games 
console, family planner, 
photo album, and a music 
library… your Mac is an 
integral part of your life. 
To prevent that information 
falling into somebody else’s 
hands, or your Mac being 
compromised by outside 
attack, we’ll walk you through 
various options for tightening 
its security.

 Prevention really is better 
than cure when the ‘cure’ 
for a significant crash could 
be spending days trying to 
reclaim your data. 
Take practical steps to 
monitor your Mac when a 
problem crops up, or even 
ahead of time, and you can 
accurately predict or forestall 
problems before disaster is 
even able to strike.

  Should the worst happen, 
don’t panic – we’ll show you 
how to fix common Mac 
problems without reaching 
for your backups. If you 
need to seek help, we’ll also 
show you how to check for 
obvious hardware faults 
without first lugging your 
Mac to a Genius Bar, and how 
to gather evidence that could 
help resolve your problem.

Nik Rawlinson equips you  
with the knowledge you need to  

keep your data safe and your  
Mac in working order

The Ultimate

Survival Guide
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 You’ve already taken a sensible 
first step on the road to keeping 
your data secure: you’ve chosen a 
Mac. After all, OS X is widely rated as 
one of the most secure mainstream 
operating systems, and Apple’s 
continued focus on encryption and 
privacy is a valid reason to remain 
optimistic. However, don’t be 
complacent about security.

Local security
Start boosting your 
security by setting a 
strong password, and change 
it regularly. When doing this in the 
Users & Groups preferences pane, we 
recommend opting to use your iCloud 
password to log in, so you can 
simultaneously change it on all of 
your Macs to minimise the duration a 
cracked system remains vulnerable.

Set OS X to demand a password 
immediately after waking from sleep 
or the screen saver in the Security 
& Privacy pane’s General tab, and 
minimise the number of apps that 
have access to core data, such as 
your contacts, calendar and photos, 
through the same pane’s Privacy tab.

Network security
Switch to the Firewall tab and make 
sure the firewall is switched on. It will 
run in addition to any firewall on your 

router to control what can – or can’t 
– use your network connection; Unlike 
many firewalls, it enables you to 
manage communications on a 
per-app basis, rather than blocking 
specific ports, which is more brutal in 
its effect but easier to manage. Click 
the Firewall Options button 
and consider unchecking the option 
to automatically allow signed apps to 
receive incoming connections if you 
want to explicitly grant permission.

You can also enable stealth mode 
here so that your Mac ignores any 
attempts to probe it with small packets 
of data that test its presence from 
elsewhere on or beyond your network. 
Such attempts can help hackers to 
identify vulnerabilities and abuse 
them. By not responding, the idea is 
your Mac won’t give anything away.

Finally, start up in OS X Recovery 
(see page 86) and choose Utilities > 
Firmware Password Utility to stop an 
intruder breaking in and even resetting 
account passwords – see apple.co/ 
29LBlOl for full instructions.

HOW TO Go beyond  
the built-in firewall >

1 Install Little Snitch
This app (about £25, obdev.at) tracks 

network traffic going in and out of your 
Mac. When it detects a new connection 
it’ll ask whether to allow or block it.

2Decide what you trust
If you trust the connection, you can 

authorise it forever or until you quit the 
associated app. You can deny those you 
don’t trust on the same basis.

3Tighter control
Pick an alternative duration from the 

pop-up menu, and specify below whether 
to block specific ports and services or 
subdomains on an internet server.

4Manage rules
Over time, the number of alerts will 

reduce as you give instruction to the app. 
Change previous choices by deleting or 
amending entries in its main window.

Mac security

OS X’s built-in firewall makes it easy to manage 
which of your apps can reach the internet.

Set your Mac to demand a password 
immediately after falling asleep or 
running the screen saver.
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FEATURE the ultimate Mac survival guide

1 Keychain contents
Your keychain stores usernames and 

passwords for automatic insertion into 
web forms, authentication windows and 
apps. It’s a great timesaver, but get into 
the habit of revoking access rights.

2 Investigate your data
Open Keychain Access from the 

Utilities folder, select a keychain at the 
top left, then All items under Category. 
Scroll through the entries to find keys 
for apps you no longer use.

3 Excise old information
If you find an item you no longer use, 

such as an old email account’s password 
or a certificate for a site you no longer 
visit, ≈-click it, choose Delete, then enter 
your password to authorise its removal.

Problem prevention
OS X will often alert you to upcoming problems, if you know where to look

 Mac old-timers will often advise that 
you keep 10% of your startup disk free 
for temporary storage. This space is 
used by apps like Photoshop that create 
large files as you work, OS X’s built-in 
housekeeping routines, and so on, to 
cache files when your Mac runs out of 
memory. That figure may be excessive 
now that drive capacities are far larger.

However, if you’re using an older 
computer, or a Mac with a small amount 
of memory, either add more memory or 
free up some storage to improve overall 
performance. Use Activity Monitor to 
check memory usage; if the Memory 
Pressure graph regularly shows orange 
or red, more memory will mean OS X 
doesn’t have to write the contents of 
memory used by idle apps out to disk in 
order to free up that resource for apps 
that need it immediately.

On a Mac with a hard drive (not flash 
storage), keep at least the same amount 
of free storage as your Mac has memory, 
so the latter’s contents can be saved to 

disk if the Mac 
enters Safe Sleep 
when its battery 
runs low or it’s left 
idle for a long time.

Think about 
upgrading to a 
faster hard drive, 
or even an SSD 
if your budget 
allows, for further gains – you’ll find 
visual guides for many Macs at ifixit.com. 

Optimal performance
OS X automatically runs optimisation 
scripts overnight if your Mac’s turned on 
or in sleep mode, but you can force them 
to run manually at any time by opening 
Terminal (in /Applications/Utilities) and 
typing sudo periodic daily weekly 

HOW TO Clean up your keychain to remove old access rights >

monthly (or any combination of the last 
three words), then pressing ®.

Although OS X is generally very good 
at keeping things in order, apps can 
interfere with its settings, causing 
problems. Permissions define who can 
access, execute, write to or delete a 
file on disk, and are used to limit the 
damage that unauthorised users or 
routines can cause. It’s possible for 

If you suspect your 
Mac isn’t able to run its 
maintenance scripts 
automatically, run them 
yourself in Terminal.
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OS X 10.11, System Integrity Protection 
(apple.co/29LWvsP) protects the 
permissions of important system files 
and apps, which are now checked and 
repaired automatically when you install 
system updates.

If your Mac’s running slow, there could 
be any number of reasons. Most can be 
diagnosed using Activity Monitor (again, 
in the Utilities folder). If your Mac is hot or 
its fans are running at high speed, click 
the CPU tab, then the ‘% CPU’ column 
header to sort processes by usage. 
Similarly, use the Disk tab to diagn    ose 
which app is thrashing storage, and 
Memory and Network to check general 
slowness or a slow internet connection.

You can force an unresponsive app 
or a process hogging resources to quit, 
but do this with care: only quit those for 
which your own username appears in the 
User column, and save your work first, 
if possible, to miminise potential data loss.

an app to erroneously lock a file by 
changing its permissions, which could 
cause other apps to crash when they 
can’t access a required resource, such as 
the place where iTunes records play 
counts for tracks.

Up to OS X 10.10, open Disk Utility, 
select your startup disk, click the First 
Aid tab, then Repair Permissions. As of 

On a Mac with a hard drive, keep at least 
the same amount of storage free as you 
have memory so OS X can enter Safe Sleep

the ultimate Mac survival guide FEATURE

In El Capitan, Disk Utility’s First Aid no longer fixes 
permissions, but it does deal with low-level issues.

Annotation Use Activity Monitor to diagnose unresponsive apps >

1

Resource 
management
 Switch between 
various resource 

monitors by 
clicking the tabs 

across the top of 
Activity Monitor.

3

Kill stalled 
processes 
 Click a sluggish 

or unresponsive 
process, then this 
to force it to quit. 
If possible, save 
your work first.

2

Identify any 
resource hogs
 Click a heading 

to sort the list 
on that attribute 

and highlight 
those that are  

resource-hungry.

4

Identify things
 Many items are 

crucial bits of 
OS X. Search 
online for them 
to learn more – 
don’t quit them 
for the sake of it.

 SMART, which stands for 
Self-Monitoring Analysis and 
Reporting Technology, is built in 
to many hard drives and some 
SSDs, allowing them to detect 
potential problems and predict 
their own demise. In Disk Utility, 
select a drive in the sidebar to view 
its SMART status at the bottom of 
the window. This may help you to 
back up and install a new drive 
in time to avoid losing your data. 
Disk Utility can’t check the status 
of most external drives, though. 
See page 60 for more tips about 
how to check a drive’s health.

Check SMART  
status of disks >
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 If your Mac is unresponsive or 
exhibiting problems that can’t be 
resolved using the tips in the previous 
section, use your Mac’s diagnostics 
tools to check for physical problems 
before contacting Apple for support.

First, eject and detach all external 
devices, then shut down your Mac. 
Next, power on your Mac and hold d 
while it starts up until you see either 
Apple Diagnostics or Apple Hardware 
Test. (If you’ve completely erased your 
Mac’s startup disk in the past, you can 
start Apple Diagnostics from the 
internet by holding å+d instead.)

On Macs introduced in June 2013 or 
later, your Mac will run Apple 
Diagnostics. When this tool is finished 
examining your Mac you can either 
return to OS X if no problems are found, 
or restart in OS X Recovery, a hidden 
partition that enables you to repair 
certain problems or reinstall OS X. 

Macs introduced prior to June 2013 
use Apple Hardware Test instead. If this 
utility finds any problems, it gives an 
error code for you to quote to Apple or 

an authorised service 
provider when 
seeking their 

assistance.
If your Mac shipped with 

OS X 10.7 (Lion) or an earlier version, 
you’ll need to use the diagnostics tools 
supplied with it – on Applications Install 
Disc 2 or the MacBook Air Software 
Reinstall Drive. They’re accessed by 
inserting the original optical disc or 
connecting the USB drive to your Mac 
and then following the same steps 
described to the left. 

Repair in OS X Recovery
If you’re running OS X 10.10 or an earlier 
version, tried repairing permissions in 
Disk Utility as described in the previous 
section, and it hasn’t solved your 
problems, repeat the operation after 

Recovery options
                            When quick fixes don’t work, all is not lost…

starting up in OS X Recovery, which you 
can enter at will by holding ç+r at the 
startup sound. This starts your Mac in 
OS X Recovery and, because it won’t 
load any background processes, there’s 
less chance of anything interfering with 
Disk Utility’s ability to fix problems. 
Select Disk Utility from Recovery’s main 
menu and repeat the repair process.

Recovery also lets you reinstall OS X 
from scratch. This will give you the most 
recently installed version of OS X if you 
use the local Recovery partition, or the 
one that shipped with your Mac if you 
use Internet Recovery instead.

OS X Recovery also provides an 
option to restore your Mac’s contents 
from a Time Machine backup (provided 
you haven’t excluded system files from 
your backups). Any of these methods is 

OS X Recovery provides an option to 
restore your Mac’s contents from a Time 
Machine backup if OS X itself won’t start

Your Mac provides a Recovery system in case OS X 
won’t start, where you can perform maintenance, 
reinstall OS X, or restore a Time Machine backup.

 ✓  Keep your backups up to date, 
and don’t rely on just one. 
Pairing a local backup such as 
Time Machine with an online 
service such as Crashplan, 
Backblaze or Carbonite is ideal.

✓  After an app or OS X crashes, 
save details from your Mac’s log 
files and submit them to the 
developer. Even if you don’t 
understand them, they will.

✓  If your Mac crashes on startup, 
restart in safe mode by holding 
ß after you hear the startup 
sound, then disable login items 
for your user account in System 
Preferences > Users & Groups.

Recovery checklist >
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an effective means of solving most 
problems, but will lead to data loss if 
you don’t have a recent backup.

Aid an amnesiac Mac
If you’re suffering from persistent kernel 
panics, in which the screen dims and is 
overlaid by multi-language messages, 
or your Mac is forgetting small but 
important details between sessions, 
such as your preferred volume or 
startup disk, reset your Mac’s NVRAM 
(non-volatile random-access memory), 
which stores key settings.

Power on your Mac and hold down 
ç+å+p+r as soon as you hear the 
startup sound until you hear the sound 
a second time, then release and allow 
startup to complete. (If you’re wondering 
about the key combo, older Macs use 
PRAM, Parameter RAM, for the same 
purpose, which is reset the same way.)

Help the helpers
Should all else fail and you need to seek 
professional assistance, give the helper 
as much info as you can by pulling crash 
reports from OS X’s logs. OS X can send 
crash data to Apple and app developers 
if you allow it in Security & Privacy prefs, 
under Privacy > Diagnostics & Usage. 
You can review what’s been sent by 
opening the Console app (in the Utilities 
folder) and choosing Diagnostic & Usage 
Messages on the left – this is best done 
from an admin user account. 

Apple describes automatic reporting 
in detail at apple.co/29v73tC. If you opt 
out of it, your selection in Console can 
be exported to a file, to send manually, 
by choosing File > Save Selection As.

HOW TO Make an OS X install disk >

2Get the OS X installer
Download El Capitan from the Mac 

App Store but quit the installer when it 
opens, as you don’t want to reinstall the 
operating system. Instead, you’ll use a 
media creation tool hidden inside it to 
turn your USB drive into an install disk.

1 Prepare a USB drive
Connect your drive (12-inch MacBook 

owners need a USB-C adaptor or drive). 
Open Disk Utility, select the drive in the 
sidebar, click Erase, enter a name, select 
OS X Extended (Journaled) as the format 
and GUID as the scheme, then click Erase.

4 Finish the command
Type --volume and a space. Press 

ß+ç+c in a Finder window and drag 
your USB drive onto Terminal. Leave the 
space this time, type --applicationpath 
and a space, drag in the installer, again 
leave the space and add --nointeraction.

3Prepare to copy files
In Terminal, type sudo then a space, 

and drag the installer onto the window to 
add the full path to it to the command 
line. Press ∫ to remove the space after 
it, then add /Contents/Resources/
createinstallmedia, then add a space.

6Try out your install disk
Your disk is now ready to install 

El Capitan on other Macs. Connect it to 
one and reboot that Mac, holding å at 
the startup sound until you’re asked to 
select a startup disk. Choose the disk you 
just prepped and the installer will load.

5Wait a little while
Now press ®. After entering your 

password, Terminal will reach into the 
installer to use the media creation tool 
in it to copy the installation files to your 
USB drive and make it bootable. Leave 
Terminal alone until you see ‘Done’.

Resetting NVRAM can overcome forgotten settings, 
such as screen resolution, startup disk or volume.

the ultimate Mac survival guide FEATURE
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 Awarded to a 
five-star product 
we believe is truly 
exceptional in its 

category. Given solely at the 
discretion of the Editor.

 Given to a 
hardware or 
software product 
that might not be 

the very best in its category, 
but is a noted for affordability.

 Our group test 
winner gets this 
award for being 
the best of its 

kind when pitted against 
other comparable products.

 the MACFORMAT Awards

 manifesto – our ratings explained
 Our reviews are totally 

independent; we’re not 
affiliated with Apple or 
anyone else, nor are we 
influenced by advertisers. 
You can trust us to give 
an honest assessment 
of a product’s worth.

The prices quoted for 
products are correct at 
the time of writing and are 

the best we can find from 
a reputable online dealer, 
excluding delivery. 

HHHHH
 A brilliant thing in all regards, 

and worth every penny

HHHHH
 Strongly recommended; any 

flaws are only minor concerns

HHHHH
 Worth considering, though 

there may be better options

HHHHH
 Fundamentally flawed; look 

at alternatives as a priority

HHHHH
 A waste of your money and 

everyone’s time; do not buy!

SOny RX10 iii 
p90

What’s inside 

90–95  
MAC HARDWARE 
 Travel-friendly on-ear 
headphones, a 256GB 
MacBook Pro storage 

boost, and other kit
 

96–99  
GROuP TEST 

 Six portable Bluetooth 
speakers with sound 

that’ll rock your world!

100–102  
MAC SOFTWARE 
 Apps to enhance your 

landscape photos, build 
a website, and more

103  
iOS SOFTWARE 
 Improve your verbal 
communication and 
mark up digital docs

Contact us

 Email your queries 
and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

 Get the latest 
subscription offers at 

macformat.com

Our authoritative reviews 
help you make more 

informed choices

BuyinG 
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 There’s no denying it: 
that lens is incredible. 

While I find it tempting 
to have such versatility 

in a single lens, the price 
is pretty steep for the 
type of photographer 

Sony is aiming at. 
My heart wants it, but 

my brain says no – 
I hope for my wallet’s 

sake that my head wins.

Alex says…

The zoom range of the 
RX10 III’s Zeiss lens is simply 

incredible – but it’s heavy 
when fully extended.

90 | MACFORMAT | SepteMber 2016  macformat.com  @macformat

Sony rX10 III
Virtually in a league of its own

C
oming almost a year after the 
RX10 II, the big difference in 
the RX100 III is the inclusion 

of a variable aperture (f/2.4–4) mega 
zoom lens, with a reach of 600mm (25x 
optical and 100x digital zoom). With this 
comes a big increase in size and weight. 
The RX10 III has the same 20.1-million-pixel, 
1-inch stacked Exmor CMOS sensor, and the 
same excellent 4K video functionality as the 
RX10 II. The main talking point is the large 
and impressive Zeiss 24–600mm lens; of its 
rivals, only Canon’s G3 X has the same reach.

The variable aperture of f/2.4–4 still 
makes this a fast lens, certainly compared 
to the competition, and it boasts hugely 
impressive minimum focussing distances of 
3cm at the wide end and 72cm at the long end.

A large range of shooting options and 
photo modes are included, with 3:2, 4:3, 16:9 
and 1:1 formats for both raw and JPEG images. 
The max resolution is 5472x3648 in the native 
3:2 format, and sensitivity ranges from ISO 
100–12,800, expandable to ISO 64–25,600.

Single-shot autofocus, continuous, direct 
manual focus and full manual focus are 
available, with Sony’s focus magnification 
and focus peaking options making the latter 
easy to use. The electronic viewfinder (EVF) 
and tilting rear LCD are both high quality.

There’s no getting around the bulk of the 
camera, which weighs a little over a kilo. The 
build is reassuringly solid, and its generous 
protruding-front grip and rounded body style 
mean you’re able to hold the camera securely.

Through the looking glass
The new 24–600mm lens doesn’t disappoint, 
performing extremely well throughout its 
zoom range. Details are perhaps not quite as 
crisp as from the Mk II’s lens, but given this 
lens’s far greater reach that’s not surprising.

The lens is remarkably sharp when wide 
open at most focal lengths. At its wider end 

there’s a degree of softness at the frame’s far 
left side. However, at telephoto focal lengths, 
the image is impressively detailed across the 
frame, right up to 600mm. Diffraction is more 
noticeable (but controlled) by f/11, but by f/16 
there’s a noticeable fall-off in quality.

Out of focus areas are rendered pleasingly, 
although f/2.4 is only available up to 35mm, 
with f/4 the widest aperture available above 
100mm. This means isolating subjects from 
their background can be a challenge, but the 
RX10 III still beats most of its rivals in this 
respect. Distortion and chromatic aberration 
are both well controlled throughout the range; 
we struggled to notice any examples of either.

The lens’s impressive focussing range of 
3cm to 72cm makes it extremely versatile, 
and its JPEG quality is good; even at higher 
sensitivities we were impressed with their 
quality. Using noise reduction at its lowest 
setting is a good compromise between detail 
and noise, with files very clean and detailed 
up to ISO 1600; raw images have more detail, 
but the difference is surprisingly small. 
Even above ISO 1600, JPEG quality is still 
very good, with very manageable noise levels.

reviewed by Lizzie Shepherd

 £1,349  from Sony, sony.co.uk
 featureS 20.1MP one-inch CMOS sensor, 24–600mm lens, 4K video recording
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 A superb lens and 
great features make 
this hard to beat as 
an all-in-one camera 
(but at a hefty price). 

HHHHH
 excellent lens
 Superb video quality
 Costly versus rivals
 Autofocus can be a 

bit hit-and-miss

VERDICT
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Autofocus is a mixed bag. At wider focal 
lengths it’s snappy, working well for still and 
moving subjects. But at the longer end of its 
range, it’s very slow, even with still subjects; 
it’s accurate once it’s found its target, but the 
lens is prone to hunting. This is exacerbated if 
you’re tracking a fast-moving subject at longer 
distances: our usual test (trying to focus on an 
approaching dog) was a step too far. For closer 
and slower subjects, we got good results using 
centre lock tracking and the slow burst rate.

Shake it off
Sony’s SteadyShot image stabilisation is very 
effective and, with Auto ISO enabling you to 
set a minimum shutter speed, you can adjust 
the settings to ensure camera shake shouldn’t 
be an issue. But it’s a big camera, so we found 
a minimum setting of 1/125-second was a safe 
option at longer focal lengths; at the wider end 
1/25-second was readily achievable.

Although the RX10 III is suited more to 
enthusiasts, Sony has included a wide range 
of scene modes, creative styles and picture 
effects, which are fun to use and will be 
welcomed by some users. At the opposite end 

of the scale, it’s good to see the ability to use 
the self-timer in conjunction with bracketing, 
as well as many other features found on 
Sony’s higher-end system cameras.

It also comes with an excellent range of 
filming options, with 4K and HD modes and 
the ability to extract 8MP stills from 4K 
movies. The High Frame Rate (HFR) feature 
enables you to create slow motion videos, and 
we were very impressed with its ability to 
handle mixed light when shooting movies.

As we’ve come to expect from Sony, 
dynamic range is impressive, particularly 
when you consider there’s only a 1-inch 
sensor. JPEG quality is excellent straight from 
the camera, if you prefer that over raw files.

Overall, this is a highly capable camera, 
offering a huge focal range and excellent 
image quality. The slow autofocus at its longer 
end is a tad frustrating, and this isn’t a camera 
we would use for action photography. If you 
already use a DSLR or system camera with 
several lenses, we suspect it’ll be too large as a 
second camera. But, as a one-camera solution 
with great functionality, versatility and image 
quality, it should be high on your list.

Panasonic FZ1000  
(body only) £569

SpecificationS 
 from panasonic.com/uk  

  20.1 megapixels

 One-inch Live MOS sensor

  ISO 125–12,800  

(80–25,600 extended)

 12fps burst rate

 4K video recording at 25fps

Canon G3 X  
(body only) £700

SpecificationS 
 from canon.co.uk  
  20.2 megapixels
 One-inch CMOS sensor
      ISO 100–12,800 
(64–25,600 extended)
 6fps burst rate
  1080p video recording  
at 60fps

ALTERnATIVE CHOICEs
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Audeze sine
Audeze beats Apple to 
the Lightning punch

 £450  FROM Audeze, audeze.com  FeatuRes 10Hz–50kHz 
frequency response, 6W maximum power handling

t
he Audeze Sine, unlike 
most other headphones, 
is ready for a future 

that actually may not come to fruition. 
That’s the possibility of an iPhone 7 devoid of 
the traditional 3.5mm headphone socket, and 
how Apple’s move could signal a big change 
in the way manufacturers make headphones.

If Apple does decide to kill the decades-
old standard, Audeze is prepared with the 
Sine thanks to its Lightning functionality 
(there’s also a 3.5mm version, though). 
If you’re an iPhone user, you should really get 
the ‘Cipher’ Lightning cable version, which 
has an amplifier, a digital signal processor 
and a digital-to-audio converter. It houses all 
of these components in the cable because the 
Lightning port bypasses the iPhone’s default 
audio system, which means that the data 
coming out of the iPhone to the Sine hasn’t 
yet been converted and processed.

While wireless is certainly the trend du 
jour, Audeze is keeping things a little more 
old school with its cable-only approach. 
When you first plug the headphones into a 
Lightning port, you’re prompted to install 
their companion app. This is recommended, 
because it will keep the hardware up to date 
with the latest firmware, and also because it 
lets you tune two equalisers to your taste. 
These are stored on the cable itself, and usable 
on multiple Audeze audio devices.

Audeze’s Cipher Lightning cable gives the 
Sine all of the modern powers we love to see 
in a set of wired headphones. It includes a 
multifunction inline remote that can adjust 
volume, switch songs and, thanks to its 
microphone, pick up calls – so, your phone 
can remain in your pocket.

The audio is excellent, too – full of attack, 
warmth and detail. Everything sounds well 
balanced in the closed-back cup and, to our 

 these are excellent 
headphones, with 
a key feature that 
rewards listening 

on iphone or ipad. 
Make sure you get 

the Lightning version. 

HHHHH 
  Awesome all-in-one 

Lightning cable 
 Leather design 

 excellent sound 
 expensive

VERDICT

the 3.5mm 
cable lacks the 

immediacy  
and warmth 

of listening 
over the Cipher 
Lightning cable

reviewed by CaMeROn FaulkneR

ears, nothing seemed disproportionate or 
out of place in the presentation. They simply 
sound amazing when using the Cipher cable.

In terms of design, the Sine’s build exudes 
quality. It has a sturdy frame and leather-
capped accents, and the earcups are almost 
completely made up of leather on the exterior. 
From front to back, the cups are smooth to the 
touch and supple when resting against your 
ears. The adjustable arms operate as a swivel 
for them to allow for a custom fit.

If you have an Android phone, or are just 
listening through a non-Lightning port, the 
3.5mm cable option is appreciated and totally 
serviceable, too. But by comparison, audio 
coming through the 3.5mm cable sounded 
more reserved and lacked the immediacy 
or the warm quality that we loved from the 
Cipher cable. It’s a nice option to have, but not 
how the Sine was meant to be experienced.

That’s not just down to the sound quality. 
When you use the 3.5mm cable, the Sine loses 
its interesting functionality, as it’s missing the 
mic and music control options. So unless you 
need to charge your iPhone while you listen to 
your tunes, stick with the Cipher cable.

The Audeze Sine is potentially ahead of 
the curve with its Cipher Lightning cable, 
which really boosts the sound over the 3.5mm 
option. It also enriches the experience with a 
capable inline remote. Will Apple be ditching 
the 3.5mm port? Who knows, but there’s no 
need to wait and see to experience the benefits 
of Lightning headphones.

The Audeze Sine looks absolutely lovely and 
sounds just as good – over Lightning, at least.



Mac Hardware APPLE CHOICE

 macformat.com  @macformat SepteMber 2016 | MACFORMAT | 93

ASWY Ondo  
Air Speaker v2
‘Defying gravity’, but it’s not Wicked

W
e’ve seen devices 
before that slot 
into a MacBook’s 

SD card reader to boost 
onboard storage without 
carrying another box. The 
JetDrive Lite 360’s storage is 
built in, though, rather than 
it being a MicroSD adaptor 
for a card of your choice (see 
Nifty MiniDrive, MF289) – 
and its 256GB capacity is 
easily the standout feature.

The JetDrive Lite 360 is 
designed for Late 2013 and 

F
loating speakers 
are a sure sign 
that we're living 

in the home audio future. 
When you see the Air 
Speaker in action for the first 
time, you can't help but be 
impressed by how it hovers 
above its base unit. In fact, 
it's quite easy to become 
distracted by the speaker’s 
constant rotation. However, 
we never warmed to the Air 
Speaker beyond it being 
anything other than 
a conversation piece. 

newer 15-inch models of 
MacBook Pro. The drive 
protrudes only enough from 
your Mac’s card reader to 
enable you to slip fingernails 
under its edge to remove it.

Transfers are claimed to 
reach up to 95MB/sec when 
sequentially reading data 
and 60MB/sec when writing 
it. In our tests, performance 
peaked close enough to those 
numbers at 88.4MB/sec and 
62.6MB/sec, respectively, 

It isn’t meant to be just 
for show, though. Its maker 
says the its levitating, 360° 
sound projection cuts wave 
absorption into surfaces, 
producing a cleaner sound. 
Although we never thought 
of its sound quality as poor, 
we found it underwhelming, 
and it failed to pack the kind 
of punch we've experienced 
from some other Bluetooth 
speakers of a similar size.

If you were seriously 
considering buying this, 
it's the novelty factor that 

 More costly than a 
fast, external SSD of 

its size, but this drive 
is always with you.

HHHHH
 big storage boost 
 Cost per gigabyte

 Weird, but not 
wonderful thanks to  

some awkward design 
and assembly.

HHHHH

 …and that's about it!

VERDICT

VERDICT

 £154  from ASWY, aswyshop.com  
 features 360° sound, wireless charging, LeD touch controls

and held up well in averages 
of all our tests on 75.4MB/sec 
and 53.8MB/sec; that puts 
the cost in context given the 
cheaper, lower quality 128GB 
card we use in our MiniDrive 
peaks at 44.2MB/sec and 
21.1MB/sec, respectively.

This performance and 
the large capacity are an 
appealing combo that’s good 
for backing up on the move 
when you can’t get online. 
alan stonebridge

probably prompted your 
interest in the first place. 
Sadly, even getting the 
speaker to float isn’t without 
its problems. You have to use 
a cumbersome plastic holder 
in order to make the speaker 
stay where it's supposed to 
be, and even then it tends to 
float slightly off the base’s 
centre. There simply wasn’t 
enough here to make us 
seriously want a new way 
to play In the Air Tonight (as 
much as we were looking for 
one). CHristian Hall

No tools are needed to install  
the JetDrive or, importantly, to remove it.

transcend 
JetDrive Lite 360
big storage in a tiny, easy-to-fit form
 £138  from transcend Information, uk.transcend-info.com  
 features MLC flash memory

 A conversation piece…
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b&O beoplay H5

Naim Mu-so Qb

premium wireless earbuds

big sound in a petite package

t
hese days, audio 
companies see 
wireless buds as 

a fertile market. Bang & 
Olufsen has thrown its hat 
into the ring with the H5 
earphones, delivering on its 
premium mandate for top 
notch design and sound, 
but with a few caveats. 

The plastic, solidly made 
earpieces come with a thick 
braided cable, four pairs of 
silicone tips and three sets 
of anti-wax foam tips. In our 
tests, the standard silicone 
tips had the comfiest fit and 
seal, and delivered the best 
treble and bass response.

t
he original Mu-so 
was an amazing-
sounding speaker, 

but its form factor didn’t 
make sense. The Qb is just 
as good but smaller, making 
it a much better fit compared 
to its bulky predecessor.

Naim has done well to fit 
five drivers (one subwoofer, 
two tweeters and two mid- 
range) into a box this small, 
giving you 300W of power. 
The bass is punchy but not 
overbearing, and sound 
separation is impressive.

The Qb’s connectivity 
ports are at the rear; you’ll 
find analogue, optical and 

Design-wise, the most 
attractive feature of the H5 is 
its magnetised buds, which 
click together around the 
neck and turn off when not 
in use. The inline, three-
button remote is thin and 
indistinct, but its volume, 
pairing and call answering 
functions work as expected. 

B&O supplies a small 
magnetic charging brick in 
the box that lets you connect 
the buds to a USB outlet, but 

USB inputs, and a power 
connector and Ethernet port. 
However, you’re likely to 
connect to the Qb wirelessly 
with your iPhone, and the 
speaker works with most 
audio standards, including 
AirPlay. It supports files 
ranging from MP3s up to 
high-resolution WAV, FLAC, 
and AIFF tracks at 24-bit/ 
192kHz. Just be aware that 
audio streamed over Wi-Fi 
is downsampled to 24-bit/ 
48kHz), so avoid this if you 
crave high-resolution audio. 

 Water, sweat and 
dust resistant, the 

H5’s live up to their 
premium promise.

HHHHH
 premium sound

 premium price

 the Mu-So Qb 
sounds fantastic, but 

at £595 this is one 
expensive speaker.

HHHHH
 Stylish looks

 really expensive

VERDICT

VERDICT

 £200  from bang & Olufsen, beoplay.com
 features bluetooth 4.2, magnetic clasp, USb charging cube

 £595  from Naim, naimaudio.com  features Upnp, Airplay, 
bluetooth, internet radio. USb, 3.5mm and optical digital inputs

at this price you won’t want 
to lose it, especially when the 
charge only lasts five hours.

The H5 sounds great, and 
can be further tweaked with 
the Beoplay iOS app. Are the 
buds outstanding enough to 
justify the price? Probably 
not, but we still think their 
design smarts will be worth 
the outlay for audiophiles 
who can live with the 
ignominy of Bluetooth. 
tim Hardwick

You’ll get the best results 
if you hardwire your music 
directly using USB, but the 
trade-off between sound 
quality and portability using 
AirPlay or aptX Bluetooth is 
fine. Streaming over regular 
Bluetooth is also supported, 
but audio quality takes a hit.

You can tweak the Qb’s 
sound using an app; for the 
most part, the speaker’s 
built-in controls are for show, 
since it’s likely you’ll mostly 
be controlling the Qb with 
your phone. Jon Porter

The Mu-so Qb’s design fits  
well in a modern living space.

The H5 earbuds come in either black
or rose pink, both boasting a matte 
black accent on the back.
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 Amazing value for such a feature-packed 
backpack. The only real negative is the 
padding in the Haven’s shoulder straps.

HHHHH

 The more expensive option, but it’s a very 
well made and stylish way to cart around 
your MacBook and accessories on the go. 

HHHHH

A simple backpack with great 
protection for your Apple gear

The bargain MacBook rucksack 
with a plethora of storage spaces

 £129  FROM Knomo, knomobags.com  
 DIMENSIONS 42.5x31.5x15cm (fits 15-inch MacBook Pro)

 £75  FROM STM, stmbags.com.au  
 DIMENSIONS 47x28x13cm (fits 15-inch MacBook Pro)

Style HHHHH 
This backpack is aimed at the practical user rather than 

the style-conscious MacBook owner. It’s much more 
like a hiking pack, with plenty of compartments and 

side pockets for people with a lot to carry!

Comfort HHHHH 
The Haven generally feels bulkier than Knomo’s Hanson, 

though it is fractionally lighter (there’s less metal on zips 
and no leather). It distributes weight well on the move, but 
the straps don’t have the best padding and can feel rough.

Features HHHHH 
You really get some bang for your buck in this department, 

or should we say ‘compartment’. We counted 13 separate 
areas for your gear, ranging from sleeves and zipped 

compartments to small pouches. There’s also a cable-
routing clip and a port for charging kit while on the move.

Protection HHHHH 
The Haven is very compact, using every bit of available 
space in the bag. There are five distinct compartments 

(four with zip access from the outside), and for the price 
the materials seem up to the task of protecting your kit.

Style HHHHH 
The Hanson is part of Knomo’s Brompton Collection, 
a simple backpack that is neither rugged or ‘computery’ 
in appearance. It’s very compact and disguises well the 
many internal spaces for your MacBook and iOS devices.

Comfort HHHHH 
This bag clearly wins out in this category. It distributes the 
weight of its contents superbly, is made from a lightweight 
PET canvas (woven from recycled plastic), and the straps 
are comfortable for lengthy periods.

Features HHHHH 
The STM bag has a bewildering number of pockets, but 
the Hanson doesn’t leave you short; there’s still plenty of 
space for your smaller items, too. However, the depths of 
some of the pouches are frustratingly shallow, meaning 
objects like cards, earbuds or batteries can easily fall out.

Protection HHHHH 
Crucially, the central padded compartment for your 
15-inch MacBook is a great fit and feels well protected. 
In front of that is a smaller pocket for a 9.7-inch iPad, 
and there’s a separate zipped area for your iPhone.

Knomo HansonSTM Haven
R

ev
ie

w
ed

 b
y 

C
H

R
IS

T
IA

N
 H

A
L

L



APPLE CHOICE Group Test

96 | MACFORMAT | SEPTEMBER 2016

Reviewed by  
Cliff joseph

B
oomboxes were all the rage back 
in the ’80s, when a teenage Kevin 
Bacon got everyone dancing in 

Footloose, and hip hop and breakdancing 
took music out onto the streets. The point 
of a boombox was that it was loud and proud, 
and you made sure everyone could hear it.

The iPod and the iPhone changed all that. 
Music became more personal, and less public, 
and the endless stream of compact speakers 
that followed the arrival of the iPod left the 
traditional boombox looking like a musical 
dinosaur from a forgotten age.

But, in the words of Geddy Lee and Rush, 
“plus ça change, plus c'est la même chose”, 
and in recent years the boombox has started 
to make something of a comeback. Perhaps 
it’s the ever-increasing number of festivals 
that have helped to make music a communal 
experience once more, but there’s no doubt 
we’re seeing a new generation of powerful 
speakers that are designed to make a big noise 
for as big an audience as possible.

Strictly speaking, a boombox is designed 
for outdoor use, and that’s very much the case 
with speakers such as the new Monster 
Blaster and Braven’s BRV-XXL, which are 
very solidly built and include powerful 
rechargeable batteries that’ll last all night 
long. However, we also decided to look at 
some powerful speakers that are designed for 
parties at home, or out in the garden, such as 

the Audio L Plus designed by the party people 
at Ministry of Sound. We’ve even been very 
impressed by the mini-boombox design of the 
Ultimate Ears Boom 2, which fits down into a 
backpack yet packs a real audio punch when 
it needs to. So dig out those old leg warmers 
(you know you want to!) and, as Slade used to 
say, c’mon feel the noize.

How we tested
 Boombox speakers will 

always be associated 
with dance music, but 
we tested them playing 
a wide range of songs 
and styles. We tried 
bass-heavy dance, noisy 
guitar rock and even a 
few gentle acoustic 
numbers for nights 
when you’re roasting 
marshmallows around 
a campfire. We also 
weighed them, as 
portability is obviously 
a key issue for speakers 
that are designed for 
outdoor use.

BOOMBOXES 
ON TEST…
 Braven BRV-XXL
 JBL Xtreme
 Libratone Zipp
 Ministry of Sound Audio L Plus
 Monster Blaster
 Ultimate Ears Boom 2

The boombox was loud and 
proud, and you made sure 
everyone could hear it

 macformat.com  @macformat

The boombox is back! Check out the noisiest  
speakers for home and  
away this summer

BEST BOOMBOX    S
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Things to consider…

…or lower?
 A new release from 

Libratone, the One Click 
is a smart, compact, 
weatherproof speaker 
that produces a big 
sound. It costs just £139, 
so won’t break the bank.

1 how heavy?
The Monster Blaster and Braven 

BRV-XXL have moulded handles for carrying, 
but at 7.6kg and 8.2kg respectively, they 
stretch the definition of ‘portable’ to its limit.

2 Battery life
Most of these speakers claim battery life 

of 10–15 hours, but only if they’re running at 
around 50% of maximum volume. Increase the 
volume and you’ll decrease the battery life.

3 Back to bass
Only the bulky Braven and Monster have 

proper subwoofers. All the other speakers use 
‘passive radiators’ or ‘bass ports’ that work like 
an echo chamber to enhance lower frequencies.

4 Why Wi-fi?
The Wi-Fi offered by Libratone and 

Ministry of Sound provides longer range and 
better audio quality than Bluetooth. However, 
Zipp supports AirPlay and Apple Music, too.

5 power play
Manufacturers don’t like quoting specific 

numbers for maximum volume but, as a rough 
rule of thumb, sound starts to get painful – and 
harmful to your hearing – at around 90dB.

6 singing in the rain
Most of these speakers are splashproof 

and can stand a bit rain. The toughest speaker 
is the Ultimate Ears Boom 2, which can survive 
underwater to a metre for up to 30 minutes.

Boomboxes APPLE CHOICE

 macformat.com  @macformat

Higher…
 The SRS-X88 from 

Sony needs mains 
power and costs £350, 
but it includes a very 
powerful subwoofer, 
AirPlay support, and 
can play high-resolution 
audio formats, too.

Everything you need to know before getting started

    SPEAkERS
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 In some ways, the standout in this 
group is Ultimate Ears’ Boom 2. 
Despite its compact and lightweight 
design, this mini-monster packs a 
serious punch. The sound is clear 
and detailed across the range, with 
surprising volume and bass for such 
a small speaker. The Boom 2’s only 

real weakness is that the sound does get a bit distorted when 
you push the volume up to max, so unsurprisingly it can’t 
match the sheer power of its larger rivals. Even so, it’s a great 
choice if you need a powerful speaker that you can easily fit 
into a backpack when you’re out and about.

In contrast, we were a little disappointed to see that 
Ministry of Sound, with its background in dance music, has 
chosen not to include a subwoofer, which would have allowed 
its chunky Audio L Plus to kick out dance tracks. The mid 
range also lacked clarity at times, especially with heavily 
layered songs such as Queen’s Somebody to Love. Libratone’s 
Zipp has an edge here, with a clean, clear sound that works 
well with a wide range of musical styles, and its AirPlay 
support is great if you want maximum quality when streaming 
your music from Macs and iOS devices.

The JBL Xtreme is, in many ways, a larger version of the 
Boom 2. It has a similar cylindrical design, although the 
increase in size and weight lends some extra firmness to the 
overall sound, as well as giving the bass a respectable kick too. 
Like the Boom 2, it suffers from a little distortion at higher 

volumes, but it’s still a 
good, rugged speaker 
that will deliver the goods 
for most outdoor events 
and social gatherings.

If you really want to 
pump up the volume, 
the Braven BRV-XXL 
and Monster Blaster 
are the obvious choices. 
In addition to their sheer 

size and power, these are the only two speakers on test that 
include powered subwoofers for really strong bass output. 
They’re both seriously loud, while still maintaining clarity and 
detail. However, we found that Braven’s separate bass and 
treble controls were more effective than the Indoor/Outdoor 
EQ modes offered by Monster when it came to fine-tuning the 
sound of its gigantic boombox.

 It’s no surprise that the colossal 
Braven and Monster are sturdy 
enough to cope with a spot of rain or 
a few splashes on the beach. But at 
8.2kg and 7.6kg respectively, you’ll 
probably need a car to get them 
where you’re going.

In contrast, the Ultimate Ears 
Boom 2 weighs just 548g and is small and light enough to easily 
carry in a backpack while still packing some serious audio 
power. The Libratone Zipp is less sturdy, but its carrying 
handle and battery will be handy for a barbecue. The Ministry 
of Sound Audio L Plus only runs off mains power, however, 
so it’s primarily suitable for indoor use.

The JBL Xtreme strikes the best balance. Its weight of 2.1kg 
is still fairly manageable, and its sturdy design includes metal 
hooks and a shoulder strap to help you lug it about.

 All the speakers provide Bluetooth 
for streaming to mobile devices, as 
well as a standard 3.5mm socket 
for wired connections. The JBL 
and Libratone also have mics and a 
speakerphone option for voice calls, 
while the Braven and Monster have 
an eye on the DJ scene and include a 

second 3.5mm connector for an external microphone.
One advantage of these big, powerful speakers is that they 

have correspondingly big, powerful batteries, and Braven, JBL, 
Libratone and Monster provide USB ports so you can charge 
an iPhone or iPad when you’re away from home. Back indoors, 
Ministry of Sound and Libratone provide Wi-Fi streaming 
and the ability to create a multiroom system with additional 
speakers. Libratone gets bonus points for also supporting 
Apple’s AirPlay and working with Apple Music.

TEST RESuLTS

TEST RESuLTS

TEST RESuLTS

Test 1 Out and about

Test 2 Connectivity

Test 3 Sweet sounds
Sturdiness and portability compared

Bluetooth is just the start

They’re loud, but are they any good?

Braven BRV-XXL  HHHHH

JBL Xtreme HHHHH

Libratone Zipp   HHHHH

MoS Audio L Plus    HHHHH

Monster Blaster  HHHHH

Ultimate Ears Boom 2  HHHHH

Braven BRV-XXL  HHHHH

JBL Xtreme HHHHH

Libratone Zipp   HHHHH

MoS Audio L Plus    HHHHH

Monster Blaster  HHHHH

Ultimate Ears Boom 2  HHHHH

Braven BRV-XXL  HHHHH

JBL Xtreme HHHHH

Libratone Zipp   HHHHH

MoS Audio L Plus    HHHHH

Monster Blaster  HHHHH

Ultimate Ears Boom 2  HHHHH

The Boom 2 is a great 
choice if you need 
a powerful speaker 
that you can easily fit 
into a backpack when 
you’re out and about
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>THE SPECS >Braven BRV-XXL >JBL Xtreme >Libratone Zipp
>Ministry of Sound 
Audio L Plus

>Monster Blaster >Ultimate Ears Boom 2

 Price £330 £250 £219 £220 £300 £170

connectivity
Bluetooth, 3.5mm line-
in, 3.5mm microphone 
input, 1x USB charging

Bluetooth, 3.5mm  
line-in, 2x USB charging

Bluetooth, 2.4GHz Wi-Fi, 
AirPlay, 3.5mm line-in, 
1x USB charging

Bluetooth (aptX), 2.4GHz 
Wi-Fi, 3.5mm line-in

Bluetooth, 3.5mm line-
in, 3.5mm microphone 
input, 1x USB charging

Bluetooth,  
3.5mm line-in

Dimensions 
(HxWxD), WeiGHt

24x51x21cm, 8.2kg 12.6x28.3x12.2cm, 2.1kg 26.1x12.2x12.2cm, 1.5kg 19x35x14.5cm, 3.9kg 21x46x20cm, 7.6kg 18x6.7x6.7cm, 0.55kg

PoWer suPPly Mains, internal battery Mains, internal battery Mains, internal battery Mains Mains, internal battery Mains, internal battery

Battery 14 hours 15 hours 10 hours n/a 12 hours 15 hours

microPHone/
sPeakerPHone

No (but mic input) Yes Yes No No (but mic input) No

suBWoofer Yes No No No Yes No

WeatHer 
resistance

Splashproof (IPX5)
Splashproof  
(not submergible)

n/a n/a Splashproof (IPX5) Waterproof (IPX7)

 PoRTABiLiTy HHHHH HHHHH HHHHH HHHHH HHHHH HHHHH

 ConnECTiViTy HHHHH HHHHH HHHHH HHHHH HHHHH HHHHH

 SoUnd qUALiTy HHHHH HHHHH HHHHH HHHHH HHHHH HHHHH

 finAL VERdiCT HHHHH HHHHH HHHHH HHHHH HHHHH HHHHH

 How 
do they 
compare?

Christian says…
 There are clearly a 

lot of choices when it 
comes to big, booming 
speakers, and I love 
the Braven BRV-XXL’s 
chunky aesthetics. 
It sounds fantastic but 
weighs a ton, so it’s not 
one for lugging long 
distances – but that 
compromise is worth 
it for the amazing bass.

However, if you really want to pump up 
the volume, the old-fashioned boombox 
designs of the Braven BRV-XXL and Monster 
Blaster are hard to beat. There’s not much 
between them in terms of features, price or 
sound quality, but Braven just nudges ahead 
thanks to its bass and treble controls that 
provide greater precision when adjusting 
the sound for different types of music.
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F  or indoor use, either at home 
or in a holiday apartment, 
Libratone and Ministry 

of Sound are both good choices. 
However, Libratone’s Zipp wins 
here thanks to its rechargeable 
battery and AirPlay support, 
which provide great versatility 
and impressive value for money.

Heading outdoors, we tip our hats to 
Ultimate Ears for packing so much power 
into the tiny little Boom 2, which is a terrific 
choice if you want a powerful outdoor 
speaker that won’t also weigh you down. 

We also really like the rugged, portable 
design of the JBL Xtreme, which will deliver 
the goods for all but the biggest, noisiest 
outdoor events.

the Winner Braven BRV-XXL
When you really want to make a noise

If you want to pump up the 
volume then the Braven 
BRV-XXL is hard to beat
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If you’re a talented web designer, RapidWeaver isn’t the 
right app for you. Can’t draw for toffee? Step right up.

rapidWeaver 7
Craft impressive websites  
with the minimum of fuss

 $99 (about £77)  FROM realmac Software, 
realmacsoftware.com  needs OS X 10.11 or higher

r
apidWeaver may be the most 
Apple-y app that Apple doesn’t 
actually make. While it’s much 

more powerful than Apple’s long-defunct 
iWeb, it shares that app’s approachability  
and ease of use. Version 7 doesn’t mess with 
the formula too much, bringing some 
welcome improvements without radically 
changing how the app works. 

The app is built around professionally 
designed themes, with four new ones added to 
the existing collection in this release. You use 
the sidebar to create the structure of your site, 
the Edit panel to modify pages, the Preview 
pane to see what it looks like, and there’s a 
Keynote-esque Master Style for making global 
changes to your chosen template. You can also 
add custom code such as CSS, JavaScript and 
meta tags. It’s all very easy, enabling you to 
build a website that’s clean, attractive and 
standards-compliant in very little time, 
regardless of your level of experience.

In addition to some new templates, this 
version boasts a dramatically improved FTP 
client for uploads and site management, FTP 
path browsing, the ability to publish the same 
site to multiple locations, a Publish Locally 
option, and the ability to move your project 

across multiple Macs (the licence covers you 
for two). The app now optimises CSS and 
JavaScript code to make it as clean and as 
quick as possible, and it also includes an SEO 
Health Check that can help make your site 
more Google-friendly.

Not just a pretty face
In addition to the stock features, the app is 
also expandable through more than 1,000 
add-ons. These cost money, which has caused 
some grumbling on the internet, but when 
you consider the effort that goes into making 
a decent theme or shopping cart app, the 
average asking price range of €30 to €40 
(about £26 to £34) is hardly daylight robbery – 
and surely it’s better to keep the main app’s 
price down rather than shell out for features 
you’ll never use. The available options cover 
every conceivable category, from image 
galleries to shopping carts, audio embedding 
to typography, adjusting your backgrounds, 
and much more. The only thing RapidWeaver 
isn’t too keen on is you creating your own site 
designs: the trade-off for templates’ ease of 
use and quality is fairly limited customisation 
options, which isn’t so great if you really want 
to get stuck in to web design.

For website beginners, RapidWeaver’s key 
rival is Karelia’s Sandvox, which is simpler 
and works out about £13 cheaper. However, 
RapidWeaver’s templates are more attractive, 
the app is more powerful and, like most kinds 
of design, you’ll often find your requirements 
become more ambitious over time as your web 
design skills improve. If you just need to put 
together something quick and simple for a 
small organisation or yourself, Sandvox is 
great, but if you think you’ll need something 
a bit more ambitious then RapidWeaver is 
flexible enough to meet your future needs 
as well as today’s.

 It’s superb, but the 
reliance on templates 

means losing some 
design flexibility. 

HHHHH
 Very easy to use

 Hundreds of add-ons
 Add-ons cost extra

VERDICT

rapidWeaver 
shares the 

much-loved 
friendliness 
and ease of 

use of Apple’s 
defunct iWeb

reviewed by GaRy MaRshall

 High-quality templates



Hazel 4
Keep your Mac tidy… automatically!

H
azel serves as a 
housekeeper for 
your Mac, tidying 

and organising your files 
to save you the bother. 
Its rules system will be a 
familiar concept if you’ve ever 
experimented with Finder’s 
Smart Folders. You set up 
conditions and specify what 
should happen to matched 
items. Hazel ships with basic 
rules to get you started, which 
plonk specific media types 
into relevantly named folders. 

By making use of carefully 
constructed, multicondition 
rules, you can come up with 
surprisingly complex actions 

P
opChar’s most 
obvious function is 
inserting obscure 

text characters into your 
writing – something that's 
built into OS X. Here, you 
can search for characters by 
name or hexadecimal number, 
and it’s clever enough to show 
variations on each – so, enter 
‘number’ and you’ll be given 
fractions as well as integers, 
and if you search for ‘e’ you'll 
get è, é, ê, and so on. If you 
don’t know how to search for 
a character or you're looking 
for an icon, you can draw it 
instead, then click through 
the various fonts on your Mac 

of your own, even going so far 
as to import content into apps, 
or archive or upload items. 
For example, if you regularly 
dump things on your Mac's 
desktop, Hazel can monitor 
documents for keywords and 
periodically move matching 
ones somewhere safe.

Construction of rules is 
now simplified somewhat 
through being able to preview 
them and discover where they 
fail. This update also adds the 

to find one you like or that 
matches what you’re using 
in your document.

Clicking on a character 
drops it at the insertion point 
in the app you’re using, but 
if you prefer to use keyboard 
shortcuts, just put the pointer 
over it and the key combo (and 
the character’s HTML code) is 
shown at the window’s foot.

PopChar steals some of 
Font Book’s thunder too, with 
a full preview for each font 

 $32 (about £24)  FROM Noodlesoft, noodlesoft.com  
 NEEDS OS X 10.10 or higher

abilities to search rules and 
sync them between Macs.

For power users, we’ve no 
doubt these additions justify 
the upgrade fee. Frankly, we’d 
have paid just for the preview 
feature. As for newcomers, 
Hazel remains great value for 
money due to how much time 
it can save, even if it’s only 
performing the most basic 
and tedious of tidy-up tasks. 
After all, that's one less job 
for you. CRaig gRaNNEll

showing how it looks as a 
headline or typeset block, 
which you can print if you 
need to discuss a font choice 
with colleagues or clients.

It’s certainly a very slick 
app, more flexible than OS X’s 
built-in tools, and a boon for 
anyone who works across 
multiple languages. Unless 
you use it several times a day, 
though, we’d say the price 
might be hard to justify. 
Nik RawliNSON

 Useful (though not 
revolutionary) updates 

build on an already 
essential Mac app.

HHHHH
 Flexible rules

 Also manages Trash

VERDICT

 An elegant (if pricey) 
solution to a common 
problem. Shows Apple 
how it should be done.

HHHHH

 Quite expensive

VERDICT

PopChar X 7.5
Quicker character insertion 
 €29.99 (about £25)  FROM Ergonis Software, ergonis.com 
 NEEDS OS X 10.6 or higher

Hazel’s rules are similar to those 
used in Finder’s Smart Folders.

Hover over a character to 
see its keyboard shortcut.

Mac Software APPLE CHOICE

 Quick, easy and flexible
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Landscapepro  
pro results in minimum time

t
his is a tempting 
alternative to the 
complexity of 

Photoshop for landscape 
enthusiasts. Click areas of 
your image to define grass, 
sky, water, people, and so on, 
then refine your masks by 
dragging the pointer. Next, 
choose your effects: the app’s 
presets – which have intuitive 
names like Morning, Storm, 
and Sunset – offer instant, 
impactful results, and you can 
apply different effects to each 
area – warming up your 
foreground but not your sky, 
for instance. You can even 
drop in entirely new skies 

V
ideo grading isn't 
always this easy. 
Place the pointer 

over a thumbnail to cycle 
through examples of what 
each of this app’s tools can 
do to your clip’s colours and 
tones. Tools can be combined 
in a modular fashion for a 
range of results. Presets help 
you get going with instant 
effects, and you can tweak 
their sliders for unique looks.

The presets also help you 
mimic the colours and tones 
produced by analogue film 

from the app’s built-in library. 
LandscapePro applies effects 
intelligently, so a fiery new 
sunset will cast a new colour 
on the ground below.

Getting good results often 
proves tricky – LandscapePro 
struggles to create accurate 
masks automatically, which 
means there’s much clicking 
and dragging required to get 
correct cutouts. Also, the 
app’s whole-image presets 
often look heavy-handed.

stock, with added artefacts 
such as vignetted edges and 
film grain. This creates a 
more realistic filmic look than 
you can get using iMovie’s 
rather limited presets.

One of the apps’s most 
powerful features is its ability 
to adjust tones and colours 
using curves. After adding a 
curve preset to create a flat 
contrast (which helps you see 
detail in the shadows and 
highlights), you’re able to  

 From £59.90  FROM Anthropics technology, landscapepro.pics  
 NEEDS OS X 10.7 or higher

The Standard edition is 
the most affordable version, 
but pricey at £59.90. To open 
raw files, among other tasks, 
you’ll need the £99.90 Studio 
edition – you could get almost 
a year’s subscription to the 
far superior Photoshop and 
Lightroom for that amount. 
LandscapePro needs to be 
more compelling to compete 
for all but the most drive-by 
landscape photographers. 
DAVE STEVENSON

drag points on the curve to 
adjust shadow and highlight 
levels separately.

The clean interface means 
you can alter your clip’s look 
without being distracted by 
panels. Nevercenter advises 
having 4GB of memory, but 
more is better as rendering 
can take a while. On an iMac 
with 24GB of memory it took 
just over five minutes to 
render a 13-second, 4K clip.  
GEORGE CAIRNS

 A strong concept 
with lots of potential, 

but as it is, it isn’t 
worth the cash.

HHHHH
 Good flexibility

 poor value for money

VERDICT

 Intuitive and simple, 
this is an invaluable 

addition to any video 
editor’s toolset. 

HHHHH
 Lots of presets 
 Slow to render

VERDICT

Camerabag 
Cinema
A powerful video grading tool
 £79.99  FROM Nevercenter, nevercenter.com  
 NEEDS OS X 10.9 or higher

APPLE CHOICE mac Software

LandscapePro offers quick masking to 
allow you to instantly apply effects.

A handy histogram helps you 
create a healthy exposure.

 macformat.com  @macformat



Ummo
A personal public speaking coach

G
lossophobia, just 
like flying, is a fear 
you can overcome 

with a little coaching. 
Ummo listens as you talk, 
transcribing what you say and 
ranking your performance. 
That way you can quickly see 
where you need to improve. 

Some test results speak for 
themselves, such as clarity, 
where you’ll naturally aim 
for 100%, but there’s no hint 
whether the 173 words per 
minute we spoke at in our 
tests is good or not. It turns 
out conversational speech 
runs at 110 to 140 words per 
minute, so perhaps we ought 

M
arking up image 
files and signing 
PDF documents 

are common tasks on iPad 
now. That’s what this app is 
designed to tackle, and this 
version adds multitasking, 
native display resolution, and 
Apple Pencil support for both 
iPad Pro models. For the first 
time, it also works on iPhone, 
but that’s a compromise at 
best. In portrait, the truncated 
toolbar runs along the bottom 
of the screen, requiring you to 
open the stack in order to see 
every tool. Things get even 
more cramped when you open 
the Toolbox to customise the 

to slow down a bit – Ummo 
ought to have told us that.

Most interestingly, the app 
picks out pauses and fillers, 
which are the downfalls of 
many a public speaker. Fillers 
aren’t simply ums and ahs: 
you can define them yourself. 
The default list includes the 
words ‘right’ and ‘like’, but 
Ummo doesn’t consider 
context, so if you say ‘I like 
football’, the ‘like’ in it would 
be incorrectly classified.

icons that appear there, with 
most of the category header 
text completely chopped off.

With markup and sharing, 
iAnnotate 4 performs well. 
Annotations include voice 
recordings, shapes, photos and 
much more. About the only 
thing missing is a crop tool.

The app connects with 
cloud storage – Dropbox, 
Google Drive, OneDrive and 
Box, as well as iCloud Drive – 
albeit clunkily. You can also 

 £1.49  FROM Anshul Bhagi, ummoapp.com 
 NEEDS iOS 9.0 or higher

It’s important to disregard 
examples like this, but we still 
think the feedback Ummo 
gives isn’t yet sufficiently 
broad. The app's developers 
are continually working to 
expand it, having recently 
added support for UK English 
dialects, and there’s talk of 
Watch integration to deliver 
constant feedback. At the 
moment, though, we don’t feel 
Ummo does enough to justify 
its price. Nik RawliNSON

capture web pages to a PDF 
file and mark them up, though 
this tends to be a long process 
with graphics-heavy sites.

Sadly, annotations can’t be 
copied and pasted. Files and 
folders appear as a comically 
oversized grid of icons, with 
truncated names that make it 
hard to know if you’re opening 
the right one. Also, right now 
there’s no way to manually 
download files from the cloud. 
J.R. BOOkwaltER

 Useful, but needs 
to do more to be a 

must‑have for nervous 
public speakers.

HHHHH
 Interesting feedback

 Needs more guidance

VERDICT

 An exhaustive 
toolbox, but the 

interface remains 
a work in progress. 

HHHHH
 Good annotation tools

 Unintuitive interface

VERDICT

iAnnotate 4
Make your mark on documents
 £7.99  FROM Branchfire, iannotate.com 
 NEEDS iOS 8.0 or higher

iOS Software APPLE CHOICE
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iAnnotate 4 can capture web pages, 
but the PDF conversion takes ages.

Ummo illustrates changes in 
your speech performance.
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 Ever since the famous Bondi Blue iMac debuted 
way back in August 1998, Apple’s all-in-one 
desktop computer has been setting standards 
in gorgeous design and powerful performance. 
Apple’s spirit of innovation was as clear back then 
as it is today – the iMac was the first Macintosh to 
abandon the floppy disk in favour of USB ports, 
and its bright, colourful aesthetic set it apart as a 
playful pretender in a world of staid beige boxes.

These days Apple is again pushing boundaries 
with the iMac, blessing all of its 27-inch models 
with the world’s best display, which has a massive 
5K (5120x2880) resolution. Add in a quad-core 
Intel Core i5 processor (configurable from 3.2GHz 
up to 4.0GHz), 8GB of RAM, a fast and capacious 
Fusion Drive, and a powerful AMD Radeon R9 
graphics processor – and the large iMac is the 
desktop system to own. In 2015, Apple lowered the 
price of the top-spec 27-inch model by £150 and 
introduced the first 21.5-inch iMac with a Retina 
4K display. All iMacs (except the entry-level, 
21.5-inch model) have a quad-core processor.

 Model  Key specifications  price

21.5-inch 
2.8GHz  
quad-core  
intel core i5

RAM 8GB of 1867MHz lpddr3
GRAphics intel iris pro Graphics 6200
sTORAGE 1tB (5,400rpm)
DispLAY 1920x1080 (ips, srGB gamut) 
ALsO Magic Mouse 2, Magic Keyboard

£1,049

21.5-inch 
3.1GHz  
dual-core  
intel core i5

RAM 8GB of 1867MHz lpddr3
GRAphics intel iris pro Graphics 6200
sTORAGE 1tB (5,400rpm)
DispLAY retina 4K (ips, p3 gamut)
ALsO Magic Mouse 2, Magic Keyboard

£1,199

27-inch 
3.3GHz  
quad-core  
intel core i5

RAM 8GB of 1867MHz ddr3
GRAphics aMd radeon r9 M395
sTORAGE 2tB fusion drive 
DispLAY retina 5K (ips, p3 gamut)
ALsO Magic Mouse 2, Magic Keyboard

£1,849

 iMac

 Choose an iMac

  Inside your buying guide…

 Who’s it for?
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W
elcome to MacFormat’s Store Guide, the place to go to find out 
about all the Apple kit that matters, whether you’re looking for 
your next iPhone or a powerful new desktop Mac. We’ve chosen 

our top products from Apple’s product line-up, plus the best third-party 
kit that meets our quality standard.

Whether you’re a recent convert or a seasoned Apple user, we highlight 
a model of each product that’s ideally suited to your needs. So, check our 
handy tables to see which Mac, iPad or iPhone is best for you. We’ve also 
highlighted the gold standard in audio, storage, cameras, and many other 
categories to complement your Mac or iOS device with the best accessories.

Your complete guide to the 
best Apple hardware and 
third-party accessories
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ENTRY LEVEL
 you’re just getting 

started in the world 
of Apple and need to 
know where to begin.

UPGRADER
 A firm Apple user, 

you’re ready to move 
on and get even more 
from your tech.

HIGH END
 Apple is your life. 

you prize quality and 
want the best that 
money can buy.

UpDATED
OCT 2015

ExpECTED
lATE 2016
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 The baby of Apple’s laptop family, 
the MacBook was recently updated 
with slightly improved specs and a new 
Rose Gold colour. Weighing in at just 
0.92kg, it’s Apple’s most lightweight 
laptop but still packs in a 226ppi pixel 
density in its 12-inch Retina display.

The MacBook is powered by an Intel 
Core M processor (at 1.1GHz, 1.2GHz or 
1.3GHz), which doesn’t require a fan to 
keep cool, so the MacBook runs silently. 
It also features a Force Touch trackpad, 
which can trigger different responses 
as you apply more pressure. All models 
of the MacBook come with 8GB of 
1866MHz memory, with no option to 
add more, and Intel HD Graphics 515 – 
that’s 25% faster than the previous 
iteration – and there are 256GB or 
512GB flash storage options. There are  
four colour options: Silver, Space Grey, 
Gold, and the new Rose Gold. 

 Following hot on the heels of the 
MacBook, the MacBook Pro recently 
gained a Force Touch trackpad. At the 
same time, the MacBook Pro range saw 
small boosts to its Intel and graphics 
processors. The top-of-the-line model 
is currently the only one to offer a 
discrete graphics processor, in the form 
of the AMD Radeon R9 M370X – the 
other models have an integrated Intel 
Iris or Iris Pro graphics processor.

All except the entry-level MacBook 
Pro are equipped with a Retina display, 
in either 13-inch or 15-inch sizes. They 
also have two Thunderbolt 2 and two 
USB 3.0 ports, an SDXC card reader, 
and their flash storage ranges from 
128GB to 1TB, depending on the model 
you pick as a starting point. Battery life 
is also improved, with the 13-inch model 
lasting 10 hours and the 15-inch model 
going strong for nine hours.

 If you need power – and we mean 
serious power – this is the computer 
for you. Even the entry-level model 
comes with 12GB of RAM, a quad-core 
3.7GHz processor, 256GB of speedy 
PCIe flash storage and dual AMD 
FIrePro D300 graphics cards. However, 
with a price point to match, it last being 
updated in 2013, and Thunderbolt 3 
just around the corner, consider 
holding out for the next version.

 A welcome update in 2014 brought a 
£100 price drop to the most affordable 
Mac. The mini has some interesting 
talking points: the entry-level model 
has a 1.4GHz dual-core Intel Core i5 
processor and 4GB of RAM, making it 
akin to the entry-level MacBook Air 
but with a 500GB hard drive and no 
display. Higher end models come with 
1TB storage (a Fusion Drive option is 
available), 8GB of RAM, a better 
graphics processor and either a 2.6GHz 
or 2.8GHz Intel Core i5 for £569 and 
£799, respectively. Those models can 
be upgraded to Core i7 processors, 
though there are no quad-core options 
available – you’ll need an iMac for that.

 Model  Key specifications  price

12-inch 1.1GHz  
dual-core  
intel core m3

RAM 8GB of 1866MHz 
lpddr3
GRAphics intel Hd 
Graphics 515
ssD 256GB

£1,049

12-inch 1.2GHz  
dual-core  
intel core m5

RAM 8GB of 1866MHz 
lpddr3
GRAphics intel Hd 
Graphics 515
ssD 512GB

£1,299

12-inch 1.3GHz  
dual-core  
intel core m7

RAM 8GB of 1866MHz 
lpddr3
GRAphics intel Hd 
Graphics 515
ssD 256GB or 512GB

£1,249 
or 
£1,419

 Model  Key specifications  price

13-inch 
2.7GHz  
dual-core  
intel core i5

RAM 8GB of 1866MHz 
lpddr3
GRAphics intel iris 
Graphics 6100
ssD 256GB

£1,199

15-inch 
2.2GHz  
quad-core  
intel core i7

RAM 16GB of 1600MHz 
ddr3l
GRAphics intel iris pro 
Graphics
ssD 256GB

£1,599

15-inch 
2.5GHz  
quad-core  
intel core i7

RAM 16GB of 1600MHz 
ddr3l
GRAphics aMd radeon 
r9 M370X
ssD 512GB

£1,999

 MacBook  MacBook Pro  Mac Pro

 Mac mini
 Choose a MacBook  Choose a MacBook Pro
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From 
£399
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 Apple brought 3D Touch to the iPhone 
with the 6s and 6s Plus, providing extra 
interactions depending on the level of 
pressure you apply to the screen. For 
example, a light press on an email lets 
you ‘peek’ at its contents, so you can 
decide whether to delete it or, with a 
firmer press, ‘pop’ it open to reply to it.

While the new iPhone SE lacks 3D 
Touch, it matches many features of the 
iPhone 6s, from a 12MP rear camera 
and 4K video recording to an A9 chip 
and M9 motion coprocessor. All that 
comes in a compact 4-inch case, so it 
has plenty of power and is perfect for 
anyone put off by the larger iPhones.

All models have front-facing 
cameras for video calls. There’s also 
Live Photos, which capture the 
moments before and after you take a 
photo to make a short video, plus all 
feature high-quality Retina displays.

 Aside from the beautifully gargantuan 
12.9-inch iPad Pro (see right), there was 
a small but very welcome change to 
Apple’s tablet line-up last September 
with the addition of the iPad mini 4, 
which is essentially an iPad Air 2 in 
a smaller chassis. The Air 2 hasn’t 
changed since late 2014, though.

On the software side, iOS 9 has 
brought multitasking features, which 
are a boon for productivity. you can 
slide a second app over the right side 
of the one you’re working in (great for 
quickly checking email), then dismiss it 
to get back to work. Picture in Picture 
enables you to watch video in a corner 
of the screen – but it may be a bit too 
small on the mini. Those two features 
work on the Air 2, mini 2 and Pro and 
newer models. There’s also Split View, 
on the Air 2, mini 4 and Pro, which lets 
you work on two apps side by side.

 Model  Key specifications  price

iphone se 
(4-inch 
display)

cApAciTY: 64GB
pROcEssOR: a9
3D TOUch no
cAMERA 12Mp photos,  
4K video recording

£439

iphone 6s 
(4.7-inch 
display)

cApAciTY: 128GB
pROcEssOR: a9
3D TOUch yes
cAMERA 12Mp photos,  
4K video recording

£619

iphone 6s 
plus  
(5.5-inch 
display)

cApAciTY: 128GB
pROcEssOR: a9
3D TOUch yes
cAMERA 12Mp photos,  
4K video recording

£789

 Model  Key specifications  price

ipad mini 4 cApAciTY 64GB 
pROcEssOR a8
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOUch iD yes

£399

ipad air 2 cApAciTY 64GB
pROcEssOR a8X
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOUch iD yes

£429

12.9-inch 
ipad pro

cApAciTY 128GB
pROcEssOR a9X
cONNEcTiViTY Wi-fi
cAMERA 8Mp
TOUch iD yes

£799

 iPhone  iPad

 Choose an iPhone  Choose an iPad
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 The iPad Pro now comes in 9.7-inch 
and 12.9-inch sizes, packed with either 
32GB, 128GB or 256GB of storage. 
All models except the 32GB, 12.9-inch 
one are available with the option of 
mobile network connectivity. The Pro’s 
A9X chip is the most powerful in any 
iOS device, and it has an impressive 
four-speaker sound system, too. Adding 
the pressure-sensitive Apple Pencil 
makes it an accomplished drawing tool.

 Apple’s first foray into the world of 
high fashion certainly turned heads 
when it arrived on the scene. Apple has 
since released a slew of updates in the 
form of watchOS 2, which expands the 
capabilities of third-party apps, as well 
as a range of new case colours and 
strap options (although hardware 
specifications are unchanged). 

Among the new straps are several 
Woven nylon models in various vibrant 
colours, plus a snappy yellow Sport 
Band made of comfy fluoroelastomer. 
The Watch comes in aluminium, 
stainless steel or 18-carat gold cases, 
the first of which now has Gold and 
Rose Gold colour options.

 iPad Pro

 Watch

From 
£499

From 
£259
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 MOnITOR

 If you’re not fussed 
about 4K but still want 
exceptional image quality, 
this IPS display is truly 
superb. It offers 99% 
coverage of the Adobe 

RGB colour space, 10-bit colour and a 
2560x1440-pixel resolution. It has HDMI 
1.4, DVI and Mini DisplayPort connections, 
and four USB 3.0 ports for expansion.

ViewSonic VP2772 
£570
viewsonic.com

 pRInTER

 This versatile laser 
printer got the nod in 
MF300’s group test. 
Its light design, feature 
list, and impressive print 
quality make it a great 

choice for home office users. AirPrint and 
Wi-Fi connectivity means it plays nice with 
your iOS devices. It’s not great for printing 
photos, but is a winner at everything else.

Brother HL-3150CDW 
£155
brother.co.uk

 UlTRA hD MOnITOR

 The recent winner of 
our 4K displays group 
test, this 32-inch screen 
is a joy to work with, and 
a monitor of this size is 
the perfect setting for 4K 

to really come into its own. From stunning 
picture quality and top-notch contrast 
ratio to the reasonable price for such a 
wide display, it’s a winner all round.

AOC U3277PQU 
£611
aoc.com

 ThUnDERBOlT DOCk

 Our MF297 group test 
winner got the nod for its 
beautifully compact form 
and superb menu bar 
tool, which lets you eject 
individual drives as you 

please (something its rivals failed to offer). 
It’s not the most laden with ports, but has 
everything that most people will need, 
and comes in at a great price point.

CalDigit Thunderbolt 
Station 2 £202
caldigit.com/uk

 MACBOOk BAG

 Deceptively spacious 
inside, the Hanson is full 
of well-padded pockets to 
protect your precious 
portables. It’s extremely 
comfortable, distributing 

weight well so your shoulders don’t feel 
the strain, and is rather good looking, but 
remains subtle enough not to attract the 
attention of light-fingered thieves.

Knomo Hanson
£129
knomobags.com

 pORTABlE STORAGE

 This drive fits into your 
MacBook Pro’s SDXC slot 
to instantly increase your 
storage by up to 256GB. 
We were very impressed 
with its transfer speeds, 

clocking 88.4MB/sec for sequential reads 
and 62.6MB/sec in our write tests. The 
drive comes with storage included, unlike 
some rivals that require you to supply one.

Transcend JetDrive  
Lite 360 £138
uk.transcend-info.com

 wIRElESS ROUTER

 This is one of the best 
802.11ac routers you can 
get. It was one of the 
fastest models in MF301’s 
group test, and it can 
connect to ADSL, fibre 

and cable equipment, so it’s not stymied if 
you change your broadband setup. Its iOS 
app is great, and it’s hugely affordable for 
what it offers. A winner all round.

netgear nighthawk 
D7000 £148
netgear.co.uk

 nETwORk STORAGE

 We know a good nAS 
drive when we see one, 
which is why the 6TB 
TS-251+ won MF302’s 
group test. It’s one of the 

quickest nAS drives we’ve seen lately, with 
transfer rates of over 105MB/sec for large 
files. It has an HDMI port and a remote 
control for watching your media directly 
on your TV set. Four USB ports top it off.

QnAP TS-251+
£442
qnap.com

nEw!

 Ip CAMERA

 Winner of MF299’s 
group test, the Logi Circle 
is packed with features. 
It’s so easy to use and can 
be powered by batteries, 
making it highly portable. 

With a wide 135° field of vision, it captures 
plenty of detail, and is very affordable. The 
Logi Circle is a barnstorming all-rounder, 
and looks great on your mantlepiece.

Logi Circle
£158
logitech.com

nEw!



STORE GUIDE Accessories

108 | MACFORMAT | September 2016  macformat.com  @macformat

bEsT bUYs… curated picks of third-party kit 

nEw!

 pORTABlE BATTERy pACk

Apple iPhone 6s Smart 
Battery Case £79
apple.com/uk

 Despite that silly-looking 
hump on its back, the 
official battery case for 
the iPhone 6 and 6s is 
impressive. It’s easy to fit, 
the buttons feel great, 

and the soft inner lining protects against 
scratches. It isn’t the largest capacity case, 
yet it has more than enough juice for busy 
days, and the bump is surprisingly comfy.

 wIRElESS SpEAkER

 This airship-inspired 
speaker is certainly 
striking, but it’s more than 
just a looker, with crisp, 
clear treble and refined 
bass output over previous 

Zeppelin models. Support for Bluetooth, 
Spotify Connect and AirPlay makes for 
plenty of connectivity, and dynamic EQ 
ensures controlled bass at all volumes.

Bowers & Wilkins 
Zeppelin Wireless £499
bowers-wilkins.co.uk

 On-EAR hEADphOnES

 Wireless headphones 
are often blighted by 
meagre battery life, but 
not so with these cans, 
which run for more than 
25 hours. They offer 

active noise-cancelling, brilliant wireless 
range, superb comfort and a huge range 
of intuitive touch controls, making these 
the wireless headphones to beat.

Plantronics Backbeat 
Pro £128
plantronics.com

 In-EAR hEADphOnES

 These in-ear buds 
impress on nearly every 
level. They come with 
easy-to-use inline controls 
and a steel-reinforced 
cable, while faultless low 

and mid range reproduction and a crafted, 
premium feel make them earphones of 
distinction. They are a world away from 
Apple’s cheap earbuds.

RHA MA 750i
£90
rha-audio.com

 iphOnE STAnD

 Charge your iPhone in 
style with this simple yet 
elegant stand. From the 
curved backstop to the 
rounded aluminium base, 
it oozes Apple-esque 

design chops and will fit right in among 
your other Apple kit. The Lightning 
connector can be tilted to help mount 
your iPhone on it, which is a nice touch.

Just Mobile AluBolt
£32
just-mobile.eu

 pORTABlE SpEAkER

 If you want big, booming 
sound then your best bet 
is the hulking BRV-XXL. 
With Bluetooth, separate 
bass and treble controls, 
plus incredibly rich, deep 

sound thanks to its included subwoofer, 
it’s got you covered whether you take it to 
the beach or a DJ party. A 14-hour battery 
and IPX5 splashproof rating seal the deal.

Braven BRV-XXL
£330
braven.com

 ApplE wATCh STAnD

 nomad’s stand is an 
absolutely gorgeous 
Apple Watch charging 
dock – carved from a 
single piece of curved 
aluminium, it looks like 

it could have been designed by Apple. 
Its weighty base keeps everything in place 
and the cable management is so tidy that 
it looks like there’s no cable there at all.

nomad Stand for 
Apple Watch £40
hellonomad.com

 ACTIOn CAMERA

 GoPro has built a truly 
formidable reputation for 
itself as an action cam 
champ, and rightly so. 
The Hero4 Session may 
be compact, but it’s a 

great all-rounder. Internal waterproofing, 
an outstanding app and impressive video 
quality, combined with an affordable price 
tag, make it a firm favourite at MacFormat.

GoPro Hero4 Session 
£164
gopro.com

 CAMERA STABIlISER

 The iPhone may take 
amazing videos, but if 
you’ve got shaky hands 
then your phone will still 
struggle. If that sounds 
like you, try the Zhiyun Z1 

Smooth-C. It’s an iPhone holder with a 
built-in gimbal, so you can move your 
hand around and your footage will stay 
smooth with nary a bump or wobble.

Zhiyun Z1 Smooth-C
£157
zhiyun-tech.com





We are committed to only using magazine paper 
which is derived from well managed, certified forestry 
and chlorine-free manufacture. Future Publishing and 
its paper suppliers have been independently certified 
in accordance with the rules of the FSC (Forest 
Stewardship Council). 

© Future Publishing Limited 2016. All rights reserved. No part of this magazine may 
be used or reproduced without the written permission of the publisher. Future 
Publishing Limited (company number 2008885) is registered in England and Wales. 
The registered office of Future Publishing Limited is at Quay House, The Ambury, 
Bath, BA1 1UA. All information contained in this magazine is for information only and 
is, as far as we are aware, correct at the time of going to press. Future cannot accept 
any responsibility for errors or inaccuracies in such information. Readers are advised 
to contact manufacturers and retailers directly with regard to the price of products/
services referred to in this magazine. If you submit unsolicited material to us, you 
automatically grant Future a licence to publish your submission in whole or in part in 
all editions of the magazine, including licensed editions worldwide and in any 
physical or digital format throughout the world. Any material you submit is sent at 
your risk and, although every care is taken, neither Future nor its employees, agents 
or subcontractors shall be liable for loss or damage.

MacFormat, Future, 
Quay House, The Ambury 
Bath, BA1 1UA
Tel +44 (0)1225 442 244 
 www.futureplc.com
 facebook.com/macformat 
 twitter.com/macformat

Don’t miss it –  
subscribe toDay!
in print & on your ipaD
 Our print and digital bundle gets you the  

paper magazine as well as our iPad edition 
myfavouritemagazines.co.uk/macformat

Zinio subscriptions do not include a print copy of the magazine.

on your mac
 Read on the big screen: subscribe with  

Zinio at zinio.com/macformat

print 12,821 Digital 9,636

22,457

A member of the Audited Bureau of Circulations
Jan–Dec 2015

neXt issue Get ready for Sierra

110 | macFormat | SEPTEMBER 2016  macformat.com  @macformat

30 aug 
2016

ISSUE 304on sale

and get some if its best features  
right now in OS X El Capitan

also insiDe…
 Create a great website using RapidWeaver
 Make pro-looking videos for YouTube
 Salvage an old drive and its precious data
 Discover what’s new in emerging Wi-Fi tech

Get ready for 
macOS Sierra…

eDitorial
Editor christian hall 
editor@macformat.com
Managing Art Editor paul blachForD 
paul@macformat.com
Production Editor alan stonebriDge 
alan@macformat.com
Commissioning Editor aleX blake
alex@macformat.com 

aDVertising
Commercial Sales Director clare DoVe
Senior Advertising Manager lara Jaggon
Director of Agency Sales matt DoWns
Advertising Director John burke
Head of Strategic Partnerships clare Jonik
Advertising Manager michael pyatt 
michael.pyatt@futurenet.com
Account Sales Manager anDreW tilbury 
andrew.tilbury@futurenet.com

print & proDuction
Production Controller Frances tWentyman  
frances.twentyman@futurenet.com
Production Manager mark constance 
mark.constance@futurenet.com 

management
Managing Director – Magazines Joe mceVoy
Group Editor-In-Chief paul neWman
Group Art Director graham Dalzell

licensing  
Senior Licensing & Syndication Manager matt ellis  
matt.ellis@futurenet.com Tel +44 (0)1225 442244

print subscriptions  
Tel 0844 848 2852 Web myfavouritemagazines.co.uk
Email macformat@myfavouritemagazines.co.uk 

Printed in the UK by William Gibbons
Distributed in the UK by Seymour Distribution Ltd,  
2 East Poultry Avenue, London, EC1A 9PT  Tel 020 7429 4000

contributors 
eDitorial: Adam Banks, Matt Bolton, J.R. Bookwalter,  
George Cairns, Cameron Faulkner, Craig Grannell, Tim Hardwick, 
Kenny Hemphill, Cliff Joseph, Gary Marshall, Howard Oakley,  
Nick Peers, John Porter, Nik Rawlinson, Lizzie Shepherd,  
Dave Stevenson, Luis Villazon 
art: Apple, Future Photo Studio (Neil Godwin),  
iStockphoto, Jamie Schildhauer



HEALTHY HOME
 In this article (Apple Home, MF302)

you talk about type 2 diabetes and the 
ability to get test strips on the NHS. 
This is only available to people with 
type 1. Free medicine is all you get, 
or that is what I was told. It is not the 
machines that cost the money, it is the 
needles and test strips.
by  A N D R E W  B R O W N

ALAN sAYs… All people with type 1 
diabetes should get glucose strips on 
NHS prescription without issue, and type 
2 patients should also be prescribed 
them if they are on medication (not 
purely diet-controlled). There was 
controversy a few years ago about some 
local health authorities restricting test 
strip availability purely to save money 
(despite potentially higher costs from 

Get in touch CONTACTs

 Contact us

 Email your queries  
and your questions to 
letters@macformat.com

poor monitoring meaning heightened 
risk of complications). The Department 
of Health issued guidance that type 1 
diabetics should not have their access 
restricted. For type 2 diabetics, you may 
find your authority still restricts supply; 
read bit.ly/2amvJGk and the advice on 
courses of action at bit.ly/29G7h5O. 
Thanks for your query. We’re sure other 
readers will find this useful.

HOT sTUFF
 I bought a 13-inch MacBook Air about 

six months ago (so I am still learning); 
when I run a game from developer G5, 
without the power cable connected, the 
MacBook gets extremely hot so the fan 
is very loud, but when I try the game 
with it charging it’s cool. When I use it 
for the internet while connected it’s cool 
too, so should I be worried or take it 
back to be checked? The game is G5’s 
The Cursed Ship. My system is running 
El Capitan and is up to date.
by  J  T A Y L O R

ALEX sAYs… It’s standard fair for the 
the Mac to be working harder when 
running off battery alone. The fans will 
kick in when necessary, and though  
we’d all like silence in a MacBook, it’s 
only possible in the 12-inch model.

Don’t panic if MacBook gets really hot while 
gaming on battery power; it’s designed that way.
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AIRPLAY PAINs
 I’m struggling with your April edition’s AirPlay 

project. 1: the MicroSD card. I assume a blank 
card is required. 2: I  downloaded the Pi Music 
Box from the MusicBox site (I’m using a new Pi 3). 
Your instructions say “extract” the IMG file. 
I tried double-clicking it and it produced on the 
desktop a volume named “MUSICBOX”. This 
looked hopeful. 3: I downloaded and opened Pi 

Filler. How do I “point it at the image” extracted? When aiming Pi Filler at the 
desktop, volumes such as MUSICBOX do not appear (no volumes do). So I tried 
the unopened ‘pimusicbox-0’ folder which contains the original IMG file and 
pointed Pi Filler to this IMG file. Pi Filler then built an SD with this 
unprocessed IMG file. 4: I ejected/inserted the SD card in my Mac and went 
through the config folder exercise for my BTHub 5, saving it. 5: I inserted the 
card in my Pi 3, powered on, and then got a red light. After about 10 minutes, 
I entered musicbox.local in Safari, and no luck. What am I missing?
by  D AV E  N O R R I S

CHRIsTIAN sAYs… Dave, the tutorial was written specifically with the Pi Zero in 
mind, which was listed in the requirements. The writer had to source a modified 
image that would work with the Pi Zero as MusicBox hasn’t (yet) been updated 
since the middle of last year. If you visit bit.ly/29MSHJw you’ll see Pi 3 support 
isn’t officially implemented, so you’ll need to follow the instructions there.

To answer your other questions: 1. Correct. Just a regular blank card. its 
current file system is unimportant as the image you write to it contains all of that 
information. 2. The file you downloaded was a Zip file – basically a file archive. 
Had there been more space, we would have almost certainly written “double-click 
the file to extract its contents”. 3. Again, we assumed people would know that the 
program Pi Filler needs to be pointed to a specific IMG file rather than a folder. 

To summarise, we apologise for the assumed knowledge in the steps required 
to create the actual image – however, the project itself was specifically written for 
the Pi Zero, and sometimes we need to trim instructions to fit on the page.

 LETTER OF THE MONTH!

Have your say on all things Apple!
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My phOTO Apps  

sCALE
 The child subject is offset to 

the left with a sweeping forest 
edge occupying two-thirds of 
the image, giving a powerful 

sense of scale, aided by being 
shot lower than the tree line.

TONE
 The sepia tone is often used 

for portraits, but this is a 
great example of it working 
well in a landscape. It’s not 

trying to be old-looking, 
rather it’s for drama.

VIGNETTE
 To help frame the subject 
better and add that final 

moody element to the shot, 
a simple round vignette 

has been applied to focus 
the viewer’s eyes.

why IT wORks… 

Untitled
by n i c k  S W i F T

EquIpMENT iPhone 6s

 I took this shot with my 
iPhone 6s in panorama  
mode and tweaked it in 

Adobe Lightroom and Alien 
Skin Software’s Exposure. 

I simply adjusted levels 
and applied a gradient 

filter in Lightroom 5, and 
then converted to black 
and white in Exposure 7 

(now Exposure X, alienskin.
com). I’m rather surprised 

Exposure X isn’t mentioned 
more in magazines as it’s  

the hidden gem a lot of 
working photographers use 

but don’t like to admit it!

GET INVOLVEd!

 The iPhone is the world’s most popular 
camera, but it takes a bit of work to get 
a truly excellent shot. Why not show 
us your creations? Simply email us at 
photos@macformat.com and your work 
could be showcased on these pages!

photoshop 
LIGhtRooM 
£100

 This is a fantastic program to 
archive, enhance and perform 
most of the image editing you’d 
ever want to do. Lightroom is 
extremely powerful, but without 
the complexity of full Photoshop. 
I think you should consider buying 
a keyboard skin to assist with 
Adobe’s shortcuts. The latest 
version includes HDR Merge, 
advanced Healing Brush, and 
great face recognition as well.

ALIen skIn 
exposuRe x 
$199 (£150)

 I consider this to be the go-to 
application for film-like effects. 
It accurately creates film-stock 
looks, making it a hidden gem 
for professional image editors. 
You can use it as a plug-in for 
Photoshop and Lightroom, or as  
a complete photo editor on its 
own. As a standalone application, 
Exposure X helps you quickly edit 
raw photos non-destructively too. 
It’s a good buy.

hoMe & DRY 
£2.29
 Essentially, this 

iPhone app provides you with a 
live weather radar and rainfall 
forecast. I find it very useful for 
predicting cloud and rain for my 
next outdoor shoot! Apparently 
it’s as focussed as 1km around 
your location, so it’s worth adding 
to your iOS photo arsenal. For that 
added bit of safety, the app also 
features real-time lightning strike 
maps, and it forecasts lightning 
risks for three days ahead.



Your pictures PHOTO STream

Cappadocia, Turkey
 Mark Conner might be afraid of heights but he plucked up the courage 

to fly 1km high to see the sun rise over the world-famous ‘fairy chimneys’ 
and troglodyte caves of Cappadocia from the air, captured on iPhone 5.

3 Exposure X effect
≈-click on the image, then choose 

Edit In > Exposure X > Edit a Copy with 
Lightroom Adjustments. Click through the 
B&W Film options (left) to find one you like. 
We used the Gold Split Toned effect.

2 Add a gradient 
A gradient can selectively brighten 

dark parts of an image. Select the Gradient 
tool (top right), then click and drag on the 
image where you want the transition to be. 
Use the sliders to adjust it, then click Done.

1 Import into Lightroom
Pick File > Import Photos and Videos 

and select your iPhone. Make sure the 
image you want to import is checked 
before clicking the Import button. Once 
the image is uploaded, click Develop.

Get the look...
Learn how to get fantastic 
iPhone shots like the pros 

Great shots that make it into our gallery  

 Photo album

Patmos, Greece
 The stunning 

arches of the 
Monastery of 
Saint John the 
Theologian, as 
captured by Roger 
Cossey’s iPhone 6.

Cragside Gardens, 
Northumberland
 Martin Webster usually 

takes out his DSLR for 
such occasions, but this 
time his iPhone 6 was all 
he needed!
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TIME MACHINE

Now you can get in on the iOS 10 beta in readiness for the full release in September, check 
out the revamped Messages app, which comes with classic Apple icons made into emojis. 
From realistic hand gestures to 3D happy faces, your conversations are enriched by these 
graphics that you can ‘stick’ onto your messages. Check out the Classic Mac sticker pack, 
which contains 20 retro icons from the era before OS X. Remember, If you’re trying out the 
iOS 10 public beta now, beware of using stickers in messages to people not also on iOS 10 
and signed in to iMessage; we sent stickers to an Android user, which cost us several pounds! 
Things like this are preventable by switching off Settings > Messages > MMS Messaging. It’s 
common, and increasingly expensive, for mobile providers to charge you for media messages.
 FREE in iOS 10

 Retro Apple emojis
Virtual Apple stickers to liven up techy messages

Classic Apple kit given a unique makeover

NExT IssuE ON sALE  Tuesday 30 August 2016

The Classic Mac sticker 
pack contains pre-OS X 
graphics, from pointers 
to Clarus the Dogcow  
(bit.ly/29OegLk), and even 
the “hello” cursive writing 
from the Mac’s 1984 debut.
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